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IntroductionVisual Studio remains one of the most comprehensive and powerfulintegrated development environments (IDEs) available to developerstoday. With each new version, it brings re�inements, productivityfeatures, and deeper integration with the tools modern developers relyon. This book is designed to give you a practical, hands-onunderstanding of Visual Studio, whether you are new to the IDE or anexperienced developer looking to sharpen your work�low.The focus here is not on abstract theory, but on concrete skills thatimprove how you use Visual Studio day to day. Throughout the book,you will explore features that make you more productive, learn how tomanage your projects and codebases more effectively, and gain insightinto modern development practices supported by the IDE.



Who	 the	 Book	 Is	 ForThis book is written for developers who spend their time in VisualStudio and want to get the most out of it. Whether you are aprofessional building enterprise-grade applications, a student juststarting out, or a hobbyist experimenting with .NET, the examples andwork�lows in these pages will help you improve your ef�iciency andcon�idence in using the IDE.Some prior knowledge of C# and .NET is assumed, but the materialis accessible enough that developers from other backgrounds will alsobene�it. The content ranges from basic setup to advanced topics likeunit testing and source control integration, making it useful both as alearning resource and a desk reference.The book is organized into �ive chapters, each building on theprevious one:
Chapter 1 –	 Getting	 to	 Know	 Visual	 Studio	 2022We start with the essentials, installation, workloads, orientation inthe IDE, and everyday productivity features, then dive straight intoAI. You’ll install and enable GitHub Copilot, work with Chat and Agentmodes, upload screenshots to give Copilot context, and see howAgent-driven tools automate real tasks (like running the .NETUpgrade tool end-to-end). You’ll also learn how model selectionworks in Visual Studio (including the GPT-4.1 completions model and“bring your own model” options) and how MCP (Model ContextProtocol) servers extend Agent with task-speci�ic tools.
Chapter 2 –	 Working	 with	 Visual	 Studio	 2022This chapter rounds out the day-to-day tooling: choosing the rightproject types, working with .NET Aspire, managing NuGet (and npmwhere applicable), creating reusable code snippets, navigatingquickly with bookmarks/shortcuts, exploring data and services viaServer Explorer, and getting comfortable with key windows andmenus. It also covers the new, simpler .slnx solution format and theCLI/IDE paths for migrating and opening solutions cleanly. In Aspire,you’ll see how the built-in dashboard surfaces logs, traces, andmetrics, and how Copilot can sit alongside that telemetry to answerquestions in context.
Chapter 3 –	 Debugging	 Your	 Code



You’ll move from basic breakpoints to conditional and labeledbreakpoints, DataTips and visualizers, the Immediate and Watchwindows, attaching to processes, and remote debugging. Then you’llsee how Copilot becomes “debugger-aware,” analyzing variables fromthe Autos/DataTips views and bringing exception context into a chatwork�low so you can move from symptom to �ix faster.
Chapter 4 –	 Unit	 TestingWe cover creating and running tests (MSTest), setup/teardownpatterns, data-driven tests, and Live Unit Testing in Visual StudioEnterprise. You’ll measure and interpret code coverage and,importantly, use Copilot to generate tests from inline chat or theCopilot window. The chapter also shows how to wire up an ObsidianMCP server so Copilot Agent can document your tests into aknowledge base automatically.
Chapter 5 –	 Source	 ControlYou’ll go end-to-end with Git and GitHub inside Visual Studio,including account setup, cloning, committing, branching, and pullrequests, then step into advanced �lows such as multi-repo work,stashes, comparing branches, checking out a speci�ic commit, andstaging by line. Copilot helps write consistent commit messages(with team-de�ined custom instructions), performs local codereviews before you push, and even supports quick sharing via Gitpermalinks from the editor.

What	 You	 Will	 GainBy the end of this book, you will not only understand the core featuresof Visual Studio but also be able to integrate them into your dailydevelopment practices. You will learn how to navigate the IDE moreeffectively, debug and test your code with con�idence, and collaboratesmoothly using GitHub. In short, this book equips you with both thefoundational knowledge and the practical skills needed to workproductively in Visual Studio.Copilot is an accelerator, not an autopilot. You’ll see where it shines(boilerplate, refactors, test scaffolding, reviews) and where you shouldslow down and verify.



If you are looking for a focused guide that deals exclusively withVisual Studio, its features, its work�lows, and how to make the most ofthem, this book was written for you. Keep it within reach on your desk,and let it serve as both a learning tool and a reference as you continueyour development journey.



Any source code or other supplementary material referenced by theauthor in this book is available to readers on GitHub(https://github.com/Apress). For more detailed information, pleasevisit https://www.apress.com/gp/services/source-code.
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1.	 Getting	 to	 Know	 Visual	 Studio	 2022Dirk Strauss1  Uitenhage, South Africa 
Visual Studio is an amazing bit of software. If you have been usingVisual Studio for a number of years, you will certainly agree that theIDE offers developers a host of tools and features to make them moreproductive. You will also be aware that it has grown a lot during thepast couple of years and is an absolute powerhouse when it comes toproviding tools to develop world-class software.Initially released as Visual Studio 97 in February 1997, this was the�irst attempt at using a single development environment for multiplelanguages. The evolution of Visual Studio is detailed in Table 1-1.
Table	1-1 The Evolution of Visual Studio
Release Ver .NET	 framework .NET	 (Core) Release	 date

Visual	 Studio	 2022 17.0 3.5, 4.6–4.8 2.1–3.1, 5.0–9.0 Feb 15, 2022
Visual	 Studio	 2019 16.0 3.5–4.8 2.1–3.1, 5.0 Apr 2, 2019
Visual	 Studio	 2017 15.0 3.5–4.7 1.0, 1.1, 2.0, 2.1 Mar 7, 2017
Visual	 Studio	 2015 14.0 2.0–4.6 1.0 July 20, 2015
Visual	 Studio	 2013 12.0 2.0–4.5.2  Oct 17, 2013
Visual	 Studio	 2012 11.0 2.0–4.5.2  Sept 12, 2012
Visual	 Studio	 2010 10.0 2.0–4.0  Apr 12, 2010
Visual	 Studio	 2008 9.0 2.0, 3.0, 3.5  Nov 19, 2007
Visual	 Studio	 2005 8.0 2.0, 3.0  Nov 7, 2005
Visual	 Studio	 .NET	 2003 7.1 1.1  Apr 24, 2003
Visual	 Studio	 .NET	 2002 7.0 1.0  Feb 13, 2002

https://doi.org/10.1007/979-8-8688-2114-1_1


Release Ver .NET	 framework .NET	 (Core) Release	 date

Visual	 Studio	 6.0 6.0 N/A  June 1998
Visual	 Studio	 97 5.0 N/A  Feb 1997There is so much to see and learn when it comes to Visual Studio.Therefore, in this chapter, we will start by having a look at thefollowing:Installing Visual StudioWhat workloads areExploring the IDEExisting and new features available in Visual Studio 2022Productivity tipsLet us see where to �ind the Visual Studio Installer and get going.
Installing	 Visual	 StudioAt the time of this writing, Visual Studio 2022 is available for Windowsmachines. Unfortunately, Visual Studio for Mac has been retired as ofAugust 31, 2024, in accordance with Microsoft’s Modern LifetimePolicy. Alternatives such as the C# Dev Kit for Visual Studio Code allowdevelopers to continue where Visual Studio for Mac left off. You candownload Visual Studio 2022 for Windows from
https://visualstudio.microsoft.com/vs/, and if you are onmacOS, you will need to head on over to
https://code.visualstudio.com/docs/csharp/get-
started/ to get started with C# in VS Code.Clicking the Download Visual Studio button, you will see a list drop-down with the options as displayed in Figure 1-1.

https://visualstudio.microsoft.com/vs/
https://code.visualstudio.com/docs/csharp/get-started/


Figure	1-1 Versions of Visual Studio AvailableIf you would like to compare the Visual Studio 2022 editions, youcan have a look at
https://visualstudio.microsoft.com/vs/compare/ for adetailed comparison. The bottom line is that if you want Visual Studio2022 for free, download Visual Studio Community 2022.Visual Studio Community 2022 is aimed at students, open source,and individual developers. The paid tiers include Visual StudioProfessional 2022, which is aimed at small teams and Visual StudioEnterprise 2022, aimed at large development teams.Microsoft speci�ies enterprise organizations as those havingmore than 250 PCs or more than 1 million US dollars in annualrevenue.Let us have a brief look at the recommended system requirementsfor installing Visual Studio on your machine. For a comprehensive list,browse to https://docs.microsoft.com/en-
us/visualstudio/releases/2022/system-requirementsand have a read through that.
Visual	 Studio	 2022	 System	 Requirements

https://visualstudio.microsoft.com/vs/compare/
https://docs.microsoft.com/en-us/visualstudio/releases/2022/system-requirements


The system requirements for installing Visual Studio 2022 might differfrom those of previous versions of Visual Studio. Refer to thedocumentation on https://docs.microsoft.com to review thesystem requirements for previous versions of Visual Studio.Visual Studio Enterprise 2022, Visual Studio Professional 2022, andVisual Studio Community 2022 all support the following minimumsystem requirements.
Operating	SystemsThe following 64-bit Windows operating systems are supported:Windows 11 Home, Pro, Pro Education, Pro for Workstations,Enterprise, and EducationWindows 10 Home, Professional, Education, and EnterpriseWindows Server 2022 – Standard and DatacenterWindows Server 2019 – Standard and DatacenterWindows Server 2016 – Standard and Datacenter
HardwareThere is a line here that developers generally don’t like to cross when itcomes to the minimum hardware specs. Many developers I know willgeek out on system RAM and favor SSDs over HDDs. Nevertheless, hereare the minimum recommended requirements:ARM64 or x64 processor (Quad-core or better) recommended. ARM32 processors are not supported.Minimum of 4 GB of RAM (16 GB of RAM recommended).Windows 365: Minimum 2 vCPU and 8 GB RAM. 4 vCPU and 16 GB ofRAM is recommended.Minimum of 850 MB and up to 210 GB of available hard disk space(depending on installed features, 20–50 GB of free space is typicallyrequired).For improved performance, install Windows and Visual Studio on anSSD.Minimum display resolution of WXGA (1366 by 768) but works bestat 1920 by 1080 or higher.
Supported	Languages

https://docs.microsoft.com/


Visual Studio and the Visual Studio Installer are available in 14languages as follows:EnglishChinese (Simpli�ied)Chinese (Traditional)CzechFrenchGermanItalianJapaneseKoreanPolishPortuguese (Brazil)RussianSpanishTurkish
Additional	NotesThere are several additional requirements to take note of that I willbrie�ly list here. There are, however, other requirements that might beof importance to your unique development environment. For a full list,refer to the system requirements at the following link:
https://docs.microsoft.com/en-
us/visualstudio/releases/2022/system-requirements.Administrator rights are required to install Visual Studio..NET Framework 4.7.2 or above is required to run the Visual StudioInstaller and install Visual Studio (.NET Framework 4.5.2 or above isrequired to install Visual Studio version 17.8 and earlier).Visual Studio requires .NET Framework 4.8 and will be installedduring setup.
Visual	 Studio	 Is	 64-BitVisual Studio 2022 on Windows will now run as a 64-bit application,which means that you can open, modify, and debug really largesolutions without running out of memory. Being a 64-bit application,

https://docs.microsoft.com/en-us/visualstudio/releases/2022/system-requirements


Visual Studio 2022 is no longer limited to just 4 GB of memory in themain devenv.exe process.Even though Visual Studio 2022 is 64-bit, it doesn’t change thebitness of the apps you build. You can still create and deploy 32-bitapplications.
Full	 .NET	 9.0	 SupportAs of version 17.12, Visual Studio 2022 has full support for .NET 9.Visual Studio 2022 provides an excellent developer experience forworking with .NET 9 projects, and new features such as AI productivityenhancements, GitHub Copilot, Git tooling, and IDE enhancementsreduce developer toil signi�icantly.
Using	 WorkloadsAfter Visual Studio has been installed, you can customize theinstallation by selecting feature sets, also known as workloads. Think ofworkloads as a collection of individual features that belong together.This allows you to easily modify Visual Studio to include only what youneed.To launch the workloads screen, �ind the Visual Studio Installerfrom the Start menu (this is on Windows 11), shown in Figure 1-2.

Figure	1-2 Find the Visual Studio InstallerClicking the Visual Studio Installer will launch the installer fromwhere you can click on the Modify button next to your installed



instance of Visual Studio to modify your installation, as seen in Figure1-3.

Figure	1-3 Installing Additional WorkloadsIf you want to start doing Python development, you can check the
Python	development workload and install that. As can be seen in Figure1-4, this will update the installation details section and show youexactly what is being installed and how much additional space you willneed to install the selected workload.



Figure	1-4 Workload Installation Details



The workloads also contain tabs, namely, Workloads, Individualcomponents, Language packs, and Installation locations. If you need toinstall an additional component such as Service Fabric Tools, you cando so by selecting the component on the Individual components tab.When you have selected all the workloads and individualcomponents you would like to install, you can choose to do theinstallation while downloading or to download everything beforeinstalling, as shown in Figure 1-5.

Figure	1-5 Installation OptionsThis will modify your existing installation of Visual Studio 2022 andapply the changes you selected.
Exploring	 the	 IDEThe Visual Studio IDE is full of features and tools that help developersdo what they need to do, ef�iciently and productively. Developers startoff creating one or more projects that contain the logic for their code.These projects are contained in what we call a solution. Let’s have alook at the Solution Explorer �irst.
The	 Solution	 ExplorerIn Visual Studio, the notion of solutions and projects is used. A solutioncontains one or more projects. Each project contains code that runs thelogic you need for your application to do what it does.Consider the example of a Shipment Locator application as can beseen in Figure 1-6.



Figure	1-6 The Shipment Locator SolutionIt is with this solution that you will add all the required projects tocreate your application. From the example in Figure 1-6, we can seethat the solution contains three projects. The projects are as follows:ShipmentLocator – WinForms application – C#ShipMethodLogic – Class Library – C#Tracking – Class Library – VB.NETOf particular interest, you will notice that you can have a solutionthat contains a mix of C# projects and VB.NET projects. The various



project templates are discussed in Chapter 2 of this book, but if youwould like to read more on creating a new project in Visual Studio, referto the documentation at the following link:
https://docs.microsoft.com/en-
us/visualstudio/ide/create-new-project?view=vs-
2022.Take note that you do not need the AcmeCorpShipping sourcecode for this chapter. The project is illustrative and is used to explainthe concepts of Visual Studio solutions and projects. If, however, youwould like to view the code, it is available from the GitHubrepository for this book at the following URL:
github.com/apress/getting-started-vs2022.You are therefore not limited by a particular language and cancreate applications containing a mix of .NET languages.The reason that we can mix .NET languages in the same solutionis due to something we call IL (Intermediate Language). IL is used bythe .NET Framework to create machine-independent code from thesource code used in your projects.The WinForms application will contain the UI needed to track andtrace shipments. For the WinForms application to be able to use thelogic contained in the other two class libraries, we need to add what iscalled a reference to the other projects.This is done by right-clicking the project that you want to add thereference to and selecting Add	Reference from the context menu (Figure1-7).

https://docs.microsoft.com/en-us/visualstudio/ide/create-new-project%253Fview%253Dvs-2022


Figure	1-7 Adding a Project ReferenceWhen you click the Add Reference menu, you will be presented withthe Reference Manager screen shown in Figure 1-8.



Figure	1-8 The Reference Manager ScreenUnder the Projects tab, you will �ind the other two Class Libraryprojects in your solution. By checking each one and clicking the OKbutton, you will add a reference to the code in these projects.If you had to expand the References section under theShipmentLocator project, you will see that there are two references toour Class Library projects ShipMethodLogic and Tracking as can beseen in Figure 1-9.



Figure	1-9 Added ReferencesThis will now make all the code you write in the ShipMethodLogicand Tracking projects available to the ShipmentLocator project. Havinga look at the toolbar on the Solution Explorer (Figure 1-10), you willnotice that it contains several buttons.



Figure	1-10 The Solution Explorer ToolbarThe buttons contained here are displayed as needed. The View Codebutton, for example, will only show up in the toolbar when a �ilecontaining code is selected in the Solution Explorer. These buttons giveyou quick access to the following features, as outlined in the following:1. Preview Selected Items  2. Properties  3. Show All Files  4. Collapse All  5. Pending Changes Filter  6. Toggle between Solution and Folder views I will not go through each one in detail, but of particular interest,you will notice that the Show All Files will display unnecessary �iles andfolders such as the bin folder in your Solution Explorer. Go ahead andclick the Show All Files button, and look at the Solution Explorer again.By looking at Figure 1-11, you can see that it now displays the binfolder and the obj folder. These folders are not necessary for your codebut are important to your solution.The obj folder contains bits of �iles that will be combined toproduce the �inal executable. The bin folder contains the binary �ilesthat are the executable code for the application you are writing.Each obj and bin folder will contain a Debug and Release folder thatsimply matches the currently selected build con�iguration of yourproject.



Figure	1-11 Solution Explorer Displaying All FilesYou can now right-click the bin folder, as seen in Figure 1-12, andclick the Open Folder in File Explorer menu to quickly have a look at thecontents of the folder.



Figure	1-12 Open Folder in File ExplorerThis is a nice shortcut for anyone needing to navigate to the locationof the Visual Studio �iles in the solution.



If you open the bin folder and click the Debug folder contained inthe bin folder, you will see the main exe as well as any referenced dll�iles in the project (Figure 1-13).

Figure	1-13 The Contents of the Debug FolderThese �iles will be updated each time you build or run your project.If this folder is blank, perform a build of your solution by pressing F6 orby right-clicking the solution and clicking Build Solution from thecontext menu, as seen in Figure 1-14.





Figure	1-14 Right-Click Solution OptionsYou might be wondering what the difference is between BuildSolution, Rebuild Solution, and Clean Solution. The differences are asfollows:Build Solution will do an incremental build of the solution foranything that has changed since the last build.Rebuild Solution will clean the solution and then rebuild it fromscratch.Clean Solution will only clean the solution by removing any buildartifacts left over by the previous builds.If you are encountering unexpected build errors that do not seem tobe errors in your code editor, try cleaning your solution and thenbuilding it again.
ToolboxWhen dealing with a UI �ile such as a web application or a WinFormsapplication, you will notice that you have a Toolbox at your disposal(Figure 1-15).



Figure	1-15 The WinForms Toolbox in Visual StudioThe Toolbox allows you to add controls to your application such astext boxes, buttons, drop-down lists, and so on. This allows developersto design the UI of the application by dragging and dropping therelevant controls on the design surface.You can also open the Toolbox by clicking the View menu andselecting the Toolbox menu item. It is worth noting that for someproject types, you will not see any items in the Toolbox.If you do not like the default layout of the Toolbox, you can right-click the tab or an individual item in the Toolbox and perform one ofseveral actions from the context menu, as seen in Figure 1-16.



Figure	1-16 Toolbox Context MenuThe context menu allows you to do the following:Rename an itemChoose additional itemsRemove itemsMove items up and downSort itemsAdd a new tabIf you have third-party controls installed such as DevExpress orTelerik, you will �ind the controls speci�ic to the installed componentsunder their own tab in the Toolbox.
The	 Code	 EditorLet’s add some basic UI components to our WinForms application(Figure 1-17). To this code-behind, we will add some code to our



project, just to get the ball rolling. All that this application will do is takea given waybill number and return some location data for it.

Figure	1-17 The Application DesignAfter adding the UI elements to the designer, open the code windowfor the main WinForms application called Form1.cs. Add the code inListing 1-1 to the code-behind.You will notice after adding the code that Visual Studio starts tounderline some of the added code, as shown in Figure 1-18. This isbecause Visual Studio is making suggestions to improve the quality ofyour code.
private int WBPartB(int min, int max)
{
    var rngCrypto = new
RNGCryptoServiceProvider();
    var bf = new byte[4];

    rngCrypto.GetBytes(bf);
    var result = BitConverter.ToInt32(bf, 0);



    return new Random(result).Next(min, max);
}

Listing	1-1  The Code-Behind Form1.cs

Figure	1-18 Visual Studio Code Improvement SuggestionsThe underlined code is code that Visual Studio is makingsuggestions for improvement on.To view the details of the suggestion, hover your mouse over one ofthe underlined lines of code. Visual Studio will now display the detailsof the suggested change as seen in Figure 1-19.

Figure	1-19 Code Change Suggestion



Here, we can see that Visual Studio is warning you that the use ofthe RNGCryptoServiceProvider is considered obsolete. At thebottom of the code editor, you will also see that Visual Studio displaysthe count of errors and warnings as seen in Figure 1-20.
Figure	1-20 Errors and WarningsYou are able to navigate between the warnings and errors byclicking the up and down arrows. You can also perform a code cleanupby clicking the little brush icon or by holding down Ctrl+K, Ctrl+E.After cleaning up the code and adding the code suggestions, VisualStudio displays a clean bill of health (Figure 1-21).
Figure	1-21 Code Suggestions AppliedWith these types of code improvements, you can be sure that youare writing code that is performant and generally free of basic errors.
Hot	 ReloadStarting in Visual Studio 2022, the Hot Reload feature works for bothmanaged .NET and native C++ apps. Hot Reload saves a developer fromhaving to stop the debug process between edits. This means lessrebuilding, restarting, and renavigating to the speci�ic location in theapplication you were debugging.For a list of supported .NET app frameworks and scenarios, view thedocument at the following link:
https://docs.microsoft.com/en-
us/visualstudio/debugger/hot-reload?view=vs-
2022#supported-net-app-frameworks-and-scenarios.

https://docs.microsoft.com/en-us/visualstudio/debugger/hot-reload%253Fview%253Dvs-2022%2523supported-net-app-frameworks-and-scenarios


Navigating	 CodeVisual Studio provides several features allowing developers to navigatecode throughout the solution. Knowing how to use these navigationfeatures will save you a lot of time.
Navigate	 Forward	 and	 Backward	 CommandsIf you look at the toolbar in Visual Studio, you will see the NavigateForward (Ctrl+Shift+-) and Navigate Backward (Ctrl+-) buttons. Theseallow developers to return to the last 20 locations that the developerwas at, as displayed in Figure 1-22.

Figure	1-22 Navigate Forward and BackwardYou can also �ind these commands from the View menu underNavigate Backward and Navigate Forward.



Navigation	 BarThe navigation bar in Visual Studio (Figure 1-23) provides drop-downboxes that allow you to navigate the code in the code base. You canchoose a type or member to jump directly to it in the code editor.

Figure	1-23 Visual Studio Navigation BarIt is useful to take note that members de�ined outside the currentcode �ile will be displayed but will be disabled and appear gray. You cancycle through the drop-down boxes in the navigation bar by pressingthe tab key.Each drop-down also has its own individual function. The left drop-down will allow you to navigate to another project that the current �ilebelongs to. To change the focus to another class or type, use the middledrop-down to select it. To navigate to a speci�ic procedure or anothermember in a particular class, select it from the right drop-down.
Find	 All	 ReferencesVisual Studio allows you to �ind all the references for a particularelement in your code editor. You can do this by selecting the codeelement and pressing Shift+F12 or by right-clicking and selecting Find
All	References from the context menu.



Figure	1-24 Find All References ResultsThe �ind results are displayed in a tool window as seen in Figure 1-24. The toolbar for the �ind results tool window, as seen in Figure 1-25,is also really helpful.
Figure	1-25 References Window ToolbarFrom here, you can do the following:Change the search scopeCopy the selected referenced itemNavigate forward or backward in the listClear any applicable search �ilters (�ilters are added by hovering overa column in the results window and clicking the �ilter icon that isdisplayed)Change the grouping of the returned resultsKeep the search results (new searches are opened in a new toolwindow)Search the returned results by entering text in the Search Find AllReferences text boxHovering your mouse on a returned search result will pop up apreview screen of the code. To navigate to a search result, press theEnter key on a reference or double-click it.
Find	 Files	 FasterWhen compared to Visual Studio 2019, the Find in Files feature inVisual Studio 2022 is more than 2x faster for 95% of searches. Startingin Visual Studio 2022 17.1 Preview 3, Microsoft introduced indexedFind in Files. This means that according to benchmarks provided byMicrosoft, all matches to a search query are returned in just over onesecond, making the search experience feel instantaneous.
Reference	 Highlighting



Visual Studio makes it easy to see selected items in the code editor. Ifyou click a variable, for example, you will see all the occurrences of thatvariable highlighted in the code editor, as seen in Figure 1-26.

Figure	1-26 Default Reference HighlightingBut did you know that you can change the color of the highlightfrom the Options in Visual Studio? Go to Tools	➤	Options	➤
Environment	➤	Fonts	and	Colors	➤	Highlighted	Reference as seen inFigure 1-27.



Figure	1-27 Change the Highlighted Reference ColorChange the color to yellow and click OK. All the references to thevariable you just selected will now be highlighted in yellow.
Go	 To	 CommandsI’ll admit that these are probably the commands that I use the least inVisual Studio. All with the exception of Ctrl+G. Go ahead and openVisual Studio, and press Ctrl+G while in the code editor.As shown in Figure 1-28, a window appears that lets you jumpdirectly to a speci�ic line. This is especially useful when working withlarge code �iles.



Figure	1-28 Go To LineThe list of Go To commands is as follows:Ctrl+G – Go To Line allows you to move to the speci�ied line numberin the currently active document.Ctrl+T or Ctrl+, – Go To All allows you to move to the speci�ied line,type, �ile, member, or symbol.Ctrl+1, Ctrl+F – Go To File allows you to move to a speci�ied �ile in thesolution.Ctrl+1, Ctrl+R – Go To Recent File allows you to move to a recentlyvisited �ile in the solution.Ctrl+1, Ctrl+T – Go To Type allows you to move to a speci�ic type inthe solution.Ctrl+1, Ctrl+M – Go To Member allows you to move to the speci�icmember in the solution.Ctrl+1, Ctrl+S – Go To Symbol allows you to move to the speci�icsymbol in the solution.Alt+PgDn – Go To Next Issue in File.Alt+PgUp – Go To Previous Issue in File.Ctrl+Shift+Backspace – Go To Last Edit Location.While pressing Ctrl+1 might seem slightly �inicky, you soon get usedto it, and the commands start to feel more natural.Ctrl+Shift+Backspace is another command that I �ind very useful.
Go	 To	 De�initionGo To De�inition allows you to jump to the de�inition of the selectedelement. Go to the example project for this chapter, and �ind the click



event for the Track button.Just a reminder that the code for this book can be downloadedfrom GitHub at the following URL:
github.com/apress/getting-started-vs2022.In there, you will see that we are working with a class called
Package that creates a new package we would like to track.Place your cursor on Package, and hit F12 to jump to the classde�inition as seen in Figure 1-29. You can also hold down the Ctrlbutton and hover over the class name. You will notice that the
Package becomes a link you can click. Lastly, if you have your feet upand you only have your mouse to navigate with (the other hand isholding a cup of coffee), you can right-click and select Go	To	De�initionfrom the context menu.

Figure	1-29 Go To De�inition
Peek	 De�inition



Where Go To De�inition navigates to the particular de�inition inquestion, Peek De�inition simply displays the de�inition of the selectedelement in a pop-up. Place your cursor on Package and right-click.From the context menu, select Peek De�inition.

Figure	1-30 Peek De�inition Pop-upAs can be seen in Figure 1-30, the pop-up window displays the codefor the Package class. You can navigate through the code displayed inthis pop-up as you would any other code window. You can even usePeek De�inition or Go To De�inition inside this pop-up.In the pop-up window, right-click Location, and select PeekDe�inition from the context menu. The second Peek De�inition will starta breadcrumb path as seen in Figure 1-31.



Figure	1-31 Breadcrumb PathYou can now navigate using the circles and arrows that appearabove the Peek De�inition pop-up window. The arrows only appearwhen you hover your mouse over the circles, but this makes it mucheasier to move between the code windows.
Subword	 NavigationSubword navigation is a very nice feature in Visual Studio 2022.Suppose you have a method name called DetermineValueOfFoothat consists of four subwords, namely, Determine, Value, Of, and
Foo. Subword navigation allows you to move the caret to the next orprevious subword in the string by holding down Ctrl+Alt+Left orCtrl+Alt+Right. To select the previous or next subword, hold downCtrl+Alt+Shift+Left or Ctrl+Alt+Shift+Right. This will select the nextsubword in the string. You can also turn on Select subword on doubleclick by going to Tools ➤ Options ➤ Text Editor ➤ General and checkthe Select subword on double click option. Now, when you double-click



a string, it will select the current subword you clicked instead of theentire string.
Features	 and	 Productivity	 TipsVisual Studio is full of existing productivity tips that have been aroundfor years and that some developers do not know about. In this section,we will be looking at some of those.
Track	 Active	 Item	 in	 Solution	 ExplorerIn Visual Studio, this option is not on by default. As you change the code�ile you are working in, the �ile isn’t highlighted in the Solution Explorer.You will know this is the case when you see the following arrows in thetoolbar of the Solution Explorer, as seen in Figure 1-32.

Figure	1-32 Track Active Item in Solution ExplorerClicking these arrows will highlight the �ile that you are currentlyediting in the Solution Explorer. I �ind this extremely useful, so I letVisual Studio permanently track the current �ile. To set this, click Tools
➤ Options ➤ Projects and Solutions ➤ General, and check Track ActiveItem in Solution Explorer (Figure 1-33).



Figure	1-33 Track Active Item SettingWith this setting enabled, the arrows are not displayed in thetoolbar of the Solution Explorer.
Hidden	 Editor	 Context	 MenuWhen you are in a code �ile, you can access a variety of menu items byright-clicking and selecting the menu items in the context menu. Butdid you know that you can hold down Alt+` to bring up a special contextmenu (that is different from right-click)? It has more editor commandsin it, as seen in Figure 1-34.



Figure	1-34 Special Context MenuThis gives you a little more control over navigating through errors,methods, etc., in your current code �ile.
Open	 in	 File	 ExplorerSometimes, you need to quickly get to the actual Visual Studio �iles ofyour solution. This might be to go and copy a �ile from the bin folder orto open a �ile in another text editor. To do this, you don’t even need to



leave Visual Studio. As seen in Figure 1-35, you can right-click thesolution and click Open Folder in File Explorer.

Figure	1-35 Open Folder in File ExplorerThis will open a new File Explorer window where your VisualStudio solution is located.
Finding	 Keyboard	 Shortcut	 MappingsSometimes, when you use a keyboard shortcut and nothing happens,you might be using it in the wrong context. To see what keyboard



shortcuts are mapped to, head on over to Tools ➤ Options ➤Environment ➤ Keyboard, as seen in Figure 1-36.

Figure	1-36 Find Keyboard Shortcut MappingsPress the shortcut keys, and Visual Studio will show you what theshortcut is currently used for. This is also very useful for assigning newkeyboard shortcuts to check that the keyboard shortcut you have inmind is not already bound to another command.
Clipboard	 HistoryVisual Studio allows you to access your clipboard history. This is veryuseful if you have to copy and paste several items repeatedly.Instead of going back and forth between copy and paste, simplyhold down Ctrl+Shift+V to bring up the clipboard history as seen inFigure 1-37.



Figure	1-37 Clipboard HistoryNow you can just select the copied text that you want to paste andcarry on with editing your code. The copied item also remains in theclipboard history after pasting.
Go	 To	 WindowSo this could actually have gone under the “Navigating Code” section,but I wanted to add it here because it made more sense to discuss it as aproductivity tip.Hold down Ctrl+T and you will see the Search window pop up asseen in Figure 1-38.



Figure	1-38 Go To windowYou can view the recent �iles by typing in an r. Also nice to note isthe ability to jump to a speci�ic line of code. You will remember earlierin the chapter that we discussed the Go To commands and Ctrl+G inparticular. Here, you can do the same thing by typing in : followed bythe line number.
Navigate	 to	 Last	 Edit	 LocationEarlier in this chapter, we discussed the Navigate Backward andNavigate Forward commands. This is great, but if you want to navigateto the last place you made an edit in the code �ile, hold downCtrl+Shift+Backspace. This will jump to the last place that you made anedit in one of your code �iles.
Multi-caret	 EditingThis is a feature that I love using. Consider the SQL create tablestatement in Listing 1-2.
CREATE TABLE [dbo].[menu](
        [itemName] [varchar](50) NOT NULL,
        [category] [varchar](50) NOT NULL,
        [description] [varchar](50) NOT NULL,
 CONSTRAINT [PK_menu] PRIMARY KEY CLUSTERED
Listing	1-2 Create SQL Table StatementThis is a rather small table, but sometimes we have very large tablesthat we need to work with. I want to create a simple C# class for thistable and need to create some C# properties. Why type out everythingwhen you can copy, paste, and edit all at once?Paste the column names into a C# class �ile, then hold downCtrl+Alt, and click in front of the �irst square bracket of each column ascan be seen in Figure 1-39.



Figure	1-39 Multi-caret SelectionThe cursor is placed at each line at the position you placed it. Nowstart typing the property de�inition. All the lines are edited. After typing
public string, hit delete to remove the �irst square bracket.I now want to add the { get; set; } portion of my property. Ican either do the same multi-caret selection or select one or morecharacters and hold down Shift+Alt+. to select matching selections asseen in Figure 1-40.

Figure	1-40 Selecting Matching SelectionsThis now allows me to easily select exactly all the lines I want to editat the same time and allows me to paste the { get; set; } neededfor my properties. I now end up with the completed code as seen inFigure 1-41.
Figure	1-41 Completed Code Properties



Being able to easily select code or place a caret in several places onthe same line or across lines allows developers to be �lexible whenediting code. Speaking about placing the caret in several places on thesame line, it is, therefore, possible to do the one shown in Figure 1-42.

Figure	1-42 Multi-caret Selection on the Same LineWe can now edit everything at once (even if we have selectedmultiple places on the same line), as seen in Figure 1-43.

Figure	1-43 Multi-caret Editing on the Same LineHolding down Ctrl+Z will also work to undo everything at once. Ifyou want to insert carets at all matching selections, you can select sometext and hold down Shift+Alt+; to select everything that matches yourcurrent selection, as seen in Figure 1-44.



Figure	1-44 Insert Carets at All Matching SelectionsI selected the text “cat” and held down Shift+Alt+; and Visual Studioselected everything that matches. As you can see, it also selected thecategory property, which I don’t want to be selected. In this instance,Shift+Alt+. will allow me to be more speci�ic in my selection.If you �ind yourself forgetting the keyboard shortcuts, you can �indthem under the Edit menu. Click Edit ➤ Multiple Carets to see thekeyboard shortcuts.
Sync	 Namespaces	 to	 Match	 Your	 Folder	 StructureAnother great feature is the ability to keep your namespaces in syncwith your folder structure. This is useful when you need to restructureyour solution by moving �iles around to new folders. What you want todo is ensure that the namespace in the �ile stays in sync with the newfolder structure. To do this, place your cursor on the namespace name



and hold down Ctrl+. to bring up the Quick Actions and Refactoringmenu. Select the option to change the namespace to your folder name.
Paste	 JSON	 As	 ClassesIf you work with JSON often, the following feature is another gem. If youhave copied some JSON and need an object to serialize and deserializethe JSON into (using System.Text.Json, for example), you can select Editfrom the Visual Studio menu, and select the Paste Special option. Fromthere, you will see an option to Paste JSON as Classes. You can do thesame for XML. This will quickly generate the correct class structure torepresent the JSON copied by yourself. This is a fantastic time saver.
Enable	 Code	 Cleanup	 on	 SaveAnother great feature in Visual Studio 2022 is the ability to perform acode cleanup on save. From the Tools menu, select Options ➤ TextEditor ➤ Code Cleanup as seen in Figure 1-45.

Figure	1-45 Code Cleanup on Save



Here, you will see that you can con�igure the code cleanup optionsby clicking the link and selecting the available �ixes to apply. Once youhave con�igured a code cleanup pro�ile, you can check the option to runthe code cleanup pro�ile when saving a �ile.
Add	 Missing	 Using	 on	 PasteDevelopers often copy and paste code found in another section of theproject or from another online resource. Doing this usually requiresdevelopers to add the missing using statements. Now you can enablethis feature to automatically add the missing using statements whenpasting copied code. Go to Tools ➤ Options ➤ Text Editor ➤ C# ➤Advanced and scroll down a bit, and you will see an option to Addmissing using directives on paste.
Customize	 File	 EncodingFor developers that work in cross-platform environments, there is oftena need to save �iles with speci�ic encodings. Visual Studio now allowsdevelopers to set the default �ile encoding when saving �iles.

Figure	1-46 Customize File Encoding



To enable this, navigate to Tools ➤ Options ➤ Environment ➤Documents and look for an option titles Save	 Files	 with	 a	 speci�ic
encoding. Check this option to specify the encoding in the adjacentcombo box.
Indent	 Word	 WrapAnother exciting feature is that Visual Studio now allows you to specifywhether wrapped lines are indented in the editor or not.

Figure	1-47 Indent Word Wrap



This option is enabled by default, but if you want to change it, go toTools ➤ Options ➤ Text Editor ➤ General and look for the optionlabeled Automatically	 indent	 when	 wrap	 is	 enabled. Setting thisfeature on can help improve readability for developers with littlescreen real estate.
The	 Horizontal	 Scrollbar	 ReimaginedVisual Studio’s editor tray provides developers with a wealth ofinformation. From controlling the zoom to seeing what line you’re on.All this information can sometimes crowd out the horizontal scrollbar,making it challenging when trying to scroll through your window. Thiscan be especially noticeable when viewing code side-by-side.Visual Studio allows you to control what happens when thescrollbar drops below a usable width.

Figure	1-48 Horizontal Scrollbar LocationGo to Tools ➤ Options ➤ Text Editor ➤ Advanced and change thesetting under Editor	 horizontal	 scrollbar	 location. Doing this willallow you to choose whether the scrollbar changes position accordingto the space available, stays in the editor tray, or always displays abovethe editor tray.
Automatic	 Documentation	 Comment	 GenerationAs you have probably already heard, Copilot is automatically integratedinto Visual Studio’s editor and helps you generate doc comments forfunctions. We will discuss Copilot a little later on in this chapter, butjust know that you will need a GitHub Copilot subscription to accessthis feature. You can sign up for GitHub Copilot for free from
https://github.com/settings/copilot.

https://github.com/settings/copilot


If you have enabled doc comment generation in your settings, youcan simply type /// (or whatever triggers your doc comment format)and Copilot suggestions will allow you �ill out the function descriptionautomatically as seen in Figure 1-49.

Figure	1-49 Automatic Documentation Comment GenerationTo switch on doc comments in your settings (for C#) you need to goto Tools ➤ Options ➤ Text Editor ➤ C# ➤ Advanced and check theoptions under the Comments section.
HTTP	 File	 UpdatesIf you develop API projects, you would, in all likelihood, have used .http�iles in Visual Studio. For those that haven’t worked with .http �iles inVisual Studio, check out this link learn.microsoft.com/en-
us/aspnet/core/test/http-files.Visual Studio now supports using request variables in .http �iles.



Figure	1-50 The .http File in a Minimal API ProjectIf you create a new ASP.NET Core API project in Visual Studio, you willnotice that an .http �ile is included in the template. If you have not used.http �iles before, you might be wondering what the big deal is. It comesdown to this: in order to test my API, I no longer need to use Postmanor Insomnia, for example. I can invoke every endpoint directly insideVisual Studio, edit the request, and see the results instantly. Thistightens my inner dev loop (that edit-build-run-validate cycle),providing less friction while developing API solutions.
Request	VariablesIf you have worked with APIs, you will know that a common thing to dois to read a value from an endpoint and then use that value in asubsequent request. In Visual Studio, .http �iles now support requestvariables.Let’s see this implemented in a working example. The code is inListing 1-3.



@base_address = https://reqres.in/api

###
# 1) Define your login credentials as variables
@username = eve.holt@reqres.in
@password = cityslicka

###
# 2) Login request – name it "login" to capture
the response
# @name login
POST {{base_address}}/login
Content-Type: application/json
x-api-key: reqres-free-v1

{
  "email": "{{username}}",
  "password": "{{password}}"
}

###

# 3) Protected call – reuse the extracted token
GET {{base_address}}/users/1
Authorization: Bearer
{{login.response.body.$.token}}
x-api-key: reqres-free-v1

Listing	1-3 The .http �ileI have used REQRES, which is a handy public API that lets medemonstrate authentication �lows without spinning up my ownbackend. The URL is https://reqres.in, just in case you wanted tohave a look at what is available. Let’s break the .http �ile up and look atthe parts.

https://reqres.in/


Figure	1-51 Top-level AssignmentsThe top-level assignments as seen in Figure 1-51 keep sensitive bitsout of the request body and make the �ile easy to tweak later.

Figure	1-52 Login and Capture ResponseThe line # @name login, as seen in Figure 1-52, tells VisualStudio to store both the request and its response under the name login.After the call completes, everything in that exchange is at my �ingertips.



Figure	1-53 Reuse the TokenIn fact, I can drill into the JSON payload returned by the login requestand pluck out the token �ield by writing
login.response.body.$.token. No more copy-and-paste ormessy edits, stops, and starts. The moment the �irst call succeeds, thesecond request has an up-to-date bearer token.
$shared	EnvironmentUsing the $shared environment allows developers to avoid copy-and-paste overload. Most developers juggle at least two API endpoints. Thisis usually a local and a remote endpoint, and occasionally, they need tojuggle more. Visual Studio’s http-client.env.json �ile allows youto switch between them with a drop-down, but repeating the samevalues in every environment gets old fast. This is where the $sharedsection comes in. Have a look at Listing 1-4.
{
  "$shared": {
    "message": "Shared environment message",
    "username": "httpfile-user",
    "hosturl": "http://example.com/api/sample"
  },
  "dev": {
    "hosturl": "http://localhost:5000/api/sample"
  },
  "prod": {
    "message": "Production environment message"
  }
}



Listing	1-4 The Environment FileHere I have speci�ied a $shared section. These variables will beused everywhere unless an environment overrides them. In otherwords, if a key appears in both $shared and a speci�ic environment,the environment-speci�ic value wins.

Figure	1-54 Selecting the dev EnvironmentLooking at Figure 1-54, you will notice that the environmentselected in the top right corner is the dev environment. The responsefrom this request is listed in Listing 1-5.
{
  "headers": {
    "Host": "httpbin.org",
    "Traceparent": "00-
1da30b3a47f83246b5526d9a8a45cff4-09cbdcf68670250e-
00",
    "X-Amzn-Trace-Id": "Root=1-682aca37-
2257e3d42d17487e328b007c",
    "X-Hosturl":
"http://localhost:5000/api/sample",
    "X-Message": "Shared environment message",
    "X-User": "httpfile-user"
  }
}

Listing	1-5 The dev Response



Changing the environment in the top right corner to prod will resultin the following response, as seen in Listing 1-6.
{
  "headers": {
    "Host": "httpbin.org",
    "Traceparent": "00-
b2825110f3399368fd557ba0eb00d799-bc223e0fa85f9d9f-
00",
    "X-Amzn-Trace-Id": "Root=1-682acaef-
086783095e9bcdc30a87cfc3",
    "X-Hosturl": "http://example.com/api/sample",
    "X-Message": "Production environment message",
    "X-User": "httpfile-user"
  }
}

Listing	1-6 The prod ResponseNotice that the message differs based on the environment, wherethe prod environment’s message variable wins, even though it isde�ined in $shared. The key takeaway here is that the $shared blockturns environment management from a chore into a one-liner.
Features	 in	 Visual	 Studio	 2022Visual Studio 2022 comes packed with a few very nice productivityfeatures. A lot of thought has been put into making Visual Studio easy tonavigate and to �ind things in Visual Studio 2022. The �irst feature Iwant to have a look at is Visual Studio Search.
Visual	 Studio	 SearchI think that we can all agree that more speed equals improvedproductivity. The faster I can access a menu item, and the less time Ihave to spend looking for something, the more my productivityincreases. This is where Visual Studio Search comes in.If you hold down Ctrl+Q, you will jump to the search bar, where youcan immediately start typing, as seen in Figure 1-55.



Figure	1-55 Visual Studio SearchVisual Studio performs a fuzzy search, which means that even if youmisspell a word, chances are that it will know what you intended totype and return the correct results to you. You can even click Ask
Copilot, displayed as a link just under the search box. This will sendyour query to Copilot Chat, resulting in AI-powered search.
Solution	 FiltersSometimes, we have to work on Solutions that contain a lot of projects.More often than not, you as a developer will not be working on everyproject in that speci�ic solution. This is where Solution Filters come in.They allow you to only load the projects that you care about or areactively working on. Consider the currently loaded solution as seen inFigure 1-56.





Figure	1-56 AcmeCorpShipping Solution Un�ilteredYou can see that all the projects are loaded in this solution. If weonly work on the ShipmentLocator and ShipMethodLogic projects, wecan create a Solution Filter to only load those projects. Right-click theprojects that you don’t work on, and click Unload Project from thecontext menu. Your solution will now look as in Figure 1-57.



Figure	1-57 AcmeCorpShipping Solution with Unloaded ProjectsNow, with the projects unloaded that you do not work on, right-clickthe solution and select Save As Solution Filter, as seen in Figure 1-58.





Figure	1-58 Save As Solution FilterVisual Studio will create a new type of solution �ile with an .slnf �ileextension as seen in Figure 1-59.

Figure	1-59 Save as Solution Filter FileWhen you open your project using the Solution Filter, you will see,as in Figure 1-60, that only the projects you selected to keep will beloaded.



Figure	1-60 Filtered SolutionNow with the �iltered solution, if you click the solution, you will seethat you can Load App Projects, Show Unloaded Projects, or LoadProject Dependencies from the context menu as seen in Figure 1-61.





Figure	1-61 Filtered Solution Context MenuYou still have full control of the �iltered solution from the contextmenu and can easily load the full solution as needed.

Figure	1-62 Updating the Solution FilterIf you load additional solutions as shown in Figure 1-62, VisualStudio will notice this change and ask if you would like to update yoursolution �ilter. Managing solution �ilters is easily accomplished withouthaving to go through the Save As Solution Filter process, as detailed inFigure 1-58.
Visual	 Studio	 IntelliCode



Visual Studio IntelliCode is a really nice feature that has been added toVisual Studio. Microsoft calls it AI-assisted development because it usesmachine learning to �igure out what you are most likely to use next andput that suggestion at the top of your completion list. These are usuallydisplayed as starred recommendations.Without IntelliCode, when you dot on an object such as our
package object in the AcmeCorpShipping solution, you will see theusual completion list that Visual Studio displays. With Intellicodeenabled, you will see suggestions appear at the top of the completionslist with a star icon net to them as shown in Figure 1-63.

Figure	1-63 Visual Studio Completion ListPreviously Visual Studio provided the ability to train a model onyour code. This provided model completions for your team projects,libraries, and APIs using a simple Markov-chain model to rank methodsin the IntelliSense list. As of Visual Studio 2022 (version 17.0+), this isno longer available. Instead, custom methods are ranked with the help



of a neural encoder model. This means that IntelliCode uses an on-device deep-learning network that sits on top of the static analyzer’scandidates. The bene�its are as follows:It works everywhere, even on code you’ve never shared or that isn’tpart of the public training corpus.Code-aware completions, tuned to your project without any manualtraining.Total privacy because everything runs locally. Your source code neverleaves your machine.The slimmed-down model design leads to a reduced memoryfootprint and improved inference speed.Behind the scenes, the model continually re�ines its ranking bylooking at:Language and dependencies – it understands the syntax,frameworks, and packages you’re using.Your recent edits – it learns from your coding patterns as you work,so suggestions are current with your style.By embedding a continually adapting deep learning model intoVisual Studio, IntelliCode turns IntelliSense into a proactive codingpartner.
Visual	 Studio	 Live	 ShareDuring my years of writing code, I have often needed to explain someportion of logic or a feature of the code I am working with to anotherdeveloper. This usually involves them having to get a copy of the codebase from source control and us having to direct each other over aTeams call, quoting line numbers to collaborate effectively. No longerwith Visual Studio Live Share.To �ind out more about Visual Studio Live Share, go to
https://visualstudio.microsoft.com/services/live
-share/.Visual Studio Live Share is included by default in Visual Studio2022. Visual Studio Live Share does not require developers to be all “set

https://visualstudio.microsoft.com/services/live-share/


up” to assist each other or to collaborate on projects. This means that adeveloper running Visual Studio Code on a Linux machine cancollaborate with another developer running Visual Studio 2022 on aWindows 11 machine.To start a Visual Studio Live Share session, you need to click the LiveShare icon in the top-right corner of Visual Studio 2022 next to theGitHub Copilot button as can be seen in Figure 1-64.

Figure	1-64 Visual Studio Live Share IconWhen you click the icon, Visual Studio starts up Live Share, and theprogress is indicated as shown in Figure 1-65.

Figure	1-65 Visual Studio Live Share in ProgressWhen the sharing link has been generated, Visual Studio will displaya noti�ication (Figure 1-66).



Figure	1-66 Visual Studio Live Share Link GeneratedIt is copied to the clipboard by default, but you can copy it again,make it read-only, or learn more about secure sharing. When you sharethe link with a colleague, they simply have to paste the link into abrowser to start the collaboration. Figure 1-67 shows the browser asseen by your colleague after pasting the link you shared with them.They have the option of opening Visual Studio or Visual Studio Code.

Figure	1-67 Starting Visual Studio Live Share SessionIn this example, I am sharing the link with a developer that isrunning Visual Studio Code on Linux Mint.



Figure	1-68 Visual Studio CodeWhen Visual Studio Code is opened, my colleague will see that I amcurrently active in the codebase as shown in Figure 1-68.



Figure	1-69 Live Share Chat in Visual StudioOn my machine, I can see that my colleague has joined the session(Figure 1-69) and I can chat with him.

Figure	1-70 Visual Studio Sharing IndicatorThe icon in Visual Studio also changes to show that I am currently ina Live Share session with someone (Figure 1-70). I can click on this iconto access more options, as seen in Figure 1-71.

Figure	1-71 Live Share Options



From there, I can end the Live Share session, share the terminal,manage shared servers, focus participants, or copy the sharing linkagain. At any time, I am in total control of what I share. It is alsoimportant to note that my code lives on my machine. It is not saved onthe participant’s machine.
Copy	 Files	 Across	 Visual	 Studio	 InstancesIn the past, transferring code �iles between Visual Studio instances hasbeen a tedious task. Developers often had to manually relocate �iles andin doing so, risk introducing errors. Now that toil is a thing of the pastwith the new copy and paste functionality. The process is, well, as youwould expect.Select the �ile or folder from the Solution Explorer of one VisualStudio instance.Use Ctrl+C or Ctrl+X to copy or cut the �ile or folder.Switch to another instance of Visual Studio where you want the �iles.Use Ctrl+V to paste the copied or cut �ile or folder.The changes will be re�lected in the second instance of VisualStudio’s Solution Explorer.Developers can also drag and drop �iles and folders betweeninstances, giving them even more �lexibility in managing their projects.This feature is available in all major project types in Visual Studio.
Adding	 and	 Using	 GitHub	 CopilotPowering your Visual Studio experience using AI is easier than youthink with GitHub Copilot. To get started, make sure that you are usingthe latest version of Visual Studio 2022. You can then start using GitHubCopilot for free with limited access to select Copilot features. No trial orcredit card is required; you only need your GitHub account.



Figure	1-72 Sign in to Visual StudioAfter installation, you will see the sign-in options (Figure 1-72) forVisual Studio pop up. If you have an existing installation of VisualStudio, ensure that you are on the latest version and add your GitHubaccount from the accounts selector (top right in Visual Studio).



Figure	1-73 Select User to AuthorizeYou will be redirected to GitHub to select a user to authorize withVisual Studio, as seen in Figure 1-73.



Figure	1-74 Install CopilotOnce you have signed in with your Visual Studio account, you canclick on the GitHub Copilot button to install Copilot as seen in Figure 1-74.

Figure	1-75 Visual Studio InstallerThis will display the Visual Studio Installer with GitHub Copilotselected as a component to install. You can also run the Visual StudioInstaller and select to install GitHub Copilot from the IndividualComponents tab under the AI Assistance section.It is important to note that GitHub Copilot is merely an assistant.It makes mistakes and it is up to you as developer to verify theaccuracy of the output.



After installing GitHub Copilot you will see the Copilot Chat tab asshown in Figure 1-76.





Figure	1-76 Copilot ChatRight off the bat there are a few things to take note of here. In thechat window you can type @ to reference a workspace, type #, or attacha �ile (such as an image) by clicking on the + button to give Copilot morecontext on what you are asking. You can also type / to use one of themany commands at your disposal.
GitHub	 SettingsOn github. com, navigate to the settings under your pro�ile icon in thetop right. Once there, under the Code, planning, and automationsection, look for Copilot and click on the Features menu. Here you can�ind various settings associated with GitHub Copilot.

Figure	1-77 GitHub Copilot SettingsAs seen in Figure 1-77, for example, I have selected to enable Claude3.5 and 3.7 Sonnet in Copilot.

http://github.com/


Figure	1-78 GitHub Copilot Model SelectionIn Visual Studio on the GitHub Copilot Chat Tab (Figure 1-78), youwill notice that these models are available for selection.
GPT-4.1	 Code	 Completion	 ModelThe GPT-4.1 code completion model is now available for GitHubCopilot, starting in Visual Studio 17.14. This model is based on GPT-4omini and has undergone additional training on over 275,000 publicrepos across more than 30 programming languages.This means that developers can expect more accurate codesuggestions and better performance. To select the code completionsmodel, in Visual Studio, go to Tools ➤ Options ➤ GitHub ➤ Copilot, asseen in Figure 1-79.



Figure	1-79 Copilot Completions ModelUnder the Copilot Completions section, check the option to enableCopilot Completions and select the Completions model from thedropdown selector.Using this completion model will further enhance your productivityas a developer, providing higher quality code completions.New models are often released. GPT-5 was released after thepublication of this chapter. As a result, it is now available from theModel Selector in Copilot. You can now also manage your modelsfrom the Visual Studio model selector in Copilot. This displays ascreen to choose a provider (OpenAI, Google, or Anthropic) and toenter your own API key. Essentially, allowing you to “Bring Your OwnModel” into GitHub Copilot.



Figure	1-80 GitHub Copilot Settings
You can also access the settings by clicking on the GitHub Copilotbadge on the top right corner of Visual Studio and going to Settings ➤Options, as seen in Figure 1-80.

Code	 CompletionsWith Copilot installed and active, you will notice ghost text appear inyour editor as you type.



Figure	1-81 Ghost Text Code SuggestionAs seen in Figure 1-81, Copilot suggests what it thinks your next lineof code or code completion should be. You can hot tab to accept this orclick on the arrow to accept or dismiss the code suggestion.

Figure	1-82 Code Completion from CommentAnother feature of Copilot’s code completion suggestion is thatwhen you type a comment in your code, it will use this as context tosuggest the code you need to add next. As seen in Figure 1-82, I haveadded a comment that I want to add anti-forgery middleware. When Ihit enter to add a new line, Copilot suggests the code to accomplish this.
Inline	 ChatGitHub Copilot allows you to chat with it in Visual Studio, displayinganswers in the code editor window itself.



Figure	1-83 Ask CopilotIf you right-click in the code editor, you will notice that Ask Copilotis available, as seen in Figure 1-83. You can also type Alt+/ to invoke it.
Figure	1-84 Chatting with CopilotAfter invoking Copilot, you will see a chat window displayed in yourcode editor, as seen in Figure 1-84. Here you can also select the model



to use to chat with.

Figure	1-85 Asking Copilot a QuestionTo ask Copilot a question, simply type it in the chat window andclick on the send button, as seen in Figure 1-85.



Figure	1-86 Copilot ResponseCopilot responds in the editor as shown in Figure 1-86. Theresponse is usually detailed and you can scroll through the response.



Figure	1-87 Continue in Chat WindowAt the end of the in-line chat window, you will see an option tocontinue in the chat window. This will send the response to the Copilottab, and you can continue the conversation there instead of in-line inthe code editor.
Slash	 CommandsAnother feature you can make use of is slash commands. As seen inFigure 1-88, you can type a /and then select the desired command.

Figure	1-88 Available Slash CommandsTry the /doc command and see what happens.
Copilot	 Agent	 Mode



A feature of GitHub Copilot Chat is Copilot Agent (formerly known asCopilot Edits). It is designed to iterate across multiple �iles moreef�iciently. It offers the conversational �low of a chat with an inlinereview experience and provides the following bene�its:Know exactly what changes are going to be made with a summary ofthe affected �iles and proposed changes.See the code diffs inline in your editor allowing you to press the tabkey to accept or the Alt+Del key to reject changes.Allows you to use checkpoints to revisit earlier iterations of a code�ile or apply an alternate approach for new ideas.The feature is a solid addition to GitHub Copilot and you might bewondering when to use Copilot Chat as opposed to Copilot Agent. Tochoose when to use which, think of it as follows. Copilot Chat providesdevelopers with a general-purpose conversational interface in VisualStudio for exploring programming concepts, asking questions about thecode in your solution, asking questions about C#, and generating codesnippets on demand. This allows you to manually apply suggestionsand rely on your normal Git version control.Copilot Agent, on the other hand, offers a focused multi-�ile editingwork�low that automatically previews diffs across all affected �iles andallows you to accept or reject individual changes. It also maintains abuilt-in rollback history to reset any edits until you close Visual Studio.



Figure	1-89 Copilot AgentEnsure Agent mode is enabled by going to Tools ➤ Options ➤GitHub ➤ Copilot and checking the option to Enable Agent mode. Youmight need to restart Copilot Chat or Visual Studio. To access CopilotAgent, select Agent from the dropdown menu as shown in Figure 1-89.Go ahead and ask it a question and review the results (Figure 1-90).To illustrate the power of Copilot Agent in screenshots in a book isto do it an injustice. You have to experience it �irst-hand.



Figure	1-90 Copilot Agent in ActionHere, I have asked it to modify the standard logic in the Weather APIboilerplate code that comes with the API template in Visual Studio.



Figure	1-91 Copilot Agent DiffAfter Copilot Agent is done, it builds my project and offers a codediff of my code for me to review and accept or reject.

Figure	1-92 Revert All ChangesAs seen in Figure 1-92, you can click on the Restore link next to thecreated checkpoint in the Copilot Chat window to revert all the changesto your documents since the beginning of the iteration.You can also click on the Keep or Undo buttons below each code �ile.
Agent	 Mode	 Tools	 and	 Using	 MCP	 Servers



Agent mode allows developers to use built-in tools or MCP tools. ModelContext Protocol (MCP) is an open standard that gives AI models theability to interact with external tools and services. Visual Studio allowsdevelopers to enhance GitHub Copilot’s Agent mode by connecting toany MCP-compatible server. This means that:An MCP client, such as Visual Studio, can connect to MCP servers andrequest actions on behalf of the AI model.The MCP server provides tools exposing speci�ic functionality via awell-de�ined interface.The MCP protocol will de�ine the message format for handlingcommunication between the client (Visual Studio) and the servers,which includes tool discovery, invocation, and response handling.To understand how to use an MCP server, let’s con�igure the GitHubMCP server. The steps to be taken are as follows:1. Install Docker Desktop if your machine does not already haveDocker installed.  2. Verify the Visual Studio prerequisites.  3. Generate a Personal Access Token (PAT) on GitHub.  4. Create your .mcp.json �ile.  5. Authenticate and enable tools.  6. Validate the setup.  The prerequisites for Visual Studio are that you need to be runningVisual Studio 2022 version 17.14 or later and that you are signed in toVisual Studio with your GitHub account with Copilot access.Generating a personal access token on GitHub is alsostraightforward. Click the GitHub account icon in the top right andselect Settings. Scroll all the way to the bottom and select Developersettings. There you will be able to generate a personal access token. Isuggest generating a classic token with at least the repo scope.



You now need to create your .mcp.json �ile. Create it in
<SOLUTIONDIR>\.mcp.json using Visual Studio. Paste the contentsin Listing 1-7 into the .mcp.json �ile.
{
  "inputs": [
    {
      "id": "github_pat",
      "description": "GitHub personal access
token",
      "type": "promptString",
      "password": true
    }
  ],
  "servers": {
    "github": {
      "type": "stdio",
      "command": "docker",
      "args": [
        "run",
        "-i",
        "--rm",
        "-e",
        "GITHUB_PERSONAL_ACCESS_TOKEN",
        "ghcr.io/github/github-mcp-server"
      ],
      "env": {
        "GITHUB_PERSONAL_ACCESS_TOKEN":
"${input:github_pat}"
      }
    }
  }
}

Listing	1-7 GitHub MCP Server JSONVisual Studio also checks for MCP con�igurations set up by otherdevelopment environments. MCP server con�igurations are read from



the following directories in the following order:1.
%USERPROFILE%\.mcp.json – Sets a global MCP servercon�iguration for the current user. Adding a server here makes itload for every solution in Visual Studio.  

2.
<SOLUTIONDIR>\.vs\mcp.json – Con�igures MCP servers justfor Visual Studio, scoped to a speci�ic user and a speci�ic solution.  3.
<SOLUTIONDIR>\.mcp.json – Ideal if you want an MCP setupthat you can commit to source control along with your repository.  4.
<SOLUTIONDIR>\.vscode\mcp.json – Tied to the repositoryor solution, but usually not checked into source control.  5.
<SOLUTIONDIR>\.cursor\mcp.json - Also tied to therepository or solution, and typically not tracked in source control.  
Please note that some of these locations require .mcp.json whileothers require mcp.json.When you save this �ile, Visual Studio should prompt you for yourPAT as seen in Figure 1-93.

Figure	1-93 The Personal Access Token PromptYou might need to restart Visual Studio, but after adding yourpersonal access token, in the tools dropdown in Copilot you will see theGitHub MCP server tools listed (Figure 1-94).



Figure	1-94 The Available GitHub MCP ToolsOn GitHub, I went ahead and added an issue to my repository toremove the boilerplate code.



Figure	1-95 Running a Tool



To test if my MCP server tools work, in Visual Studio, with Agentselected, I type in “list issues assigned to me on GitHub”. The Agent thenstarts running the required tools and returns the results to me as seenin Figure 1-95. It also returned one of the repository’s pull requestsbecause I enabled every available tool by selecting the GitHub option,which activates all tools in the dropdown.Visual Studio allows the MCP server to use three transport options:local standard input/output (stdio), server-sent events (SSE), andstreamable HTTP (http). Right now, out of the three primitives—tools,prompts, and resources—servers can only deliver tools to Copilot’sagent mode. The of�icial MCP server repository(https://github.com/modelcontextprotocol/servers) isa good starting point if you want examples of reference, of�icial, andcommunity-contributed servers that demonstrate what MCP can do.You’ll �ind servers handling tasks like �ile system operations, databasework, and web services.MCP is still fairly new, and the ecosystem is growing quickly. Asadoption picks up, you’ll see more servers and tools becoming availableto integrate into your projects.With the version 17.14.13 August release of Visual Studio 2022,MCP support became GA in Visual Studio. Released after thepublication of this chapter, MCP support became a �irst-classexperience in Visual Studio 2022. No more copying JSON snippetsinto .mcp.json �iles. This is another example of the rapidly evolvinglandscape of AI tools and Visual Studio in general.
Using	 Images	 in	 GitHub	 CopilotYou can upload images to GitHub Copilot in Chat mode and Agent mode.This is more helpful than some folks might think. There are times whenyou need to “show” Copilot what you mean when describing a problem.Think of a UI component that is not being styled correctly in yourBlazor application. You can explain it and ask for a solution, but toexplain it and provide an image as context is so much more powerful.To illustrate the concept of providing an image to Copilot, I havecreated a service in a Blazor application that is used in the home page,but that is not registered in the DI container. When I run this

https://github.com/modelcontextprotocol/servers


application, I will see the familiar error displayed in my browser asseen in Figure 1-96.

Figure	1-96 The InvalidOperationExceptionFor a moment, ignore the fact that this error is very descriptive andtells you exactly what the problem is. You can take a screenshot of thiserror and save it to disk.You will be using this image to provide more context to Copilot chat.



Figure	1-97 Upload an ImageClick on the green + button and click on Upload Image to attach thescreenshot you just saved (Figure 1-97).

Figure	1-98 Describe the Error



When the image is attached (Figure 1-98), ask your question, but bevague. Do not give any speci�ics in your question.





Figure	1-99 Copilot Chat Providing a SolutionAs seen in Figure 1-99, Copilot Chat provides a complete solution toyour problem based solely on the uploaded image.



Figure	1-100 Copilot Agent Providing a Solution



To illustrate the difference and power of Copilot Agent, upload theimage again in Agent mode and ask the same question. This time,Copilot actually �ixes the error for you in your code. You will see the diffwindow open up showing you what changes were made. You can thenkeep or undo these changes.
Custom	 InstructionsCustom instructions is the best way to get Copilot up to speed on theway you code. Every dev team has some kind of knowledge base orcoding standard that they follow. Be this how to get started in the repoor the frameworks that the team is using, Copilot can’t easily infer thisinformation from the codebase itself.This is where custom instructions come in. Create a .githubfolder in your solution and add a �ile called copilot-
instructions.md to this folder as shown in Figure 1-101.



Figure	1-101 Adding the Copilot Instructions FileHere you can de�ine the speci�ic instructions you want Copilot tofollow. This �ile basically acts like a system prompt, allowing me to seedinformation to Copilot, giving it a better idea of what my team isworking on, naming conventions, and coding standards we follow, etc.Secondly, make sure that you enable the functionality in settings, asseen in Figure 1-102.



Figure	1-102 Custom Instructions SettingBased off of the information I specify in the Copilot-instructions �ile,Copilot can come up with better suggestions when responding to myrequests. This means that whenever Copilot suggests code, it is morelikely to be in line with the standards my team follows.For a nice example of a copilot-instructions.md �ile, have alook at
https://gist.github.com/jamesmontemagno/ee1edce39c
dedd185a789a0f69aa22b2 by James Montemagno. Just view theraw �ile and paste the markdown into your instructions �ile.

https://gist.github.com/jamesmontemagno/ee1edce39cdedd185a789a0f69aa22b2




Figure	1-103 Copilot Using Custom InstructionsAsking Copilot directly what my team’s coding standards arereturns the response as shown in Figure 1-103.





Figure	1-104 Asking Copilot to Generate CodeTo test if Copilot is following the instructions when generating code,ask it to create a property for you in one of your code �iles. Here, as seenin Figure 1-104, I asked it to create a property to set the current city.

Figure	1-105 Copilot Following InstructionsWhen I asked Copilot why it used PascalCase for the property, it toldme that it did so because this was de�ined in the coding standards inthe copilot-instructions.md �ile (Figure 1-105).The power of this �ile should not be underestimated. You cancommit this instruction �ile to your repo, allowing all team members to



bene�it from a single cohesive set of standards throughout your codebase.
Upgrade	 with	 CopilotThe process of upgrading old projects is probably one of the leastfavourite tasks a developer has to perform. It can be time consuming,risky, and full of manual toil. Well, Copilot is here to help. GitHubCopilot app modernization – upgrade for .NET is an AI-poweredexperience that helps you upgrade your .NET applications to the latestversion more conveniently than before.

Figure	1-106 GitHub Copilot App ModernizationTo get started, from the toolbar in Visual Studio select Extensions ➤Manage Extensions. Search for GitHub Copilot app modernization. Youwill see the extension listed in the search results, as seen in Figure 1-106.



Click on the Install button. You will now be prompted to close VisualStudio, after which the extension will be installed. Once the installationcompletes, start Visual Studio again and open your solution that youwant to upgrade.To unlock the full power of AI-assisted upgrades, make sure thatyou are running Visual Studio 17.14 and that you have enabled Agentmode from the GitHub Copilot settings.

Figure	1-107 Select the .NET Upgrade ToolAs seen in Figure 1-107, select Agent mode and check the .NETUpgrade tool from the tools dropdown.



Figure	1-108 Upgrade via Right-ClickTo start upgrading your solution, you can right-click your solutionand select Upgrade with GitHub Copilot, as seen in Figure 1-108.



Figure	1-109 Starting the Upgrade ProcessAlternatively, you can just tell Copilot what you want to do. As seenin Figure 1-109, I asked Copilot to upgrade my solution to .NET 8.Something slightly strange that responds with a choice of upgradeoptions after I speci�ied .NET 8, but hey, this tool is saving me time, soI’m not complaining.



Figure	1-110 Performing Additional ActionsCopilot Agent will now start iterating through a series of steps andask you for con�irmation along the way. Here, as seen in Figure 1-110,Copilot has noticed that I have some pending changes to my solution. Itnow asks me what I want to do. Commit the changes, stash them, orundo the changes. Conveniently, I can click on the option and send thatas a response to Copilot.



Figure	1-111 Generating an Upgrade PlanCopilot then might go through an additional series of steps, askingyou for con�irmation along the way where necessary. It then generates



an upgrade plan for you that you can review and ultimately approve.Copilot will then start to perform the upgrade, and depending onyour application size and complexity, this could take some time. Rightthroughout the process, Copilot will keep you informed of the status ofthe upgrade tasks. Once it has completed the upgrade you will see thecon�irmation that your project has been upgraded (Figure 1-111).Give this tool a try. With the power of AI, mundane tasks arestreamlined and completed with minimal developer interaction (apartfrom answering a few Agent questions).
SummaryIn this chapter, we explored what Visual Studio 2022 brings to the tablefor modern development. We covered how to install Visual Studio andchoose the right workloads for your projects. You learned how tonavigate the IDE ef�iciently, from using Solution Explorer and theToolbox to managing references and viewing build artifacts. I showedyou how to use core navigation features, keyboard shortcuts, and thepowerful search to stay productive. We also touched on features likecode cleanup, IntelliCode, Live Share, and GitHub Copilot to help youwrite better code faster and collaborate seamlessly. This foundationsets you up to take full advantage of what Visual Studio 2022 offers aswe dive deeper into the chapters ahead.
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2.	 Working	 with	 Visual	 Studio	 2022Dirk Strauss1  Uitenhage, South Africa 
If you have worked with previous versions of Visual Studio, you may �ind that Visual Studio 2022does not break the mold. Visual Studio 2022 feels much the same as previous versions, andthat’s a good thing.While there are new features and enhancements in Visual Studio 2022, developers �ind iteasy to work with it from the start. If you are new to Visual Studio, a few topics deserve a closerlook. In this chapter, we are going to look at the following:Visual Studio project types and when to use them.NET AspireManaging NuGet packagesCreating project templatesCreating and using code snippetsUsing bookmarks and code shortcutsThe Server Explorer windowVisual Studio WindowsThis chapter is an extension of Chapter 1 in many respects. Things that didn’t make it intoChapter 1 are discussed in this chapter. I do believe, however, that these are essential to workingwith Visual Studio and bene�it developers in their day-to-day coding.
Visual	 Studio	 Project	 TypesVisual Studio 2022 allows developers to create a new project in several ways. The most obviousis when you start Visual Studio 2022. You are presented with the Start screen displayed in Figure2-1.
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Figure	2-1 Visual Studio 2022 Start ScreenHere, you can see recent projects that you can pin to the Start screen and always keepavailable. If you right-click any recent projects, you can see a context menu pop up, as shown inFigure 2-2.



Figure	2-2 Context Menu Options on Recent ProjectsYou can remove the project from the list, pin or unpin it, or copy the path to the project.Visual Studio 2022 has also made it relatively easy to get where you need to go when working onprojects. As seen in Figure 2-3, developers have a few options available when they are ready tostart working with code.

Figure	2-3 Get Started SectionYou can start by grabbing code from GitHub or Azure DevOps, opening a local Visual Studioproject, opening a local folder to edit code �iles, creating a new project, or continuing withoutcode.If Visual Studio is already open, you can create a new project from the menu bar by clickingthe New Project button, shown in Figure 2-4. You can also hold down Ctrl+Shift+N.

Figure	2-4 New Project Toolbar ButtonThe Create a new project screen is displayed (Figure 2-5), and you have a whole newexperience here, too, when it comes to �inding the project type you want to create.



Figure	2-5 Create a New ProjectYou can see recent project templates displayed, which is excellent, should you need to get upand running with similar projects as what you have created before. You can also search for and�ilter project templates by language, platform, or project type, shown in Figure 2-6.



Figure	2-6 Filter Project TemplatesYou are, therefore, able to quickly �ind the most suitable project template.Take note, though, that you may need to install a workload if you do not �ind the projecttemplate you want. To do this, click Install more tools and features. Refer to Chapter 1 to seehow to use workloads in Visual Studio.Of the several project templates available, let’s see which ones there are and what project issuitable for speci�ic situations.
Various	 Project	 TemplatesYou can choose from a host of project templates in Visual Studio 2022. I would even go as far asto say that it’s now even easier to �ind the template you need to use due to the �ilters in theCreate a new project window. Let’s have a look at a few of these project templates next.
Console	ApplicationsI remember the �irst time I wrote a single line of code. I used a Console Application, a greattemplate to use when you don’t need a UI for your application. The Console Application projecttemplate running on the .NET Framework is displayed in Figure 2-7.



Figure	2-7 Console App (.NET Framework)You will notice that this application is suited for running on Windows machines. But what ifyou need to run the Console Application across platforms such as Windows, Linux, and macOS?Here is where the second Console App template can be used as displayed in Figure 2-8.

Figure	2-8 The Console App Template for Linux, macOS, and WindowsA good modern example of when a Console Application shines is for building lightweightautomation tools. Think of a cross-platform deployment script that backs up con�iguration �iles,applies database migrations, and restarts services. Because a Console Application has no UIoverhead and runs identically on Windows, Linux, or macOS, it’s a perfect �it for scripting tasksand DevOps work�lows where reliability and portability matter more than user interaction.
Windows	Forms	ApplicationIn contrast to the Console Application, the Windows Forms application template is used whenyou need to create an app that has a UI and runs on Windows. The project template (like theConsole Application) can run on the .NET Framework or the latest version of .NET as shown inFigure 2-9.

Figure	2-9 Windows Forms App (.NET and .NET Framework)It is important to note that before .NET, there were two separate products: the .NETFramework and .NET Core. If you’re part of the Old Guard, you will have worked extensively withthe .NET Framework. With .NET Core, however, a process was set in motion that would change



the face of .NET development forever. Being open source, .NET Core was written from scratchand is designed to work across all platforms, such as Windows, Linux, and Mac.With .NET 6.0 going forward, developers had just a single version of .NET (and it’s just called.NET). Think of .NET 6 as the beginning of a uni�ied development platform that allowsdevelopers to create desktop, cloud, web, mobile, gaming, IoT, and AI applications. As of thiswriting, Visual Studio 2022 allows you to choose .NET 6 and .NET 7, which are out of support,.NET 8, which has Long Term Support, and .NET 9, which has Standard Term Support. August2025 will see the release of .NET 10.
ServicesIf you ever need to create an application that continually runs in the background, performingsome speci�ic task, your best choice would be to use a Windows Service or a Worker Servicetemplate as seen in Figure 2-10.

Figure	2-10 Windows Service (.NET Framework) and Worker Service
Windows	Service	(.NET	Framework)A Windows Service running on the .NET Framework is an older project type that allowsdevelopers to build long-running background processes that run speci�ically on Windows.You will choose this project when you’re maintaining or extending legacy .NET Frameworksystems seeing as this will only run on Windows. In other words, a Windows Service is your go-to for older, Windows-bound projects.
Worker	ServiceThis is a modern, cross-platform template for building background services using .NET. It uses ageneric host that is designed to run a Windows Service (when deployed with properregistration), as a Linux daemon, a Console app for local dev testing, or in a container such asDocker.You will choose this template when you are building new services that might run onWindows, Linux, in containers, or in the cloud. You might also choose this template if you wantto use dependency injection, con�iguration, logging, and lifecycle management. Finally, if thesolution you want to provide needs to run cross-platform (Windows, Linux, macOS, containers,and cloud hosts), you will not go wrong with choosing the Worker Service template.



Figure	2-11 Creating a Worker ServiceIn short, a Worker Service is the modern, portable approach for any new background workload.
Web	ApplicationsIf you need to create web-based applications, you will see that you have various options tochoose from (Figure 2-12). I will not cover .NET Aspire in this section. I will cover it in its ownsection as I feel that it warrants a focused discussion given its speci�ic design goals. Looking atthe choices, however, you might be wondering when to choose which project template.



Figure	2-12 The Various Web Application TemplatesLet’s break this down a bit more and see when each project type might make more senseover the other.
Blazor	Web	AppIf you want to build interactive, client-side web applications using C# instead of JavaScript, theBlazor project is your template of choice. Blazor can run on the server (Blazor Server) or entirelyin the browser via WebAssembly (Blazor WebAssembly). You will want to choose Blazor if youwant to share logic and models between your front-end and back-end, and you prefer workingfully in .NET rather than mixing in a JS framework like React or Angular.
ASP.NET	Core	Web	App	(Razor	Pages)This is ideal for traditional, page-focused websites where each page handles its own logic. Razorpages keep page markup and associated C# logic tightly coupled and simple to maintain.
ASP.NET	Core	Web	API



If your primary goal is to expose RESTful endpoints for use by client applications, mobile apps,third-party consumers, or other services, then this is your template of choice. The Web APItemplate is lean and purpose-built for creating HTTP APIs with JSON or other negotiation,without any front-end UI included.
ASP.NET	Core	Web	App	(Model-View-Controller)If you want to use a Model-View-Controller approach to create your web application, you canselect the ASP.NET Core Web App (Model-View-Controller) template, as shown in Figure 2-13.

Figure	2-13 ASP.NET Core MVC Web App TemplateAs seen in the template description, this template allows you to create a web applicationusing Views and Controllers.
Class	LibraryThe following project template we will look at is the Class Library. From Figure 2-14, you cansee, the Class Library can be based on .NET, .NET Framework, or .NET Standard.



Figure	2-14 Class Library ProjectsLet’s discuss the differences between the various class library projects.
Class	Library	(.NET	or	.NET	Standard)This is the go-to project type for general-purpose, reusable code that you want to share acrossdifferent .NET workloads (e.g., ASP.NET Core, Blazor, Console Apps). To ensure the broadestcompatibility with older projects, .NET Standard is a solid choice. For newer applications,however, the recommended choice here is .NET and is ideal for applications built on .NET 5 andbeyond. This project type is generally used for code logic, utility functions, data access layers, orany shared code that is UI-agnostic.
Razor	Class	LibraryIf you need to bundle reusable Razor components, partial views, or pages that can be embeddedin multiple web projects, you should pick this template. In fact, if you plan to distribute a UIcomponent library, this is your template of choice. For more info on RCL browse to
https://learn.microsoft.com/en-us/aspnet/core/razor-pages/ui-class.
WPF	Class	LibraryIf you need to write code speci�ically for a WPF (Windows Presentation Foundation) application,this template ensures that your library references the correct WPF assemblies. Choose this when

https://learn.microsoft.com/en-us/aspnet/core/razor-pages/ui-class


writing custom controls, converters, or behaviors in a WPF-only solution.
Class	Library	(.NET	Framework)This template exists for backwards compatibility, and you should only use it when you need tocreate a library that must run speci�ically on the .NET Framework such as 4.8 or older. Your usecase here will be to support legacy WinForms, WPF, or ASP.NET apps that have not beenmigrated to .NET Core or .NET 5 or newer.
Windows	Forms	Class	LibraryThe detail is in the name. This is scoped for Windows Forms apps, and it sets up the right projectreferences and ensures seamless integration with WinForm-speci�ic types. If you need to createcustom WinForm controls or UI helpers for reuse across multiple WinForm apps, this is yoursafest pick.
.NET	AspireThe last project template we will look at is probably the most exciting, and we will see how tocreate a .NET Aspire application in the next section. The idea behind Aspire is to provide tools,templates, and packages to assist developers in building observable, production-ready apps. Thepromise of .NET Aspire is to simplify common challenges in modern application development,especially when these applications rely on multiple services such as databases, messaging,caching, etc.To create a .NET Aspire application, search for and select the .NET Aspire Starter App as seenin Figure 2-15.

Figure	2-15 The .NET Aspire TemplateIn the next section, I will go through creating a .NET Aspire project, viewing the .NET Aspiredashboard, adding .NET Aspire to existing applications, adding .NET Aspire Packages, andadding SQL Server to your .NET Aspire project.
Creating	 a	 .NET	 Aspire	 ProjectCreating a new project is the �irst step in experiencing the capabilities of .NET Aspire. In thissection, we will discuss the prerequisites, using Visual Studio or CLI templates, and take a look atthe structure of the created .NET Aspire solution. By the end of the Aspire section of this chapter,you will have a running Aspire app with front-end, back-end, and integrated services.
Prerequisites	 and	 InstallationBefore you can create a .NET Aspire project, you need to ensure that your developmentenvironment is set up with the required tools. These are:.NET SDK – Ensure that you have .NET 8.0 or .NET 9.0 installed.



Container Runtime – Install an OCI-compliant container runtime such as Docker or Podman.IDE or Editor – You can use Visual Studio 2022 (v17.9+) or Visual Studio Code (with the C#Dev Kit extension installed) or JetBrains Rider (with the Aspire Plugin). Note that VisualStudio 2022 version 17.10 and up already includes the .NET Aspire SDK component as part ofthe ASP.NET and web development workload..NET Aspire Workload – If you prefer to use the CLI, you can install the Aspire workload byrunning dotnet workload update and then dotnet workload install aspire.
Using	 Visual	 Studio	 2022After ensuring that your development environment is set up with the required tools, you canfollow the following steps to create a new Aspire app using the New Project template. From theVisual Studio 2022 launch screen, create a new project. If Visual Studio is already open, go to File
➤ New ➤ Project. Search for Aspire and select the .NET Aspire Starter App template and clickNext. On the next screen, give your project a name (I called mine HelloAspire) and select alocation for your project, and click Next.From the Additional Information screen, as seen in Figure 2-16, choose the target framework.NET 9.0 (STS). You will also see options to include certain integrations:Use Redis for caching – Check this option to include a Redis cache integration. This willrequire a supported container runtime such as Docker or Podman.Create a test project – You can optionally include a test project.

Figure	2-16 The Additional Information Screen



A word on supported containers; as of this writing, .NET Aspire can run containers usingseveral OCI-compatible runtimes. This includes Docker Desktop and Podman. There have beenreports of developers successfully using Rancher Desktop, especially when con�igured to use theDocker CLI, but this is not an of�icially supported scenario.When you have con�igured the Additional Information, click Create to �inish. Visual Studiowill create a new solution pre-con�igured for .NET Aspire, complete with the required projectsand NuGet packages.Once completed, the solution typically contains a few projects as seen in Figure 2-17.

Figure	2-17 The Aspire SolutionThe Aspire solution we created includes:



HelloAspire.AppHost – This is the orchestration project that will start and wire up all thecomponents.HelloAspire.ServiceDefaults – This is a shared project for common con�iguration such asresilience, telemetry, etc. across services.HelloAspire.Web and HelloAspire.ApiService – These are simply just a Blazor project andminimal API project.The projects in this solution are structured using Aspire conventions. We’ll explore theirunique roles shortly, but it is interesting to note that Visual Studio automatically sets theAppHost as the startup project. This means that the solution will launch the orchestrator bydefault.
The	 Solution	 StructureWhen you create an Aspire solution using the .NET Aspire Starter App template, you will noticethat the solution is organized into multiple projects, each with speci�ic roles. Understandingthese roles will help you navigate the code.
AppHost	ProjectThis is the heart of Aspire’s orchestration. It contains a Program.cs �ile that makes use of the
DistributedApplication builder APIs to de�ine the “app model” (in other words, whichprojects and resources your application uses), and then runs them.
var builder = DistributedApplication.CreateBuilder(args);

var cache = builder.AddRedis("cache");
var apiService = builder.AddProject<Projects.HelloAspire_ApiService>
("apiservice")
    .WithReference(cache).WaitFor(cache);

builder.AddProject<Projects.HelloAspire_Web>("webfrontend")
    .WithExternalHttpEndpoints()
    .WithReference(cache).WaitFor(cache)
    .WithReference(apiService).WaitFor(apiService);

builder.Build().Run();
Listing	2-1 The Program.cs FileThe code, as seen in Listing 2-1, is doing a few important things. These are:
DistributedApplication - which is an implementation of the
Microsoft.Extensions.Hosting.IHost interface that orchestrates a .NET Aspireapplication.
AddRedis("cache") – this includes a Redis cache with the name "cache" that will spinup a Redis container when your app runs.
AddProject<…>("apiservice") – This adds the existing API project into the Aspire appmodel and names it "apiservice".
AddProject<…>("webfrontend") – This adds the Blazor project named
"webfrontend" and chains .WithReference(cache) and
.WithReference(apiService) along with .WaitFor on each one. The
.WithReference method is used to link a resource or service to the project, ensuring that



necessary information (like connection strings or service discovery URLs) are injected forthose projects. The .WaitFor method ensures that those referenced resources (the APIservice and Redis cache) are up and running before the Web UI starts.
Builder.Build().Run() – The �inal step in the process, starts the orchestrator andlaunches the projects and containers.The AppHost project essentially de�ines how all the parts of our distributed app cometogether in development. In our project, for Listing 2-1, it orchestrates a Redis container, an APIservice, and a Web application, handling their con�igurations and startup order automatically.

ServiceDefaults	ProjectThis shared class library contains common con�iguration for resilience and observability.Looking at the project �ile (right-click the project and click on Edit Project File from the contextmenu), you will notice that it is marked with
<IsAspireSharedProject>true</IsAspireSharedProject>. This class typicallycontains packages for OpenTelemetry, logging, Service Discovery, and Resilience libraries.The running AppHost ensures that each app project references the ServiceDefaults and indoing so, ensuring consistent settings across all. An example of this would be enablingstructured logging, distributed tracing, and health checks by default.As seen in Listing 2-2, the ServiceDefaults adds an extension method called
AddServiceDefaults() to apply all the defaults it de�ines to an app builder.
public static TBuilder AddServiceDefaults<TBuilder>(this TBuilder
builder) where TBuilder : IHostApplicationBuilder
{
    builder.ConfigureOpenTelemetry();
    builder.AddDefaultHealthChecks();
    builder.Services.AddServiceDiscovery();

    builder.Services.ConfigureHttpClientDefaults(http =>
    {
        // Turn on resilience by default
        http.AddStandardResilienceHandler();

        // Turn on service discovery by default
        http.AddServiceDiscovery();
    });

    // Uncomment the following to restrict the allowed schemes for
service discovery.
    // builder.Services.Configure<ServiceDiscoveryOptions>(options
=>
    // {
    //     options.AllowedSchemes = ["https"];
    // });

    return builder;
}

Listing	2-2 The AddServiceDefaults Extension Method



This means that in practice, each app (the API and Web app in our solution) will call
builder.AddServiceDefaults() in its Program �ile before adding its own services. Youcan see this in Figure 2-18, where clicking on the references will show you the applicationsreferencing the AddServiceDefaults() extension method.

Figure	2-18 The AddServiceDefaults ReferencesThis means that cross-cutting concerns are uniformly set up throughout your applications.
Application	ProjectsThese projects are the Blazor application (HelloAspire.Web) and the minimal API project(HelloAspire.ApiService), as previously seen in Figure 2-17.
HelloAspire.WebThe web frontend is a Blazor server project. This is the UI of your solution. It uses an
HttpClient to communicate with the API project (HelloAspire.ApiService). Looking at the
Program.cs �ile, you will notice that it calls the builder.AddServiceDefaults() andthen the Redis integration for Output caching with
builder.AddRedisOutputCache("cache") since we included Redis when we createdour Aspire project.The Program.cs also con�igures HttpClient.BaseAddress to enable communicationwith the API via service discovery. Interestingly, note the URL used here, which is
https+http://apiservice. This is a special scheme supported by .NET Aspire’s servicediscovery. It means:Prefer HTTPS – The client will try to connect to https://apiservice �irst.Fallback to HTTP – If HTTPS is not available, it will try http://apiservice.This approach is useful in Aspire environments where services may be available over bothHTTP and HTTPS, and you need to ensure that secure connections are preferred but will allowfallback for development or local scenarios.
HelloAspire.ApiServiceThis is a minimal API project that provides data access (in our solution, the boilerplate weatherforecast service). It too calls the builder.AddServiceDefaults() as well as the Rediscache. Because the AppHost linked the Redis resource to this API project, the API can �ind thecorrect connection string automatically by referencing the name "cache".Both API and Web projects will be launched by the AppHost instead of running on their own.Both projects are enriched with environment variables or con�igurations by Aspire. The webproject, for example, doesn’t need the hardcoded API URL. It simply needs to call
http://apiservice, and Aspire’s service discovery takes care of the rest.



Application	Projects	in	SummaryThe .NET Aspire Starter application creates a multi-project solution where the AppHostorchestrates a couple of services and a cache (in our example). Doing this sets the stage for therapid development of complex, distributed applications on your local machine without manuallycon�iguring each one. As the .NET team describes, Aspire “simpli�ies common challenges inmodern app development” by handling service wiring, connection strings, and reducing dev-time toil by setting up infrastructure for you.
Running	and	Testing	the	Aspire	ProjectAfter you have created your project, run it locally to see if everything works. In Visual Studio,ensure that your <YourApp>.AppHost project (HelloAspire.AppHost in our example) isset as the startup project (which by default, it should be). Then press F5 to run with thedebugger (or Ctrl+F5 without the debugger). Visual Studio will build all projects and start theAppHost. This will spin up any container resources (Note that Docker must be running).

Figure	2-19 The Aspire DashboardIn our example, we included Redis in our project, so you’ll see Docker pull and start a Rediscontainer. Once this is done, the dashboard will automatically open in your browser shown inFigure 2-19. The dashboard provides a UI to allow you to monitor your application. In thedashboard’s Resources list (seen in Figure 2-19) you will see entries for “apiservice” and“webfrontend” which are the two Application projects. You will also see “cache” which is theRedis container. Each resource shows its state (Running) and its available URLs.In the Aspire dashboard, click on the URL for the webfrontend project. This will open thefront-end app in a new tab in your browser (Figure 2-20).You can navigate around the default web application to get a feel for how it works. The pointhere is that it works like this out of the box. Clicking on the Weather tab will call the API wired



up to the Blazor app by Aspire. Again, this just works without you having to wire anything upmanually.

Figure	2-20 The Running Blazor ApplicationYou can also click on your API URL and add /weatherforecast to the end of the URL tosee the returned JSON from the API service, as seen in Listing 2-3.
[
    {
        "date": "2025-06-22",
        "temperatureC": 5,
        "summary": "Warm",
        "temperatureF": 40
    },
    {
        "date": "2025-06-23",
        "temperatureC": -6,
        "summary": "Balmy",
        "temperatureF": 22
    },
    {
        "date": "2025-06-26",
        "temperatureC": -14,
        "summary": "Chilly",
        "temperatureF": 7
    }



]
Listing	2-3 Example of Returned Weatherforecast JSONIn your browser, the JSON will simply be output as shown in Figure 2-21.

Figure	2-21 The Weatherforecast APIWhat this shows us is that your API and Web Application are functioning correctly. You havesuccessfully created and run your �irst .NET Aspire solution. You now have a feel for how Aspireautomates local orchestration of multiple services.Next, let’s have a look at the Aspire dashboard in a bit more detail.
Viewing	 the	 .NET	 Aspire	 DashboardOne of the standout features of .NET Aspire is its dashboard. If you refer back to Figure 2-19, youwill see the running Aspire dashboard. This dashboard provides a real-time monitoring UI foryour application. It provides deep insights into all the running projects and resources. In fact, ifyou look at the toolbar as seen in Figure 2-22 you will notice that it has Copilot baked in.



Figure	2-22 Copilot in the Aspire DashboardThe dashboard gives you all the tools you need to view settings, logs, traces, metrics, start orstop services, and use Copilot to help you diagnose issues.
Dashboard	 OverviewThe Aspire dashboard is essentially just a web application that the AppHost launches on startup.It runs locally and requires an authentication token for security. Starting the AppHost fromVisual Studio allows the tooling to automatically pass the auth token to the dashboard page andlog you in. This means that the dashboard will just appear without any login prompts for thetypical F5 developer scenario.If, however, you open a terminal and navigate to the AppHost directory and type in the
dotnet run command, you will see the application launch and an authentication link with atoken in the console (Figure 2-23). Incidentally, you see the same in the console that launcheswhen you debug via Visual Studio F5. In Figure 2-23 below, you will notice that my login page isat https://localhost:17070/login.

Figure	2-23 The Console WindowCopy the login URL without the token query parameter and paste it into a new browserwindow (Figure 2-24).



Figure	2-24 The Aspire Login PageThe Aspire login page will be displayed. Copy the token from the login URL and paste it intothe login page. This will allow you to log in to the Aspire dashboard. Once the token is used to login to the dashboard, a persistent login cookie is set. This means that you won’t need to re-enterthe token for a few days. This is an important security measure because the dashboard displayssensitive information such as connection strings and secrets in environment variables. Onlyauthorized local users (you the developer) are allowed to see it.So to sum things up, to access the dashboard, you simply have to run your .NET Aspire app.The dashboard opens automatically. If it does not open up automatically (if, for example, you’reusing dotnet run), look for the login URL in the console and login to Aspire like that. Oncelogged in, you will see an interface with a left navigation menu to Resources, Console, Structured(which are logs), Traces, and Metrics. Let’s have a look at each in turn.
Resources	 PageThis page gives you a bird’s eye view of all the components that make up your .NET Aspireapplication (Figure 2-19). Each resource, be that a project or a container, is listed in a table. Thistable shows:Name – The name identi�ier of the resource as de�ined in your code. In our example,
"apiservice", for example, corresponds to what you passed to AddProject in theAppHost.State – This indicates if the resource is running, stopped, or in an error state. If there are anyerrors, you will see a red icon with the error count. You can click on that to be taken directly tothe error logs for that resource.Start time – This is the date and time when the resource started.Source – This is the path or origin of the resource on disk. For projects, you will see the path tothe folder, and for containers, you will see the image info.



URLs – If your project is running, this will list the URL where that project is listening. You cansee multiple URLs here if the project has multiple endpoints. Clicking on the endpoint willopen the service in the browser.Actions – Here you will see buttons to stop or start a resource. You can also access the ConsoleLogs from here as well as click on the ellipses (...) that display the full Actions menu,allowing you to View Details, Console logs, Ask GitHub Copilot, access Traces, Stop and Restartthe service.The Stop button will obviously only show if the resource is in a running state. You can seethis menu in Figure 2-25.

Figure	2-25 The Actions MenuReferring back to Figure 2-19, you will see that we have two project resources and acontainer resource, all of which are running. If you wanted to simulate a failure, you could stopthe Redis container and your web application/API will start logging the errors until you restartthe container again.
Graph	ViewEasily overlooked, the Graph view is accessed by clicking on the Graph menu located next to theTable menu (or tab), as seen in Figure 2-26.



Figure	2-26 The Graph MenuThe graph gives you a view of your application’s architecture. As seen in Figure 2-27, ingraph mode, you will see boxes or nodes for each project and resource.The lines between the boxes and nodes indicate their dependencies. In our example, thearrows from the webfrontend resource to the apiservice and cache show that it isdependent on them.This visualization helps us understand how the pieces connect. You can also click on a nodein the graph to highlight it and see additional details.You can also zoom or pan around the graph as required. The graph in our example might notlook all too impressive, but it becomes especially useful when your application grows andbecomes more complex. Seeing all the resources and services in one diagram comes to you forfree, out of the box, with .NET Aspire.



Figure	2-27 The Graph ViewBut .NET Aspire doesn’t stop there. You have rich telemetry and logs at your disposal. Let’slook at these next.
Viewing	 Logs	 and	 TelemetryOne major advantage of the Aspire dashboard is the consolidated observability. From one singledashboard, you have access to a rich set of data about the resources in your solution. The rest ofthe menus in the left navigation allow us to view logs and telemetry.
Console	PageThis page shows the console output for the projects in your solution. It’s like having access to allyour terminal outputs in a single view. The resource can be selected from the Resource drop-down as seen in Figure 2-28.



Figure	2-28 The Console Logs Resource SelectorThis allows you to laser focus on a speci�ic application’s logs, helping you see what’s going onwith your running applications.

Figure	2-29 Structured Logs
Structured	Logs	Page	(Structured)Aspire collects structured logs from your applications via the built-in logging andOpenTelemetry integration, which is then presented in a table format shown in Figure 2-29.This page allows you to �ilter by log level and resource. You can also search for text in the logmessages. You can also view more details under the Actions Menu.If a resource has errors, clicking on the error icon will bring you to this view and �ilter to thatresource and error level.
TracesDistributed tracing visualization is probably one of the most powerful features. Aspireautomatically instruments common operations such as HTTP requests, database calls, etc., withOpenTelemetry tracing.



The Traces page allows developers to see end-to-end traces of requests across services. Forexample, if the web application makes an HTTP call to the API, and the API hits the Redis cache.You could see a trace that spans webfrontend – apiservice - cache as seen in Figure2-30.Clicking on a trace displays a timeline view of the operations and how long each one took.Clicking on the /weatherforecast request, for example, will display the time it took for theWeb UI to handle the request, which in turn included a call to the API that took X milliseconds,that included a Redis cache check of Y milliseconds.This allows developers to pinpoint performance issues or errors across distributedcomponents.

Figure	2-30 The Traces PageThe dashboard’s Trace page essentially replaces the need for external tools such as Jaeger orZipkin in the dev environment, giving you immediate insights into the �low of requests.
MetricsThe Metrics page displays live metrics captured from your application (Figure 2-31). Aspireintegrations automatically collect many metrics such as CPU, memory, HTTP requests, databaseconnections, etc., via OpenTelemetry meters.The Metrics page lists all available metric instruments (counters, gauges) and their values ordimensions.You might see metrics like requests per second or active server requests or TLS handshakes,or even custom app metrics if you have de�ined any.These metrics are not as fully featured as, say, Azure Monitor or Prometheus & Grafana, but itdoes give you a quick glance at important stats while you are developing your application.



Figure	2-31 The Metrics PageAgain, you need to keep in mind that all this comes to you for free, out of the box, without youhaving to do anything extra. Metrics such as these can often help you catch issues such asmemory leaks or too many retries, early, simply by watching the output on this page.
CopilotA notable addition to the Aspire dashboard is the integration of GitHub Copilot chat on the side.Refer back to Chapter 1 on Getting Started for free with GitHub Copilot, and how to use itsfeatures in your daily development.As seen in Figure 2-32, GitHub Copilot can assist you by answering questions about your logsor telemetry.



Figure	2-32 GitHub Copilot IntegrationYou can see from Figure 2-32 that I am using Copilot on the Console logs page. The promptsuggestions will also change as the selected page changes. Here, Copilot is suggesting to analyzethe apiservice resource. Changing to a different page, Structured for example, will providedifferent prompt suggestions. Copilot, therefore, has context of which page you are viewing onthe Aspire dashboard, making it a solid debugging tool for �inding issues.
Standalone	 Dashboard	 ModeWe have seen how the .NET Aspire dashboard is tied to a running AppHost, but you can also runthe Aspire dashboard in standalone mode. This means that you can monitor any application thatemits OpenTelemetry data without the rest of .NET Aspire.Microsoft provides a Docker image mcr.microsoft.com/dotnet/aspire-
dashboard:9.0 that you can run independently. This is essentially exactly the same UI, butyou need to feed it telemetry from any source.To launch the dashboard container on its own, run the command as seen in Listing 2-4.
docker run --rm -it -d \
    -p 18888:18888 \
    -p 4317:18889 \
    --name aspire-dashboard \
    mcr.microsoft.com/dotnet/aspire-dashboard:latest

Listing	2-4 The Docker CommandThis Docker command does the following:



Starts a container from the mcr.microsoft.com/dotnet/aspire-dashboard:9.0image.Exposes two ports byMapping the dashboard’s OTLP port 18889 to the host’s port 4317 that receivesOpenTelemetry data from apps.Mapping the dashboard’s port 18888 to the host’s port 18888. Port 18888 has thedashboard UI, and if you navigate to http://localhost:18888 in the browser, you willsee the dashboard.You can now point any OpenTelemetry-enabled app to send data to localhost:4317 andbe able to view it on the dashboard. This is a fantastic way to use Aspire’s dashboard forscenarios that fall outside a full .NET Aspire project.
Adding	 .NET	 Aspire	 to	 an	 Existing	 ApplicationIf you have existing applications that could bene�it from .NET Aspire, adding this to your existingapps is not only possible, but quite easy. Before you continue, ensure that you have the followinginstalled locally:.NET 8.0 or .NET 9.0An OCI-compliant container runtime such as Docker or PodmanVisual Studio 2022 version 17.9 or higherIf you want an example project to follow along with, you can clone the eShopLite project byMicrosoft.To clone the project, use the following git clone command:
git clone https://github.com/MicrosoftDocs/mslearn-dotnet-
cloudnative-devops.git eShopLiteThis will clone a .NET 9 example application to your machine and place it in a new localfolder called eShopLite.



Figure	2-33 The eShopLite SolutionYou can see the solution in Figure 2-33. The solution contains three projects:DataEntities – This is a class library project that de�ines the Product class used in the Blazorapplication and the API.Products – This is a simple API project that returns a list of products in the database.Store – This is the Blazor application that pulls the product information from the API anddisplays it to the user.Next we need to con�igure the startup projects. To do this, right-click the eShopLite solutionin the Solution Explorer and select the context menu option to Con�igure Startup Projects.



Figure	2-34 Con�igure Multiple Startup ProjectsAs seen in Figure 2-34, select Multiple Startup Projects.In the Action column, set Start for both the Products and Store projects, then click on OK tosave.Now you can press F5 or select Start to start debugging your application. You will see twopages open in the browser. One browser page displays the Product output from the API in JSON.The other browser page displays the Blazor application’s home page. To see the products, clickon the Products menu shown in Figure 2-35.



Figure	2-35 The Products PageYou now have a running application to test with. So let’s enrol the Store project in .NETAspire orchestration. To do this, right-click the Store project and select Add ➤.NET AspireOrchestrator Support from the menu options.The Add .NET Aspire Orchestrator Support dialog will open as seen in Figure 2-36.

Figure	2-36 Add .NET Aspire Orchestrator SupportHere you can select a pre�ix for the project name and the location. You can leave these set todefault.



It also informs you that two projects will be created. These are the AppHost and theServiceDefaults projects (Figure 2-37).

Figure	2-37 The Added Aspire ProjectsClicking OK then creates these projects in your solution. Next we also want to add theProducts project to .NET Aspire. Follow the same steps as previously followed, the onlydifference will be that this time you will right-click on the Products project and select Add
➤.NET Aspire Orchestrator Support.

Figure	2-38 Adding .NET Aspire to ProductsAs seen in Figure 2-38, we receive a message that we have already added a .NET AspireOrchestrator project to the solution, and that it will only be updated to include Products to theorchestration. Looking at the eShopLite.AppHost project’s Program.cs �ile, you will see theregistrations of Store and Products (Listing 2-5).
var builder = DistributedApplication.CreateBuilder(args);



builder.AddProject<Projects.Store>("store");

builder.AddProject<Projects.Products>("products");

builder.Build().Run();
Listing	2-5 The AppHost Program.cs FileWe now have a little bit of code work to complete the addition of Aspire Orchestration to oursolution. Both our projects are now part of .NET Aspire Orchestration, but we need to enableservice discovery to allow the Store project to rely on the Products backend address.To do this, modify the AppHost’s Program.cs �ile as seen in Listing 2-6.

var builder = DistributedApplication.CreateBuilder(args);

var prodstore = builder.AddProject<Projects.Products>("products");

builder.AddProject<Projects.Store>("store")
    .WithExternalHttpEndpoints()
    .WithReference(prodstore)
    .WaitFor(prodstore);

builder.Build().Run();
Listing	2-6 The Modi�ied AppHost Program.cs FileHere we are telling .NET Aspire that the Store project relies on the Products project. You willalso notice that the Store project is con�igured to use external HTTP endpoints.This is necessary because in a distributed or cloud-native application such as those built on.NET Aspire and Blazor, resources such as services or APIs often de�ine endpoints which bydefault, may only be accessible internally (e.g., within a container).The WithExternalHttpEndpoints() extension method marks all HTTP and HTTPSendpoints on a resource as external. Setting them as external signals to the orchestrator thatthese endpoints should be exposed outside the internal network, making them accessible fromyour host machine, other services, or the public Internet.You can see the WithExternalHttpEndpoints() extension method code in Listing 2-7.Lastly, we call the WaitFor API that ensures that the store app doesn’t start until theproducts API is fully started and ready to serve requests.

public static IResourceBuilder<T> WithExternalHttpEndpoints<T>(this
IResourceBuilder<T> builder) where T : IResourceWithEndpoints
{
    if
(!builder.Resource.TryGetAnnotationsOfType<EndpointAnnotation>(out
var endpoints))
    {
        return builder;
    }

    foreach (var endpoint in endpoints)
    {
        if (endpoint.UriScheme == "http" || endpoint.UriScheme ==
"https")



        {
            endpoint.IsExternal = true;
        }
    }

    return builder;
}

Listing	2-7 WithExternalHttpEndpoints Extension MethodWe also need to change the appsettings.json �ile in the Store project (Listing 2-8).
{
  "DetailedErrors": true,
  "Logging": {
    "LogLevel": {
      "Default": "Information",
      "Microsoft.AspNetCore": "Warning"
    }
  },
  "AllowedHosts": "*",
  "ProductEndpoint": "http://products",
  "ProductEndpointHttps": "https://products"
}

Listing	2-8 The Store appsettings.json FileHere we are telling Aspire that the endpoints now use the "products" name that theorchestrator added to the AppHost.

Figure	2-39 The Aspire DashboardRunning the project will launch the dashboard as seen in Figure 2-39.



Figure	2-40 The Running Store AppClicking on the store resource’s URL in the dashboard will launch the Store application(Figure 2-40).But something is missing. In the dashboard (Figure 2-39), there is no GitHub Copilotintegration.



Figure	2-41 The Aspire NuGet Package VersionThis is because the .NET Aspire NuGet package that was added is most likely (as of thiswriting) version 9.0.0, as seen in Figure 2-41.To �ix this, right-click on the AppHost project and select Manage NuGet packages from thecontext window.



Figure	2-42 Update AppHost NuGet PackageUnder the Updates tab, you will see that the NuGet package for Aspire.Hosting.AppHostmight be outdated. Update this to the latest version available to you (for me, it was version 9.3.1as seen in Figure 2-42).Rebuild your solution and run the Aspire project again.

Figure	2-43 The Aspire Dashboard with CopilotThis time around, you will see GitHub Copilot integrated into your Aspire dashboard.Although the eShopLite application is a small solution, it clearly demonstrates how to add.NET Aspire to an existing project. This allowed us to bene�it from:Uni�ied Startup.Service discovery, avoiding the need for hardcoded URLs.Telemetry and Health out of the box.Dev-time Containers - Aspire set the stage to easily add other services, which we’ll see in thenext section.



Aspire is capable of scaffolding away the complexities of managing multiple projects in asolution and, in doing so, reducing developer toil, allowing you to be more productive andeffective (reducing your time to F5).
Adding	 .NET	 Aspire	 PackagesOne of the core bene�its of .NET Aspire is the ability to use pre-built connectors (or packages) forpopular services. These integrations come in two �lavors:Hosting integrations – These provision or connect to external resources like databases, caches,message brokers, etc.Client integrations – These con�igure your application to use those resources via DI, healthchecks, etc.Adding Aspire packages to your solution allows you to easily incorporate things like Redis,SQL Server, Azure Services, AWS services, and more into your application using a consistentpattern.The .NET Aspire team provides a curated suite of NuGet packages under the Aspire.*naming. These are categorized by their service type and are designed to be cloud-agnostic orcloud-speci�ic.Cloud-agnostic packages are for technologies such as Redis, PostgreSQL, SQL Server,RabbitMQ, Ka�ka, MongoDB, etc.Azure-speci�ic packages can be found for Azure services such as Azure Service Bus, AzureKey Vault, Azure Storage, Azure Cosmos DB, Azure Functions, etc. The hosting integrations canbe found in the Aspire.Hosting.Azure.* NuGet packages with their client integrationsliving in the Aspire.* NuGet packages.The .NET Aspire Community Toolkit is a collection of integrations for .NET Aspire that hasbeen created by the community, but that is not of�icially supported by the .NET Aspire team. Formore information on what the Community Toolkit provides, browse to
https://learn.microsoft.com/en-us/dotnet/aspire/community-
toolkit/overview.The key takeaway here is that adding an integration is as simple as installing a NuGetpackage and calling the corresponding extension method. You need to remember, though, that.NET Aspire is evolving, and you will want to keep your packages updated. Use the previoussection as an example where we had to update the AppHost package (Figure 2-42). This updateadded GitHub Copilot integration into our Aspire dashboard.A good rule of thumb is to use the latest stable Aspire packages and review the release notesregularly.
Adding	 SQL	 ServerWe had a look at adding .NET Aspire to an existing application called eShopLite earlier. Thisapplication is con�igured to use SQLite by default. This means that it uses a local SQLite databasenamed Database.db located in the application’s working directory (Figure 2-44).You can see this by going to the Products project in your Solution Explorer, right-clicking on itand selecting Open Folder in File Explorer.While this is great for debugging locally, we want to add SQL Server to our eShopLiteapplication. Luckily, .NET Aspire makes it easy to add a SQL Server database.

https://learn.microsoft.com/en-us/dotnet/aspire/community-toolkit/overview


Figure	2-44 The Local SQLite DatabaseLet’s see how to do this by adding a local SQL Server container and connecting our app to itvia Entity Framework Core.
Installing	 the	 SQL	 Server	 Integration	 PackagesLet us identify which packages we will need. To enable running SQL Server in a container orhandling an external connection, we will need to install Aspire.Hosting.SqlServer asseen in Figure 2-45.



Figure	2-45 The Aspire.Hosting.SqlServer PackageWe also need a client integration for our data access approach. If we use EF Core, we willwant the Aspire.Microsoft.EntityFrameworkCore.SqlServer package. If we wantto use raw ADO.NET or Dapper, we will need Aspire.Microsoft.Data.SqlClient.Because EF Core usage is common, we’ll be using that. To get started, add the following:eShopLite.AppHost project – add the Aspire.Hosting.SqlServer NuGet package,matching the version of Aspire you’re using. You can do this by right-clicking the AppHostproject and selecting Add -> .NET Aspire Package from the context menu. This will take you tothe available Aspire NuGet packages by applying the �iler owner:Aspire
tags:integration+hosting.Products project – to the project that needs database access, add
Aspire.Microsoft.EntityFrameworkCore.SqlServer.These packages will bring the required dependencies into your eShopLite solution. Whenyou have done this, the solution dependencies for the two projects should look as in Figure 2-46.



Figure	2-46 The Added NuGet PackagesWe now have a few code changes to make next. We need to tell the AppHost that we want touse SQL server.
Add	 a	 SQL	 Server	 Resource	 in	 AppHostTo con�igure the AppHost to include a SQL Server instance, we need to open the Program.cs�ile and make some code changes as shown in Listing 2-9.
var builder = DistributedApplication.CreateBuilder(args);

var sql = builder.AddSqlServer("sql")



    .WithLifetime(ContainerLifetime.Persistent);

var db = sql.AddDatabase("eShopLite");

var prodstore = builder.AddProject<Projects.Products>("products")
    .WithReference(db)
    .WaitFor(db);

builder.AddProject<Projects.Store>("store")
    .WithExternalHttpEndpoints()
    .WithReference(prodstore)
    .WaitFor(prodstore);

builder.Build().Run();
Listing	2-9 The AppHost Program.cs FileWhat we have done is added a SQL server resource to the AppHost by adding the line
builder.AddSqlServer("sql").
AddSqlServerThis will pull and run the of�icial Docker image when you start the application. The string "sql"is the resource name. You use this to reference this resource in connection strings.
WithLifetimeWe have also chained .WithLifetime(ContainerLifetime.Persistent) to specifythat the SQL container should use a persisted lifetime. SQL Server can take some time to start up,so using this is recommended. Aspire will therefore try to keep the container running acrossmultiple debug sessions of your app, instead of tearing it down each time. In reality, Aspire willstop it when the AppHost stops, but mark it to reuse the container with its data volume on thenext run. This ensures that subsequent debug sessions are faster and your database persists. Fordev scenarios, persistence is a good idea.
AddDatabaseTo add a database resource to SQL Server, we used var db =
sql.AddDatabase("eShopLite"). Our database name is speci�ied as "eShopLite". Infact, this is the resource name. Under the hood, Aspire will use the resource name as thedatabase name if not provided. You could specify the resource name and database nameseparately by changing that line of code to var db = sql.AddDatabase("db",
"eShopLite"). Here, the resource name is "db" and the database name is "eShopLite".
WithReference	and	WaitForNext, we use our resource in the project that needs the database, which is (in our eShopLitesolution) the Products project. Here we add WithReference and WaitFor.
WithReferenceThis injects the connection information for the database into our Products project’scon�iguration. In fact, it uses the resource name as the connection string name, unless it isoverridden.
WaitFor



As mentioned previously, WaitFor ensures that our Products API doesn’t start until thedatabase is ready.
First	RunAt this point, when you run your AppHost, you will notice that all your resources are eitherstarting or waiting (Figure 2-47).

Figure	2-47 Aspire DashboardAs speci�ied in our AppHost, the Products project needs to WaitFor the database to beready.Docker then pulls the mcr.microsoft.com/mssql/server image if it hasn’t beenpulled previously (Figure 2-48). Aspire then starts the container and waits until the SQL serveris responding. Once the database eShopLite has been created (on �irst run), Aspire sets theenvironment variable or con�ig for the connection string. Once all that is in place, the API willstart up.



Figure	2-48 Docker DesktopThe next thing we need to do is add the client integration. Stop your Aspire project and let’sset that up next.
Connecting	the	Application	via	EF	CoreOur Products project is the API project for our application. You will remember (refer back toFigure 2-46) that we added Aspire.Microsoft.EntityFrameworkCore.SqlServer tothis project. This means that we have an extension to register our DbContext.We can modify our code to use EF Core instead of SQLite by adding
builder.AddSqlServerDbContext<ProductDataContext>(connectionName:
"eShopLite") to the Program.cs �ile of the Products project.You can see the complete code in Listing 2-10.
var builder = WebApplication.CreateBuilder(args);
builder.AddServiceDefaults();
builder.AddSqlServerDbContext<ProductDataContext>(connectionName:
"eShopLite");
// Add services to the container.
var app = builder.Build();
app.MapDefaultEndpoints();
// Configure the HTTP request pipeline.
app.MapProductEndpoints();
app.UseStaticFiles();
await app.CreateDbIfNotExistsAsync();
await app.RunAsync();

Listing	2-10 The Products Program.cs FileThe last code change we need to make is to modify the ProductDataContext class.



public static async Task CreateDbIfNotExistsAsync(this IHost host)
{
    using var scope = host.Services.CreateScope();

    var services = scope.ServiceProvider;
    var context = services.GetRequiredService<ProductDataContext>();
    // Remove EnsureCreatedAsync
    //await context.Database.EnsureCreatedAsync();
    // Add MigrateAsync
    await context.Database.MigrateAsync();

    await DbInitializer.InitializeAsync(context);
}

Listing	2-11 Modifying the ProductDataContext ClassYou will see that we have commented out the EnsureCreatedAsync() method andreplaced it with MigrateAsync() method. This will asynchronously apply any pendingmigrations for the context to the database, and it will also create the database if it does notalready exist.Now that we have that �igured out, we need to get the tables created on our database. Aspirehas only created the database for us; it hasn’t created any tables. To do this, we will be usingmigrations.
Adding	and	Running	MigrationsTo get the process going, right-click on the Products project and select “Open in Terminal”from the context menu. Once the terminal is open, run the command dotnet ef
migrations add InitialCreate. You can see this in Figure 2-49.

Figure	2-49 Adding MigrationsThis will add a Migrations folder to your Products project as seen in Figure 2-50.Although we manually ran dotnet ef migrations add to generate the initialmigration, we do not actually need to apply the migration using dotnet ef database
update.When our Aspire application starts up, it will automatically apply all pending migrations atruntime thanks to the context.Database.MigrateAsync() call in our



CreateDbIfNotExistsAsync method. This allows us to maintain a clean deploymentpipeline, where schema creation and evolution are handled within the application itself, noseparate migration steps required.Later on in development, if you added a new entity (e.g., Category or Order), you will only berequired to generate a new migration to re�lect that change. This is done by running the dotnet
ef migrations add command, followed by the name that describes the purpose of themigration. For example, dotnet ef migrations add AddCategoryEntity. In thisexample, AddCategoryEntity is not a command or keyword; it’s simply the name of themigration.

Figure	2-50 The Migrations FolderThis command scans your updated DbContext and generates the appropriate Up() and
Down() methods to apply or remove the schema change. Once this migration exists in yourproject, you do not need to manually apply it. Aspire will run the app as usual, and because wehave hooked up context.Database.MigrateAsync(), any pending migrations, includingones for newly added entities, will automatically be applied to the database at runtime.



Running	Your	Aspire	AppWe can now run our Aspire application to kick off the process of applying the migrations weadded.If you get a ‘Globalization Invariant Mode is not supported’ error, stop your applicationand edit the .csproj �ile of the Products project. Look for and remove the tag<InvariantGlobalization>true</InvariantGlobalization> from the <PropertyGroup>. Then runyour Aspire solution again.Once all your resources are marked as running in your Aspire dashboard, open up a Consoleand run the command docker ps. This will list your running Docker containers as seen inFigure 2-52. Look for the PORTS column in the output for the container spun up by Aspire foryour SQL Server as seen in Figure 2-51.

Figure	2-51 The Running ContainersFrom the Console, you will see that our container is listening on port 1433 internally (SQLServer’s default port). Docker is exposing it to my local machine on port 63377. This means thatI can connect to my database via SQL Server Management Studio using that IP and Port.

Figure	2-52 The Running Containers in the ConsoleOpen SQL Server Management Studio and paste 127.0.0.1,63377 into your Server Name.Take note of the comma between the IP address and the Port. To �ind the password of the sa SQLuser, in the running Aspire dashboard, click on View Details under the Actions column on the
SQL resource (Figure 2-53).



Figure	2-53 Finding the SQL Server PasswordWith the password copied paste it into the Connect to Server dialog (Figure 2-54).

Figure	2-54 Connect to Server Dialog



Once you click on the Connect button, you will connect to the database in the container thatAspire spun up for you, as seen in Figure 2-55. The database name is the same name displayed inour Aspire dashboard and is the same as we had de�ined in the AppHost’s Program.cs �ile.

Figure	2-55 The eShopLite DatabaseIf you select the Product table, you will see the data that your Products API project seededwhen it started. The seeding data can be seen in the ProductDataContext class in theProducts API.Running the web application from your Aspire dashboard and browsing to the Productsmenu, you will see the product data seeded in your Docker container’s SQL database.



Figure	2-56 The Running Product StoreCongratulations, you have successfully added a SQL database to your .NET Aspire application. Byadding SQL Server through .NET Aspire, you have essentially containerized your databasedependency without the usual hassle. Many developers will �ind this extremely useful forensuring that their dev/test environment is as “production-like” as possible. Not having tomaintain separate local connection strings or keep a local SQL Express running reducescomplexity and improves developer productivity.
A	 Word	 on	 NuGet	 PackagesAs a software developer, being able to reuse code is essential to any modern development effort.Being able to share code is the cornerstone of a healthy development community. Manydevelopers create handy code libraries that can add functionality to your particular application.We saw how NuGet packages allowed us to add functionality to our Aspire application.This is where NuGet becomes an essential tool for developers to create, share, and consumehelpful code. As a developer, you can package a DLL and other required content needed for theDLL to function correctly into a NuGet package.NuGet is just a ZIP �ile with a .nupkg extension containing the DLLs you have created fordistribution. Included inside this package is a manifest �ile that contains additional information,such as the version number of the NuGet package.Packages uploaded to nuget.org are public and available to all developers that use NuGet intheir projects. However, developers can create NuGet packages that are exclusive to a particularorganization and not publicly available. Let’s look at hosting your own NuGet feeds.
Hosting	 Your	 Own	 NuGet	 FeedsSometimes you need to share NuGet packages with a limited audience, typically internaldevelopers, without publishing them publicly on nuget.org. Whether due to security policies orproprietary code, NuGet supports several options for private hosting:Local feed – Simply share a folder over the network and point NuGet to it. This is ideal forquick internal distribution.



Azure Artifacts – A managed and scalable solution for hosting private NuGet feeds as part ofAzure DevOps.Third-party solutions:MyGet – https://myget.org/ProGet – https://inedo.com/progetTeamCity – www.jetbrains.com/teamcity/For a complete list of NuGet hosting products and for more information on creating yourNuGet feeds, have a look at the following link on Microsoft Learn:
https://learn.microsoft.com/en-us/nuget/hosting-packages/overview.
Using	 npm	 in	 .NET	 ProjectsExperienced .NET developers are used to managing libraries with NuGet, but modern webdevelopment often relies on npm (Node Package Manager) for client-side packages and buildtools. In ASP.NET Core web apps, npm is commonly used to pull in JavaScript frameworks, CSSlibraries, and tools such as Webpack or Gulp.Visual Studio makes integrating npm into your work�low easy by providing native supportfor npm. One of the advantages of using npm is that it hosts virtually any front-end library ortool you might need, all in one place.Unlike NuGet, which can manage .NET and some JS packages, npm is speci�ically used forNode.js and front-end ecosystems. Packages are managed by project, and are installed into alocal node_modules folder. By contrast, NuGet uses a global cache and will allow multipleversions of a library in different projects. With npm, each project maintains its owndependencies.This means that only one version of a speci�ic package is used per project, which is storedunder that project’s node_modules folder. The result is that this isolation from other projectsmeans that there could potentially be a duplication of packages across projects.If you want to use npm, you need to have Node.js (which includes npm) installed on yoursystem. You can use Visual Studio’s Node.js development workload to install Node.js for you, butyou can also install Node.js from the of�icial website at https://nodejs.org/.You can verify if Node.js is installed by running node -v and npm -v as seen in Figure 2-57. Project templates such as React or Angular include a package.json by default, and VisualStudio will automatically trigger an npm install on creation of such a project to retrieve allthe client-side dependencies.

https://myget.org/
https://inedo.com/proget
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https://nodejs.org/


Figure	2-57 Check if Node.js is InstalledIn other words, when using Visual Studio 2022 to create an Angular or React app using thebuilt-in templates, the corresponding CLI tooling is invoked under the hood. This is why the
package.json is automatically created and the npm install command is executed to pullthe required client-side dependencies.
Anatomy	 of	 the	 package.jsonThe heart of your project’s client-side setup is the package.json �ile when working with npm.An example of this �ile can be seen in Listing 2-12. This JSON �ile lives at the root of your projectand describes your project to npm. This includes information such as the project’s name as wellas metadata like what versions of packages your project has dependencies on.
{
  "name": "reactdemo.client",
  "private": true,
  "version": "0.0.0",
  "type": "module",
  "scripts": {
    "dev": "vite",
    "build": "vite build",
    "lint": "eslint .",
    "preview": "vite preview"
  },
  "dependencies": {
    "react": "^19.1.0",
    "react-dom": "^19.1.0"
  },
  "devDependencies": {
    "@cap-js/sqlite": "^2.0.1",
    "@eslint/js": "^9.29.0",
    "@types/react": "^19.1.8",
    "@types/react-dom": "^19.1.6",



    "@vitejs/plugin-react": "^4.5.2",
    "eslint": "^9.29.0",
    "eslint-plugin-react-hooks": "^5.2.0",
    "eslint-plugin-react-refresh": "^0.4.20",
    "globals": "^16.2.0",
    "vite": "^7.0.0"
  }
}
Listing	2-12 The package.json FileEssentially, the package.json �ile tells npm what needs to be installed. The key �ields inthe �ile include:
name – This is the name of your application, usually all lowercase.
version – This is the current version of your project, which needs to be updated as yourproject evolves.
scripts – An object listing command scripts you can run via npm.
dependencies – These are the runtime dependencies for your app.
devDependencies – As the name suggests, these are the development-time dependenciesrequired during development.In the example package.json �ile in Listing 2-12, you will notice version numbers next tothe dependencies. For package versions, npm uses semantic versioning that allows you to be�lexible with regard to version ranges. A version number is de�ined as major.minor.patchand the way you specify the version in this �ile has signi�icance.Caret (^): For example, "react": "^19.1.0" allows updates to any version 19.x.x newerthan 19.1.0 but not 20.x. This means you will get the latest minor/patch updates but no majorupdates that might break compatibility.Tilde (~): For example, "react":"~19.1.0" allows updates to any version 19.1.x (patchversions), but will lock the minor version. This means 19.1.0 can update to 19.1.1 but not19.2.0.No pre�ix (exact version): For example, "react":"19.1.0" locks the version to exactlywhat is de�ined. This means npm will not update it unless you manually change the version.Using these notations allows you to control the aggressiveness of your updates. In summary,the package.json �ile is your go-to place for con�iguring npm packages. Visual Studio andnpm work in unison to keep this �ile and your node_modules in sync.

Managing	 npm	 PackagesIn a similar vein to NuGet, npm is the tool for managing client-side JavaScript packages. It’swidely used in ASP.NET Core projects, speci�ically those utilizing modern front-end frameworkslike Angular, React, or Vue.Visual Studio 2022 integrates well with npm through the package.json, allowing you toinstall packages, run build scripts, and manage front-end dependencies directly from the IDE.The package manager can be opened by right-clicking the npm node in the Solution Explorer asseen in Figure 2-58.



Figure	2-58 Installing New npm PackagesYou can now search for npm packages and then select one to install, as seen in Figure 2-59.Clicking the Install Package button installs the package.



Figure	2-59 Searching for npm PackagesTo learn more, visit the of�icial documentation at https://docs.npmjs.com/.
Using	the	CLIYou can use npm from the command line in Visual Studio. Sometimes it’s faster to run npmcommands directly. If, for example, you want to add a package using the CLI, you can open aterminal in Visual Studio and type npm install <package-name> --save-dev to installit under devDependencies or npm install <package-name> --save to install itunder dependencies in the package.json. You can see an example of this in Figure 2-60.

Figure	2-60 Installing gulp-scss-lintLooking at the package.json �ile in Listing 2-13, you can see the added package gulp-
scss-lint in devDependencies.

https://docs.npmjs.com/


{
  "name": "reactdemo.client",
  "private": true,
  "version": "0.0.0",
  "type": "module",
  "scripts": {
    "dev": "vite",
    "build": "vite build",
    "lint": "eslint .",
    "preview": "vite preview"
  },
  "dependencies": {
    "react": "^19.1.0",
    "react-dom": "^19.1.0"
  },
  "devDependencies": {
    "@cap-js/sqlite": "^2.0.1",
    "@eslint/js": "^9.29.0",
    "@types/react": "^19.1.8",
    "@types/react-dom": "^19.1.6",
    "@vitejs/plugin-react": "^4.5.2",
    "eslint": "^9.29.0",
    "eslint-plugin-react-hooks": "^5.2.0",
    "eslint-plugin-react-refresh": "^0.4.20",
    "globals": "^16.2.0",
    "gulp-scss-lint": "^1.0.0",
    "vite": "^7.0.0"
  }
}

Listing	2-13 The Updated package.json FileVisual Studio allows you to manage npm packages using either the built-in user interface orthe integrated terminal, making it extremely convenient to handle npm packages directly fromwithin the IDE.
Security	 ConsiderationsUsing npm packages often means pulling in third-party code. This could introduce potentialsecurity vulnerabilities if the packages you add or their dependencies have known issues.Luckily, we can rely on npm to provide tools to help us with maintaining security.The npm CLI has a built-in security audit feature that checks your project dependenciesagainst a database of known vulnerabilities. You can run this tool at any time by executing npm
audit as seen in Figure 2-61.This will analyze the package.json and send dependency info (package names andversions) to the npm registry’s audit service. If any vulnerabilities are found, these will bereported along with their severity and if a �ix is available or not.



Figure	2-61 Running npm AuditIf there are any �ixes available, you can run npm audit fix to automatically applyrecommended updates to your package.json �ile and install the new versions. Sometimes
npm audit will report a vulnerability for which there is no available �ix yet (as seen in Figure2-61). For these issues, you have a few options:Check if the package has an open issue or patch in progress. The audit report might eveninclude a URL for you to review.Consider if you really need the package, or if you could replace it with an alternative packagethat is better maintained.As a rule of thumb, make sure that you regularly run npm outdated to see which of yourdirect dependencies have newer versions.
Creating	 and	 Using	 Code	 SnippetsCode snippets in Visual Studio are small blocks of reusable code that you can insert into yourcode �ile by typing a shortcut and tabbing twice or using the right-click menu.As an example (Figure 2-62), open a C# code �ile in Visual Studio and type the word try andhit the tab key twice.

Figure	2-62 Inserting a Try Code Snippet



This inserts a try-catch into your code �ile and allows you to enter the speci�ic exception typebeing handled, as seen highlighted in Figure 2-63.

Figure	2-63 The Inserted try-catch BlockIf you want to see all the available code snippets, you can open the Code Snippets Manager(Figure 2-64) by going to the Tools menu and clicking Code Snippets Manager.

Figure	2-64 Code Snippets Manager



You can also hold down Ctrl+K, Ctrl+B to open the Code Snippets Manager window. Clickingeach code snippet displays the description, shortcut, snippet type (expansion or surroundswith), and author. While some shortcuts are obvious (do, else, enum, for, and so on), others arenot and might take some getting used to remembering to enter the shortcut and tabbing twice toinsert the snippet.If you can’t remember the shortcut, you can invoke the snippets by hitting Ctrl+K, Ctrl+X (asseen in Figure 2-65) while inside the code �ile you are editing. This will display a menu in placethat will allow you to search for and select the speci�ic code snippet you want to use.

Figure	2-65 Ctrl+K, Ctrl+X to Invoke a Code SnippetYou can also right-click and select Snippets and Insert Snippet from the context menu. Thelast way to insert a code snippet is via the menu bar by going to Edit, IntelliSense, and clickingInsert Snippet. Visual Studio also allows developers to create their own code snippets. Let’s havea look at that process next.
Creating	 Code	 SnippetsOne feature I’ve always felt Visual Studio is missing is a user-friendly interface for creating codesnippets. Maybe that will come in a future release. For now, we’ll work with what’s available byde�ining snippets manually in XML. The basic snippet template XML is shown in Listing 2-14.
<?xml version="1.0" encoding="utf-8"?>
<CodeSnippets
xmlns:="http://schemas.microsoft.com/VisualStudio/2005/CodeSnippet">
    <CodeSnippet Format="1.0.0">
        <Header>
            <Title></Title>
        </Header>
        <Snippet>
            <Code Language="">
                <![CDATA[]]>
            </Code>
        </Snippet>
    </CodeSnippet>
</CodeSnippets>
Listing	2-14  Basic Snippet TemplateLet’s assume we have created a Custom project template that includes dependency injectionfor a logger and a service interface. This is useful if you are creating services or controllers thatrequire logging and other injected dependencies. You will save time and reduce boilerplate inevery new project by standardizing this pattern.



But you can make this even more convenient by creating a custom code snippet that insertsthe constructor and includes the injected dependencies and null checks. The snippet shown inListing 2-15 does exactly that. It de�ines the �ields, generates the constructor, and sets up theassignment with guard clauses.
<CodeSnippets
xmlns:="http://schemas.microsoft.com/VisualStudio/2005/CodeSnippet">
  <CodeSnippet Format="1.0.0">
    <Header>
      <Title>Constructor Injection</Title>
      <Shortcut>ctori</Shortcut>
      <Description>Creates a constructor with injected dependencies
and null checks.</Description>
      <Author>Dirk Strauss</Author>
      <SnippetTypes>
        <SnippetType>Expansion</SnippetType>
      </SnippetTypes>
    </Header>
    <Snippet>
      <Declarations>
        <Literal>
          <ID>ClassName</ID>
          <ToolTip>The class name for ILogger&lt;T&gt;</ToolTip>
          <Default>MyClass</Default>
        </Literal>
        <Literal>
          <ID>ServiceName</ID>
          <ToolTip>The injected service type</ToolTip>
          <Default>IMyService</Default>
        </Literal>
        <Literal>
          <ID>FieldName</ID>
          <ToolTip>The field name for the injected service</ToolTip>
          <Default>myService</Default>
        </Literal>
      </Declarations>
      <Code Language="csharp"><![CDATA[
private readonly $ServiceName$ _$FieldName$;
private readonly ILogger<$ClassName$> _logger;

public $ClassName$($ServiceName$ $FieldName$, ILogger<$ClassName$>
logger)
{
    _$FieldName$ = $FieldName$ ?? throw new
ArgumentNullException(nameof($FieldName$));
    _logger = logger ?? throw new
ArgumentNullException(nameof(logger));
}
$end$
]]></Code>



    </Snippet>
  </CodeSnippet>
</CodeSnippets>

Listing	2-15 Basic Logging ClassCreate a �ile with the XML in Listing 2-15 and save it with a .snippet extension, forexample ctori.snippet. To import this snippet into Visual Studio:Press Ctrl+K, Ctrl+B or go to Tools ➤ Code Snippet Manager.In the dropdown, select Visual C# (or relevant language for your snippet).In the Code Snippet Manager, click Import.Browse to the .snippet �ile you saved earlier and click Open.Select the folder where you want it to live, for example, “My Code Snippets” and click Finish.Back in your project, create a new class and use the ctori shortcut as seen in Figure 2-66.

Figure	2-66 Using the New Code SnippetHitting the tab key twice will insert the snippet into your code �ile, shown in Figure 2-67.

Figure	2-67 The Inserted Code SnippetYou can now �ill in the values for the placeholders, tabbing between each to go to the next.When you are done, your class should look similar to the code in Listing 2-16, with only the classname and value for IMyService differing.
public class Order



{
    private readonly IOrderRepository _orderRepo;
    private readonly ILogger<Order> _logger;

    public Order(IOrderRepository orderRepo, ILogger<Order> logger)
    {
        _orderRepo = orderRepo ?? throw new
ArgumentNullException(nameof(orderRepo));
        _logger = logger ?? throw new
ArgumentNullException(nameof(logger));
    }
}

Listing	2-16 An Example of the Inserted SnippetThis new code snippet is now available in all your future projects. Your C# code snippets livein the Documents folder in \Visual Studio 2022\Code Snippets\Visual C#\My
Code Snippets.The code snippet schema reference is available on Microsoft Docs at the following link:
https://learn.microsoft.com/en-us/visualstudio/ide/code-snippets-
schema-reference.More often than not, you will create your own code snippets based on an existing codesnippet. This allows you to reuse functionality you know is working in the existing snippet andinclude it in your own.Code snippets are a very powerful productivity feature in Visual Studio, but you might bewondering if code snippets still make sense with the advent of GitHub Copilot. The short answeris, yes. Their role, however, have shifted from being the go-to productivity tool for quick,reusable code snippets to being a supportive tool alongside GitHub Copilot.
Using	 Bookmarks	 and	 Code	 ShortcutsYou will likely be working on an extensive code base at some point in your career. Do this for awhile, and you will get bogged down with remembering where a speci�ic bit of code is or whereyou need to go to get to a speci�ic portion of logic.Visual Studio can assist developers in bookmarking certain sections of code and addshortcuts to other areas of code. Let’s have a look at what bookmarks and shortcuts are andwhen to use them.
BookmarksThe Bookmarks feature in Visual Studio has been around since the early versions of the IDE. Itwas designed to solve a common problem for developers, and that is keeping track of importantlocations in your code. It does not matter if you have a very large codebase or if you are workingacross multiple �iles and classes; bookmarks (as their real-world counterpart) help you avoidlosing your place. They are very handy when debugging, trying to �igure out legacy code, orreviewing related methods. You no longer need to rely on memory or scattered comments;bookmarks provide a structured, built-in method to mark and revisit key pieces of code at a laterstage.To see how bookmarks work, place your cursor at the line of code you want to return to, andhold down Ctrl+K, Ctrl+K, and Visual Studio will add a bookmark, as seen in Figure 2-68.

https://learn.microsoft.com/en-us/visualstudio/ide/code-snippets-schema-reference


Figure	2-68 Bookmark in Visual StudioThe bookmark is added to the side of the code editor and is indicated by a single greybookmark icon.To see all the bookmarks in your project, you can hold down Ctrl+K, Ctrl+W, or go to the Viewmenu item, select Other Windows, and then click Bookmark window.The Bookmarks window is displayed as shown in Figure 2-69. From the toolbar in theBookmarks window, you can group bookmarks in folders, navigate between bookmarks,navigate between bookmarks in the current folder, toggle a bookmark on the currently selectedline in code, disable all bookmarks, and delete bookmarks.

Figure	2-69 Bookmarks WindowOne less obvious feature of the Bookmarks window is the ability to rename bookmarks. Torename a bookmark, click a selected bookmark, and you will see that the name (in this case,“Bookmark1”) becomes editable.Now you can rename your bookmark to something more relevant to what you need toremember, as shown in Figure 2-70. Compare Figure 2-70 with the bookmark windows as seenin Figure 2-71. Renaming your bookmarks to more suitable names gives your bookmarkswindow more meaning.



Figure	2-70 Renamed Bookmark

Figure	2-71 Bookmarks CollectionNow, click the delete button on the Bookmarks toolbar. The bookmark is deleted without anycon�irmation from the user.This is something I can almost understand. It might become cumbersome to have to con�irmevery bookmark deletion, especially when you want to remove only a subsection of bookmarksfrom your collection.For this reason, I only use bookmarks as a short-term solution to remind me to go andperform some action in code or refactor something I think needs refactoring. The ease at whichthey can be deleted, however, does make me wary of using them to mark important lines of codethat I could potentially want to revisit often. It is for this reason that I treat a bookmark assomething I will come back to within the next day or so. Something I don’t want to put off doing.It is, therefore, a temporary placeholder to something I need to revisit.But what if I wanted to go and add a more permanent pointer to some logic in the code? Thisis where code shortcuts come in. Let’s have a look at this next.
Code	 ShortcutsThe ability to add code shortcuts in Visual Studio is more helpful when you need to jump to acertain section of code regularly. To add a shortcut to a speci�ic section of code in Visual Studio,you need to place your cursor on the line of code you need to revisit and press Ctrl+K, Ctrl+H.Visual Studio will then add the shortcut, as seen in Figure 2-72. To view all the shortcutsadded to your project, hold down Ctrl+\, Ctrl+T, or go to the View menu, and select Task List toopen the Task List window, shown in Figure 2-73.



Figure	2-72 Code Shortcut Added Indicator

Figure	2-73 The Task ListIn some ways, I prefer the Task List over bookmarks since I can quickly add reminders byinserting //TODO: in my code. With your Task List open, go to any place in your code, and addthe comment in Listing 2-17.
// TODO: Remember to do something here

Listing	2-17 TODO CommentNow, have a look at your Task List. You will notice that the TODO comment has been added toyour Task List. I wanted to remember to refactor some code. Adding that TODO as shown inFigure 2-74 puts the reminder front and center so that I will not forget.



Figure	2-74 TODO Comments in the Task ListThis is a nice and quick method for adding reminders to your code so that you can easilyrefer, and navigate to them by double-clicking the item in the Task List. You can, therefore, usethe Task List to take you directly to the relevant location in the code.In Visual Studio, TODO is what we call a prede�ined token. Therefore, a comment in your codethat uses a prede�ined token will appear in your Task List. The tokenized comment is made up ofthe following:The comment marker, which is //The prede�ined token (TODO in our example)The rest of the commentThe code in Listing 2-17 is a valid comment using a token and will appear in the Task List.Visual Studio includes the following default tokens:HACKTODOUNDONEUnresolvedMergeCon�lictThese are by no means case sensitive and will appear in your Task List if following the formin Listing 2-17. You can also add your own custom tokens. Let’s see how to do that next.
Adding	 Custom	 TokensI like the idea of TODO to add items to my Task List, but I would also like to add a custom tokento add an entry in my Task List, which is a nice-to-have feature. Something that is less restrictivethan a TODO, because that implies that this action must be completed.I do not want to have a bunch of TODO entries for items that are simply nice-to-have features.For this reason, I want to add a custom token called NOTE, simply as a reminder to look atsomething if and when I have the time.To add the custom token, go to the Tools menu and click Options. Under Environment, selectTask List as seen in Figure 2-75.



Figure	2-75 Add Custom TokensIn the Name text box, add the word NOTE and set the priority to Low. Then click the Addbutton. The custom token NOTE is added, as shown in Figure 2-76.

Figure	2-76 The Custom Token AddedAdding a NOTE to your code pops up in your Task List as a low-priority task (Figure 2-77).



Figure	2-77 Adding a NOTE Token CommentBeing able to add custom tokens in Visual Studio, as well as applying a priority to each,allows you to be very speci�ic with comments that contain tokens. This way, you can signi�icantlyincrease the ease and ef�iciency of navigating a large codebase.
The	 Server	 ExplorerAs the name suggests, the Server Explorer provides a quick and easy way of accessing servers.You can use it to test connections and view SQL Server databases or any databases that have theADO.NET provider installed.You can access the Server Explorer by holding down Ctrl+Alt+S or by going to the View menuand clicking Server Explorer.Figure 2-78 shows that the Server Explorer offers access to Event Logs, Message Queues,Performance Counters, and Services on my local machine (DELL-LATITUDE).



Figure	2-78 Server ExplorerI have a local instance of SQL Server installed, so now I can connect to this instance directlyfrom within Visual Studio by clicking Connect to Database.This displays a window allowing you to choose a data source, as seen in Figure 2-79. You canconnect to various data sources, but we are only interested in Microsoft SQL Server for now.Select that from the list and click Continue.



Figure	2-79 Choose Data SourceThe following window (Figure 2-80) allows you to de�ine your connection to the database.Here, you need to specify the server name and the authentication type, and if SQL ServerAuthentication is selected, provide the username and password.



Figure	2-80 Add ConnectionYou can now select a database from the list to connect to. Click on the Test Connection buttonto check if the connection settings are correct.After adding the database to your Server Explorer, you will see the instance added to your listfrom where you can expand the various nodes to view Tables, Views, and Stored Procedures, asshown in Figure 2-81.



Figure	2-81 Database Added to Server ExplorerBy double-clicking a table, Visual Studio displays the table designer for you and a create tableSQL statement (Figure 2-82).



Figure	2-82 Table DesignerFrom this window, you can easily update the table. The create table statement in Figure 2-82is listed in Listing 2-18.
CREATE TABLE [dbo].[UserHistory] (
    [Id]              INT              IDENTITY (1, 1) NOT NULL,
    [Username]        NVARCHAR (50)    NULL,
    [UserAction]      NVARCHAR (256)   NULL,
    [LogDateTIme]     DATETIME         NULL,
    CONSTRAINT [PK_UserHistory] PRIMARY KEY CLUSTERED ([Id] ASC)
);

Listing	2-18 Create table statement.We can now modify the UserHistory table by altering the SQL statement as shown inListing 2-19.
CREATE TABLE [dbo].[UserHistory] (
    [Id]             INT            IDENTITY (1, 1) NOT NULL,
    [Username]       VARCHAR (50)   NOT NULL,
    [UserAction]     VARCHAR (256)  NOT NULL,
    [LogDateTIme]    DATETIME       NULL,
    [LogCategory]    VARCHAR (5)    NULL,
    CONSTRAINT [PK_UserHistory] PRIMARY KEY CLUSTERED ([Id] ASC)
);

Listing	2-19 Modi�ied Create Table StatementI want to add a log category �ield to the table. When I modify the create table statement, I seethe changes re�lected in the table designer, as seen in Figure 2-83.



Figure	2-83 Table Design UpdatedThe changes have not been applied to my table yet. To update the table, I need to click theUpdate button.This allows me to preview the database updates, as seen in Figure 2-84. If you do not want tolet Visual Studio update the table, you can have it generate the script by clicking the GenerateScript button. Alternatively, you can go ahead and click the Update Database button afterreviewing any warnings and possible data issues in the Preview Database Updates window.



Figure	2-84 Preview Database UpdatesThis will then start the process of updating the database table with the changes you made.I am working with an empty table. I can, therefore, ignore the possible data issues andwarnings in the Preview Database Updates window.After the update, you can see the results in the Data Tools Operations window (Figure 2-85).From here, you can view the script and the results by clicking on the links on the right of theData Tools Operations window.



Figure	2-85 Data Tools Operations
Running	 SQL	 QueriesVisual Studio’s Server Explorer is more than just a view into your connected databases anddatabase objects. It enables direct interaction with your connected databases through anintegrated SQL query editor.The functionality is made possible by Visual Studio’s underlying data provider architecture,which uses ADO.NET to connect to various database engines such as SQL Server, Azure SQL, etc.You can communicate with the database using standard T-SQL over a managed connection.This gives developers a lightweight environment to run queries, inspect the output, andmake changes. All this can be done without leaving the IDE. Tight integration like this is great forquick data exploration and testing of small queries while coding.Go ahead, right-click a table (Figure 2-86), and click New Query from the context menu.



Figure	2-86 Run a SQL QueryNote That the context menu changes depending on what item you have right-clicked inthe Server Explorer. When right-clicking a table, you see items related to a SQL table. Whenright-clicking a View, you see items speci�ic to the View, such as Show Results and Open ViewDe�inition. The context menu will display the Execute command when right-clicking a StoredProcedure.Copy the SQL query in Listing 2-20. You will have had to create the table using the CREATEstatement in Listing 2-19.
SELECT Id, Username, UserAction, LogDateTime, LogCategory
FROM UserHistory
ORDER BY LogDateTime DESC, LogCategory

Listing	2-20 SQL Select StatementWhen you have pasted the SQL statement (Figure 2-87), execute it by clicking the run button,holding down Ctrl+Shift+E, or executing it with the debugger Alt+F5.



Figure	2-87 Running a Select StatementIf you’re used to pressing F5 in SQL Server Management Studio, you might �ind yourselfaccidentally starting the Visual Studio debugger instead of running the query. I �ind clicking therun button helps me avoid this muscle memory faux pas.Adding additional items to the table is quickly done by running INSERT statements asillustrated in Listing 2-21.
INSERT INTO [dbo].[UserHistory]
(
    [Username],
    [UserAction],
    [LogDateTIme],
    [LogCategory]
)
VALUES
(
    'TestUser',
    'Logged into the system',
    GETDATE(),
    'INFO'
)

Listing	2-21 Insert StatementIf we rerun the SELECT statement, you will see that the entry has been added to the table, asseen in Figure 2-88.



Figure	2-88 New User History Entry InsertedFrom the results in Figure 2-88, you will notice an invalid value for LogCategory. Let’schange that by running the SQL statement in Listing 2-22.
UPDATE [dbo].[UserHistory]
SET
    [LogCategory] = 'L'
WHERE [Id] = 50

Listing	2-22 SQL Update StatementWhen we look at the table data after the UPDATE statement (Figure 2-89), you will see thatthe table has been updated to display the correct LogCategory value for the TestUser in thetable.



Figure	2-89 TestUser Entry UpdatedWhile running SQL statements directly from Visual Studio might not seem revolutionary, theconvenience it provides can’t be overstated. Being able to interact with your database, runqueries, and view results from the queries without leaving the IDE streamlines your work�lowand reduces context switching.Context switching shifts your focus between different tasks or mental models. This incursreal cognitive and time costs. When developers have to break focus, it is estimated that ittakes 20 to 25 minutes to completely regain concentration on the original task. Frequentinterruptions such as pings, meetings, or build waits can consume hours of focused work perweek. Understand what impact this can have in your daily work�low, and �ind ways to mitigatethe effect of context switching on your productivity.The Server Explorer provides much more functionality than what I have covered here,including being able to manage connections, exploring database assets, and even generatingscripts. I encourage you to spend some time exploring these features further. You might besurprised at how much it can enhance your productivity.
Visual	 Studio	 WindowsMany developers fall into a comfortable routine when working in Visual Studio, often relying onfamiliar work�lows and overlooking powerful tools that could signi�icantly improve theirproductivity.While there is nothing inherently wrong with sticking to what you know and to what worksfor you, it often comes at the cost of missing out on lesser-known but highly effective featuresprovided by Visual Studio. In this section, we will take a closer look at two utilities found underthe View ➤ Other Windows menu, as shown in Figure 2-90.



Figure	2-90 Other Windows in Visual StudioThere are too many windows to discuss in this chapter, but I will touch on two that I �ind veryuseful.
C#	 InteractiveHow often have you wanted to test a tiny bit of code to see if it works correctly? With C#Interactive, you can do just that without having to debug your entire solution. Found toward thebottom of the View ➤ Other Windows menu, C# Interactive is almost hidden. But gems usuallyare, and you’ll love using it if you don’t already.Click C# Interactive and paste the following code shown in Listing 2-23. After pasting thecode into C# Interactive, hit the Enter key to run the code.



var numList = new List<int>() { 153, 114, 116, 213, 619, 18, 176,
317, 212, 510 };
var numResults = numList.Where(x => x > 315);
foreach(var num in numResults)
{
   Console.WriteLine(num);
}

Listing	2-23 Running a LINQ QueryThe results are displayed below the code you pasted. Your C# Interactive window shouldnow appear as illustrated in Figure 2-91.

Figure	2-91 C# Interactive Code ResultsC# Interactive is what we refer to as a REPL (Read-Eval-Print Loop). Being able to inputexpressions that are evaluated and having the results returned makes on-the-spot debuggingpossible in Visual Studio.C# Interactive supports IntelliSense, so you get the same kind of editor experience as inVisual Studio. For a list of available keyboard shortcuts, REPL commands, and Script directivesthat C# Interactive supports, just type in #help and press the Enter key.Incidentally, you can run a C# REPL from the Command Prompt too. Install it using the
dotnet tool install -g csharprepl command as seen in Figure 2-92.



Figure	2-92 Installing the C# REPLYou can then invoke the REPL from the Command Prompt using csharprepl as seen inFigure 2-93.

Figure	2-93 Invoking the C# REPLThis can be handy when you are not using Visual Studio and need to run a few lines of code.
Code	 Metrics	 ResultsThe eShopLite project we have been using is not complex. It is just used to illustrate the conceptsin this book. If you take a more complex project, one of the projects you have worked on at work,this next screen might look a lot different.Code Metrics Results (Figure 2-94) is a set of measurements that allow developers to gain abetter insight into the code they produce.



Figure	2-94 Code Metrics ResultsModern software can become quite complex, and this makes it harder to ensure reliabilityand maintainability. This is where Visual Studio’s Code Metrics provide a quantitative insightinto the quality of your code.

Figure	2-95 Calculate Code MetricsIf you click on Analyze ➤ Calculate Code Metrics as shown in Figure 2-95, Visual Studio willevaluate your code and report �ive key metrics. These are:Maintainability IndexCyclomatic ComplexityDepth of InheritanceClass CouplingLines of CodeThis is baked into Visual Studio; you don’t need any third-party tools to gain valuable insightsinto your code. These metrics act as an early warning system for code smells, and you need topay attention to what they tell you.Vibe Coding is not edgy. It’s technical debt in skinny jeans. You’re not building a prototypefor Burning Man, you’re shipping software. Think beyond the code.You might hear the term “vibe coding” thrown around by developers. While it sounds cooland “in the zone”, it doesn’t belong in any serious or professional context. In my opinion, it’s ared �lag. A former colleague of mine used to say “think more and code less”. You need to beintentional in your design and not just �low with your feelings.



It’s akin to mixing late nights, caffeine, and zero accountability into a pull request.Unfortunately, when you work on a team project, you are not solely responsible for the quality ofthe code. The team as a whole is responsible for maintaining a high standard of code quality.In this section, we will look at each metric, understand how it gets calculated, and why itmatters. Code metrics inform refactoring decisions, continuous integration (CI) quality gates,and code reviews. These metrics act as a guideline to improve code and are not draconian rulesto be followed.
Maintainability	Index	(Higher	Is	better)This index is a score between 0 and 100 that represents how easy the code is to maintain. Thecloser the code is to 100, the more maintainable it is. Visual Studio even displays this metric withcolours. Green is between 20 and 100 (good maintainability), yellow for 10–19 (moderatemaintainability), and red 0–9 (low maintainability).

Figure	2-96 Go to Source CodeRight-clicking on the row of the metric allows you to navigate to the code, as seen in Figure 2-96.
How	It	Is	CalculatedThe maintainability index formula combines several factors to calculate the score. These are:The cyclomatic complexityLines of codeHalstead volume (measure of the code’s size based on operators/operands)Originally, the maintainability Index score could exceed 100 or go negative, but to improveclarity, Microsoft later reset it to a 0–100 scale. Essentially, a large method that has manybranches (high complexity) and a lot of code will have a lower Maintainability Index than asmall, simple method that does one thing, and one thing only.The formula used, as per the Microsoft documentation, to calculate the Maintainability Indexcan be seen in Listing 2-24.
MI = MAX(0, (171
      - 5.2 * ln(Halstead Volume)
      - 0.23 * Cyclomatic Complexity
      - 16.2 * ln(Lines of Code)) * 100 / 171)



Listing	2-24 The Maintainability Index CalculationThis formula will yield a number capped at 100 maximum and 0 minimum. Therefore, if yousee a red �lag on a low score, Visual Studio is indicating with a high degree of con�idence thatthere is an issue with your code.
Why	It	MattersMaintainability Index is a high-level indicator of the health of your code. A low score hereindicates that the code is hard to work with, excessively long, complex, or tricky to understand.There is even a Microsoft Analyzer rule (CA1505: Avoid unmaintainable code) that warns youwhen the Maintainability Index drops below 10.Low Maintainability Index correlates with code that often harbors bugs or technical debt.You need to keep in mind, however, that the Maintainability Index score isn’t a magic bullet. Asseen from Listing 2-24, it aggregates other metrics, so it should be interpreted in context. If afunction has a low Maintainability Index score due to a necessary, but complex algorithm, youmight accept it, provided it is well tested.
Refactoring	and	Quality	GatesWhen faced with low Maintainability Index scores, teams often decide to refactor. Codereviewers might ask if the code can be split or simpli�ied. On CI/CD pipelines, teams mightdecide to fail the build on very low Maintainability Index scores. The .NET code analysis ruleCS1505 can be enabled to break the build if the score falls below the default threshold of 10. Allthese actions ensure no “red code” gets merged into main without scrutiny. Again, bear in mindthat the Maintainability Index score aggregates other metrics. Therefore, improving the othermetric scores will naturally improve the Maintainability Index. This score is, however, animportant metric for managers and code reviewers that helps gauge overall codebasemaintainability at a glance. For the developers, it encourages a holistic approach to writingcleaner code.
Cyclomatic	Complexity	(Lower	Is	Better)Cyclomatic Complexity is a measure of the number of independent paths through a section ofcode. In simple terms, it counts the decision points, or “forks in the road” in your code’s �low.Code that has no if statements or loops (straight-line code) has a complexity of 1, i.e., it onlyhas a single path.For every if, else if, for, case, while in a switch, or conditional operator (includingternary ?:), your complexity will increase by a count of 1. In Visual Studio’s Code Metrics, thisscore is calculated for each method and displayed as an integer.You would obviously want this score to be lower, and a value of 2 or 5 indicates a simplemethod, while a count of 20 or 30 indicates an overly complex method. This makes theCyclomatic Complexity invaluable to developers because of the quantitative nature attributed toyour code. In short, the more decisions in a method, the more complex it is.
How	It	Is	CalculatedOne of the least understood metrics, Cyclomatic Complexity, is de�ined by the graph of aprogram’s control �low. The classic formula Thomas J. McCabe introduced in 1976 is M = E –
N +2P, where:E = number of edges (control �low transitions)N = number of nodes (blocks of code)P = number of connected components (typically functions or methods)



You can read the paper at https://ieeexplore.ieee.org/document/1702388 ifyou’re curious. It all boils down to this: start at 1 for a method’s basic path and then add 1 foreach decision point.It is important to note that McCabe originally de�ined cyclomatic complexity using theformula v(G) = e – n + p. This formula is more commonly seen in a generalized form of M = E –
N + 2P, which assumes each component (function/method) has a one entry and one exit point,hence the +2 instead of +p.
Why	It	MattersCyclomatic Complexity directly in�luences the testability and maintainability of your code. Thehigher the cyclomatic complexity, the more paths you need to test, which in turn raises thepossibility of untested bugs. The logic of your code is also much harder to reason about. Theseare not just inferred from the numbers, it’s backed by research. An analysis by NASA found thatmodules with both high complexity and large size tend to have the lowest reliability.The SATC has found the most effective evaluation is a combination of size and(Cyclomatic) complexity. The modules with both a high complexity and a large size tend tohave the lowest reliability. Modules with low size and high complexity are also a reliabilityrisk because they tend to be very terse code, which is dif�icult to change or modify - SoftwareAssurance Technology Center (SATC) at NASA.In other words, long, decision-heavy methods are a prime risk for defects. Interestingly, ashort but extremely complex method (lots of decisions in a few lines of code) is also problematic.The rule of thumb is that if you see a method with an unusually high cyclomatic complexity scorein relation to its peers, you need to take a closer look.
Refactor	and	Quality	GatesCyclomatic Complexity is one of the easiest metrics to act on. If code reviewers see a methodwith a high complexity score, they will most likely ask you to simplify that method. From arefactoring perspective, you could extract methods or rethink logic. Some teams includecomplexity checks into CI pipelines. Visual Studio’s built-in analyzer CA1502 (Avoid ExcessiveComplexity) speci�ies a default threshold of 25, which is quite high. This is often lowered, but byenabling CA1502, you can fail a build or issue warnings if any method exceeds a set complexitythreshold. Doing this creates a quality gate that developers need to pass before merging codeinto main.Another approach that some teams take is to use the Cyclomatic Complexity as an indicatorof methods that require extra scrutiny. If you have to introduce complex code, then you have toensure that there are extra tests or documentation to cover those methods.Some teams might also track the average complexity of the codebase over time. If this scoretends to tick up release over release, then this would be a strong indicator of growing technicaldebt. At the end of the day, keeping the Cyclomatic Complexity low or in check is essential formanageability and testability.
Depth	of	Inheritance	(Lower	Is	Generally	Better)As the name suggests, the depth of inheritance counts how deep a class is in the inheritancehierarchy. Since all classes ultimately inherit from System.Object, a class with no base class,has a depth of 1. Every additional level of inheritance increases this depth by 1.If a class called Parent inherits from a class called GrandParent, and a class called Childinherits from the Parent class, then the Child class has a depth of 3. This means that because

https://ieeexplore.ieee.org/document/1702388


of the chain of inheritance Child ➤ Parent ➤ GrandParent ➤ System.Object, the
Parent class’s depth is 2, and the GrandParent class’s depth is 1.

Figure	2-97 Depth of Inheritance IllustratedYou can see these results displayed in Figure 2-97 in the Code metrics results under theDepth of Inheritance column.
How	It	Is	CalculatedThe Depth of Inheritance is simply a count of parent classes up to the top of the hierarchy.Interfaces are excluded in this count; only base classes are counted. This is because an interfaceimplementation does not add to the inheritance chain because it acts as a contract.You can see this illustrated in the Code Metric results in Figure 2-98. The GrandParentclass implements an interface called IPerson, and when recalculating the Depth ofInheritance, it doesn’t affect the counts at all.



Figure	2-98 The Impact of an InterfaceFrom this, you can see that interfaces are ignored, while any class you create has a defaultdepth of 1, and any subsequent inherited classes increase the count by 1 each time.
Why	It	MattersDeep inheritance can be construed as a red �lag, but it’s more like a double-edged sword. On onehand, inheritance is a fundamental aspect of reuse. On the other, a very deep chain of inheritedclasses (think of 8 or 9 levels deep) often indicates fragile class designs.This is because a change in a class deep down in the inheritance stack would have a far-reaching impact on all the derived classes. If a change to the GrandParent class is made, itmight break some or all of the classes that inherit from it.It is for this reason that a lower Depth of Inheritance score is generally better, because itsuggests a simpler class hierarchy. The code analysis rule CA1501 (Avoid excessive inheritance)will �ire when the default threshold of 5 is reached. It is also important to note that this rule isnot enabled by default in .NET 9. As with other analysis rules, you can modify the thresholdvalue. A rule of thumb is to keep your inheritance level to 3 or perhaps 4 levels. Remember, forevery level you add, you are increasing the cognitive load you will experience because you couldpotentially be opening multiple class �iles to try to understand what a method actually does dueto overrides up the chain.Favor object composition over class inheritanceOn page 20 of chapter 1 in the highly in�luential 1994 book Design	 Patterns:	 Elements	 of
Reusable	 Object-Oriented	 Software, it states that favouring object composition over classinheritance is the second principle of object-oriented design.



You can grab a copy of the book on Amazon by visiting this link:
https://www.amazon.com/Design-Patterns-Elements-Reusable-Object-
Oriented/dp/0201633612Erich Gamma, Richard Helm, Ralph Johnson, and John Vlissides, commonly known as the“Gang of Four,” state that composition provides greater �lexibility than inheritance by delegatingbehavior to contained objects rather than hard-coding relationships by using inheritance.Object composition basically refers to building complex behavior by combining smaller,simpler objects as opposed to inheriting from a base class.You can see an example of this in Listing 2-25. In this code listing, we have a class called

Engine and a class called Car.
public class Engine
{
    public void Start() => Console.WriteLine("Engine is started");
}

public class Car
{
    private readonly Engine _engine = new Engine();

    public void Start() => _engine.Start(); // Delegation
}

Listing	2-25 Object CompositionHere the Car class uses an Engine class rather than inheriting from the Engine class. Thisis composition in action, because Car has an Engine, not is an Engine.
public class Car
{
    private readonly IEngine _engine;

    public Car(IEngine engine)
    {
        _engine = engine;
    }

    public void Start() => _engine.Start();
}

Listing	2-26 Dependency InjectionInterfaces are often used with composition to improve �lexibility. We have all seenDependency Injection in action. In Listing 2-26, the Car class depends on an Interface of
IEngine, allowing us to easily swop out the behavior of the engine (e.g., DieselEngine vs
ElectricEngine vs PetrolEngine) as long as they implement IEngine. It also reducestight coupling and allows us to mock IEngine for use in unit tests.
Refactoring	and	Quality	Gates

https://www.amazon.com/Design-Patterns-Elements-Reusable-Object-Oriented/dp/0201633612


You might be inviting a discussion during a code review when you introduce a class that extendsan already deep hierarchy. In fact, CI pipelines can enable the inheritance depth rule CA1501 toavoid this issue entirely.A practical approach in large systems is to limit inheritance depth. Controllers, for example,should not inherit more than 1 level. Domain entities, on the other hand, shouldn’t have a Depthof Inheritance count of more than 3. These limits are, however, up to developers to de�ine basedon what they are comfortable with.In summary, this metric ensures that you do not create a class hierarchy that is overlycomplex. Try to strike a balance by using enough inheritance to leverage polymorphism, but nottoo much that it becomes brittle.
Class	Coupling	(Lower	Is	Better)Not to be confused with Depth of Inheritance, Class Coupling measures how many unique typesa given type or method is connected to. To put it simply, it is a count of the other classes thatyour class or method uses directly.This includes parameters, return types, local variables, �ields de�ined on external types, baseclasses or Interfaces, types used in method calls, generic type arguments, and even attributetypes.Because the emphasis is on unique types, calling one class ten times still counts as one. Usingten different classes once each, however, counts as ten. The principle of coupling in softwareengineering means that tightly coupled code has many interdependencies, whereas looselycoupled code has fewer.The code metric provided by Visual Studio quanti�ies class coupling at a code level. When yousee a low Class Coupling count, it means that your class is more focused and isolated. A highnumber indicates that your code is reaching out into many corners of your codebase, making itharder to change or reuse.
How	It	Is	CalculatedVisual Studio’s code metrics inspects a class (or method) and tallies all the distinct types ittouches. The easiest way to understand this is to look at some code directly.The code in Listing 2-27 is a good example of a tightly coupled class with a high ClassCoupling count.
public class Car
{
    // IEngine = +1
    private readonly IEngine _engine;
    // ILogger<Car> = +1 and Car (used in generic) = +1
    private readonly ILogger<Car> _logger;
    // EngineDiagnostics = +1
    private readonly EngineDiagnostics _diagnostics;
    // List<Tire> = +1 and Tire = +1
    private readonly List<Tire> _tires;
    // NavigationSystem = +1
    private readonly NavigationSystem _navigation;
    // AudioSystem = +1
    private readonly AudioSystem _audio;
    // Driver = +1
    private readonly Driver _driver;
    // List<Passenger> = +1 and Passenger = +1



    private readonly List<Passenger> _passengers;
    // Garage = +1
    private readonly Garage _garage;

    public Car(
        IEngine engine,
        ILogger<Car> logger,
        EngineDiagnostics diagnostics,
        List<Tire> tires,
        NavigationSystem navigation,
        AudioSystem audio,
        Driver driver,
        List<Passenger> passengers,
        Garage garage)
    {
        _engine = engine;
        _logger = logger;
        _diagnostics = diagnostics;
        _tires = tires;
        _navigation = navigation;
        _audio = audio;
        _driver = driver;
        _passengers = passengers;
        _garage = garage;
    }

    public void Start() {
        _engine.Start();
        _logger.LogInformation("Car started");
        _diagnostics.ToString();
        _navigation.ToString();
        _audio.ToString();
        _driver.ToString();
        foreach (var p in _passengers) p.ToString();
    }

    public bool Stop()
    {
        _logger.LogInformation("Car stopped");
        return false;
    }
}

Listing	2-27 Class with High Class CouplingVisual Studio reports the Class Coupling count here as 12. The code in Listing 2-27 highlightshow Class Coupling is calculated based on the number of unique external types that the Carclass directly depends on. Visual Studio not only considers concrete �ield and parameter typesbut also constructed generic types.This means that List<Tire> and ILogger<Car> as well as their type arguments such as
Tire, Passenger, and even Car itself when used as a type parameter, are used in calculating



this metric.It is important to note that even indirect references such as a class referencing itself via ageneric type can have an impact on the coupling count.
Why	It	MattersThe Class Coupling count is a valuable metric that lets you evaluate how interconnected andbrittle a class is. Higher coupling signals the need for refactoring, especially if the class becomesdif�icult to change or test. This allows developers to make deliberate architectural choices bybeing aware of how dependencies accumulate.High Class Coupling also indicates potential violations of the Single Responsibility Principle.Implementing SOLID principles will result in favorable code metric results throughoutyour codebase.A class might be taking on too many tasks. The ideal is that a class should be focused on asingle purpose and have minimal coupling by only depending on what it truly needs. Theanalyzer rule CA1506 (Avoid excessive class coupling) will trigger a warning when the thresholdis reached.Again, this is not enabled by default in .NET 9 and the default threshold is 95 for types and 40for other symbols, which is rather conservative in my opinion. This means that when enabled,the rule will not trigger unless coupling is extreme.In practice, developers might lower the threshold to a more palatable threshold.
Refactoring	and	Quality	GatesIn code reviews or PRs, classes with high Class Coupling counts will most likely warrantrefactoring. The �ix would be to apply separation of concerns, in other words, split the class sothat each part deals with fewer collaborators. This metric also provides objectivity, because areviewer can use the Class Coupling count to request a code refactor. On CI quality gates, CA1506can be enabled to provide warnings when a class hits the threshold set by the developers.Ultimately, understanding and tracking this metric enables more targeted refactoring, resultingin code that is easier to maintain, more stable, and signi�icantly easier to test.
Lines	of	CodeLines of code refer to the size of your codebase. But there is an important distinction here. VisualStudio actually provides two related metrics, Lines	 of	 Source	 Code and Lines	 of	 Executable
Code. Lines of Source Code include blank lines and code comments, which means that thismetric counts the lines in the source �ile. Lines of Executable Code is an approximation of howmany actual execution statements it �inds.
How	It	Is	CalculatedThe calculation is not complex, but as before, it’s easier to illustrate using an example. If amethod spans from line 142 to line 148 in the source without any blank lines or code comments,Visual Studio will count 7 lines.When it comes to Lines of Executable Code, however, Visual Studio will only count thenumber of operations in the compiled code. This roughly corresponds to IL instructions. A curlybrace or a code comment doesn’t produce an IL instruction, so it’s not included in the executablelines count.Consider the images in Figure 2-99 and Figure 2-100.



Figure	2-99 The Order Constructor Line CountsAs seen in the Code Metric Results for Lines of Source Code, the count is 7. These are:1. public Order(int orderId, string customerName) 2. {  3. _orderId = orderId;  4. _customerName = customerName;  5. _items = new List<string>();  6. OrderDate = DateTime.Now;  7. }  



For the Lines of Executable Code the picture looks different. The only lines that counttowards this metric are:1. _orderId = orderId;  2. _customerName = customerName; 3. _items = new List<string>();  4. OrderDate = DateTime.Now;  If we add in a comment and a blank line, the picture looks different as seen in Figure 2-100.

Figure	2-100 Updated Order Constructor Line CountsAdding a single comment and a blank line increases the Lines of Source Code count by 2while the Lines of Executable Code stay the same.



Why	It	MattersThe simplest of all the Code Metrics provided by Visual Studio, it’s deceptively meaningful. Amethod with 200 lines of code is usually doing more than it should, and apart from it beingharder to read and follow along in logic, it’s harder to maintain. As before, this could be anindicator of code that violates the Single Responsibility Principle.Having aid that Lines of Code by itself does not tell the whole story. You need to take all theother metrics into consideration, too. For example, a method that has 300 lines and has a highCyclomatic Complexity and Class Coupling score needs to be refactored.Some sources online suggest that methods should aim for line counts under 40, but again,there is no hard and fast rule. My view is that if a method is long enough that you can’t see it allat once without scrolling, it’s probably a sign that it should be broken into smaller, more focusedparts.
Refactoring	and	Quality	GatesI would treat Lines of Code as more of an advisory metric than a strict quality gate. Some teamsmight have style guidelines that limit lines of code to a certain number, but one might not wantto fail a CI/CD build due to the Lines of Code count.Some developers might, however, track Lines or Code as new features are added to anexisting class. Growing Lines of Code counts could hint at “God objects” being created.A God object is an anti-pattern where a single class knows too much, does too much, andinteracts with too many other parts of the systemIn summary, Lines of Code give developers a quantitative handle on code size. Thesereinforce an important aspect of quality, which is keeping things small and focused. Mega-methods or bloated classes are identi�ied early on, allowing a refactor before this code becomesunmanageable.
Send	 FeedbackThe Visual Studio team takes feedback seriously. So much so that it drives much of what they doto improve Visual Studio.If you are experiencing a problem in Visual Studio, click the feedback button, as shown inFigure 2-101.

Figure	2-101 Send Feedback buttonYou can report a problem or suggest a feature right from inside Visual Studio 2022.As developers, we should take the time to report issues we encounter. It can be anythingfrom crashes to slow performance or something else unexpected.
Personalizing	 Visual	 StudioVisual Studio is one of the most popular IDEs available and does a fantastic job at increasingyour productivity. It also allows developers to personalize their experience based on their



individual work�low needs. Let’s look at some of these improvements that help you personalizeVisual Studio.
Adjust	 Line	 SpacingIn Visual Studio 2022, developers can specify the line spacing for the text editor. To increase theline spacing, on the Tools menu, click Options and select Text Editor ➤ General and look underthe Display group as seen in Figure 2-102.

Figure	2-102 Adjust Line SpacingAdmittedly, the options might not suit everyone, and I hope that Visual Studio allows customvalues to be entered here in a future release. Nevertheless, being able to space the lines of codevertically is a quality-of-life improvement for many developers that spend most of their workingday in front of Visual Studio.
Document	 Management	 CustomizationsThere are several small but welcome changes to how developers manage documents. TheDocument Tabs group under Tools ➤ Options ➤ Environment ➤ Tabs and Windows has hadseveral new options added compared to previous versions of Visual Studio. Let’s have a look atsome of these.
The	Document	Close	ButtonDevelopers now have options when deciding how to show the close button for documents. Younow have the option to add the close button to the document well, as seen in Figure 2-103.



Figure	2-103 Show Close Button in Document WellYou can also remove the close button from the individual document tabs, as seen in Figure 2-104, leaving you with a single close button. Compare the Order.cs tab in Figure 2-103 with theOrder.cs tab in Figure 2-104.

Figure	2-104 Remove Close Button on TabsYou can also opt to remove the close button from the document well as well as from thedocument tab. You can then right-click the document to close it.To quickly access these and other options for document management, you can click on thegear icon as shown in Figure 2-105.

Figure	2-105 Access Options Via the Gear Icon
Modify	the	Dirty	IndicatorDevelopers can now choose how they would like to display dirty tabs. The default is an asteriskto the right of the �ile name, as seen in Figure 2-106 on the Order.cs tab.

Figure	2-106 The Default Dirty IndicatorYou can also change this indicator to be a dot, as shown in Figure 2-107.

Figure	2-107 The Dot Dirty Indicator



The dot does make the tab slightly bigger, but it is a more explicit indicator that thedocument has unsaved changes. What is nice, however, is that if you have set the close button tobe visible on document tabs, the dot will change into a close button when you hover over it.
Show	Invisible	Tabs	in	Italics	in	the	Tab	Drop-DownThe ability to display hidden tabs in italics is something you might not know that you want untilyou see it in action. The tab drop-down displays all your open tabs, as seen in Figure 2-108.

Figure	2-108 Invisible Tabs Not in ItalicsThe trick is knowing which documents are currently visible and which are not.With this option set to show hidden documents in italics, the hidden tabs are immediatelydiscernable, as seen in Figure 2-109. This is especially helpful when looking at that Program.cs�ile.

Figure	2-109 Invisible Tabs Displayed in Italics
Colorize	Document	TabsI’m sure the images displayed here might not be in color if you read the print book. Showing thecolor changes on tabs will, therefore, not make sense. Instead, I will show you where you canchange this option.As seen in Figure 2-110, you can colorize document tabs by Project, File Extension, RegularExpression, or choose no coloring, which is the default. Playing around with this option allowsyou to �ind a setting that is convenient for you.



Figure	2-110 Colorizing Document TabsIf you don’t like the default color for the tab, right-click the tab and select the Set Tab Coloroption to choose a color more to your liking.Being able to colorize document tabs helps developers cut through the noise when workingin multiple tabs, especially on large projects.
Tab	PlacementThe ability to choose the tab placement is something many of you might welcome.As seen in Figure 2-111, the tabs can be displayed on the left or, as in Figure 2-112, on theright.



Figure	2-111 Document Tabs on the Left

Figure	2-112 Document Tabs on the RightThe left and right placement of tabs also highlights the color options better.More �lexibility is given to developers by allowing them to choose the minimum andmaximum tab width, as seen in Figure 2-113.



Figure	2-113 Additional Document Tab Options
Visual	 Studio	 ThemesVisual Studio provides a �lexible theming system that allows developers to personalize the IDE’slook and feel. The change can be subtle or dramatic, changing editor backgrounds and syntaxcolors, tool windows, and dialogs. Let’s have a look at the built-in themes available in VisualStudio 2022 �irst, and how to switch between them.
Built-in	ThemesVisual Studio comes with a few built-in color themes that cater to different preferences. Asshown in Figure 2-114, you can access several theme options by going to Tools ➤ Options ➤Environment ➤ General and selecting the Color Theme dropdown.



Figure	2-114 Theme SelectorOut of the box, Visual Studio uses the familiar Blue theme, but you can change this to yourliking. Here, you can choose a sleek Dark theme (popular with many developers), a bright Lighttheme, a Blue (Extra Contrast) theme, or an option called Use system setting, which matchesVisual Studio’s theme to your Windows theme preference.Why do developers prefer dark themes? Because light attracts bugs.After changing your theme, Visual Studio will remember your selection and use that themethe next time you open your IDE. It will also synchronize them across all Visual Studioenvironments, depending on your account setup. With Visual Studio version 17.12, any customfont settings you’ve made will be preserved when switching themes, which is a welcome qualityof life enhancement.
Customizing	Colors	and	FontsThe built-in themes provide a complete color scheme, but you might want to make some �ine-tuned changes to aspects of the editor or UI to better suit your preferences. To accommodatethis, Visual Studio allows extensive customization of fonts and colors by going to Tools ➤Options ➤ Environment ➤ Fonts and Colors, as shown in Figure 2-115.



Figure	2-115 Customizing Fonts and ColorsHere you can tweak the appearance of nearly every UI element or code element to yourliking. At the top of the Options dialog for Fonts and Colors, you will see a dropdown named
Show	settings	for. This allows you to choose the scope of what you are customizing.As you can imagine, tweaking settings here might lead you down a rabbit hole and beforelong, you might want to undo everything you’ve changed. This can be accomplished by clickingon the Use Defaults button.It is also worth mentioning that should you wish to export your settings, you can do so byclicking on Tools ➤ Import and Export Settings from the Visual Studio menu, as illustrated inFigure 2-116.



Figure	2-116 Export Settings WizardThis allows you to save your settings to a �ile for import elsewhere. While this might not benecessary in most cases, it’s still a good tip for exporting and backing up a �inely tunedenvironment.
Customizing	Windows	LayoutsWhile the theme mainly affects colors and styling, the overall feel of your IDE will depend onhow your windows are laid out. Visual Studio allows developers to customize and save windowlayouts to suit different work�lows. You might like a minimal layout when writing code,consisting of only the editor and the Solution Explorer. When debugging, however, you mightwant to see additional windows such as the Watch window, Autos, etc.



Figure	2-117 Save Window LayoutYou can rearrange window layouts by dragging that window around and docking it to adifferent side of the IDE (or you might want it undocked and �loating). You can then save yourlayout by clicking on the menu item Window ➤ Save Window Layout.As seen in Figure 2-117, you can give your layout a name and save it. You can save severallayouts and then switch between them by going to Window ➤ Apply Window Layout. You canalso manage your saved layouts from the Window menu, as well as reset your window layout.Window layouts are beyond the scope of Visual Studio themes, but it remains a verypowerful (and underutilized) part of personalizing Visual Studio.
Extensions	and	Additional	ThemesBuilt-in themes are only the beginning. Visual Studio allows you to install themes and themepacks from the Extension Manager, as seen in Figure 2-118. The Visual Studio Theme Pack byMicrosoft DevLabs, for example, is a popular extension providing several themes that would suiteven the most particular theme connoisseur. You can access the Extension Manager from theExtensions menu and then click on Manage Extensions.



Figure	2-118 Visual Studio Theme PackFor those of you that like to have more control over your Visual Studio theme, or if you needto align Visual Studio with speci�ic company branding, you can do this by using the Visual StudioColor Theme Designer 2022. You can download it from the following URL
https://marketplace.visualstudio.com/items?
itemName=idex.colorthemedesigner2022This allows you to design your own theme with a live preview until you have a theme thatyou are happy with. The �inal product will be a Visual Studio extension that puts your themealongside the default themes under Tools ➤ Options.Microsoft has also teamed up with community theme authors to test a tool that converts VSCode themes to be compatible with Visual Studio 2022. You can access the Theme Converterfrom the following GitHub repo:

https://github.com/microsoft/theme-converter-for-vs.To see which themes are available, follow this link and style Visual Studio your way:
https://devblogs.microsoft.com/visualstudio/custom-themes/.
The	 New	 .SLNX	 Solution	 FormatFor years, developers have relied on the traditional .sln solution �ile to organize projects. Forthose of you that have ever had to merge a solution �ile, know the frustration of sifting throughits cryptic GUIDs. Recently, though, the Visual Studio solution team began previewing an XML-based solution �ile format called SLNX. As of .NET SDK 9.0.200, the dotnet CLI supportsbuilding and interacting with these �iles just like it does with traditional solution �iles.
What	 Is	 an	 .SLNX	 File

https://marketplace.visualstudio.com/items%253FitemName%253Didex.colorthemedesigner2022
https://github.com/microsoft/theme-converter-for-vs
https://devblogs.microsoft.com/visualstudio/custom-themes/


In simple terms, the SLNX �ile is a simpli�ied solution �ile format using XML instead of the oldplain-text format. It serves the same purpose as the SLN �ile, which is de�ining which projects arepart of your solution and how the solution is con�igured. Using .slnx �iles, however, streamlinesthe contents and structure, making solution �iles more human-readable and easier to mergeunder source control. The key differences between .sln and .slnx �iles are as follows:
Format	and	ReadabilityLooking at an .sln �ile, you will notice that it is a plaintext �ile �illed with GUIDs, repeatedcon�iguration mappings, and nested sections. Compare that to a .slnx �ile, you will see that it isXML-based, which is a widely understood format. The structure, therefore, is much morereadable. This allows developers to easily parse and even hand-edit solution �iles if required.
Content	SimplicityThe traditional .sln �ile contained a lot of redundant information. Duplicate project GUIDs andrepeated con�ig mappings, with boilerplate that grows as your solution has new projects addedto it. The .slnx �ile does away with all that. No more scrolling past lines and lines of GUIDs to seewhich projects are in your solution. This minimalistic approach to solution �iles means that evenlarge solutions result in relatively small, clean solution �iles.
Comparing	SLN	to	SLNXCompare the .sln solution �ile in Listing 2-28 with the much simpler solution �ile in Listing 2-29.
Microsoft Visual Studio Solution File, Format Version 12.00
# Visual Studio Version 17
VisualStudioVersion = 17.14.36203.30 d17.14
MinimumVisualStudioVersion = 10.0.40219.1
Project("{FAE04EC0-301F-11D3-BF4B-00C04F79EFBC}") =
"HelloAspire.AppHost",
"HelloAspire.AppHost\HelloAspire.AppHost.csproj", "{A2009DE2-2EE5-
4C9D-9777-1BA5B818F39A}"
EndProject
Project("{FAE04EC0-301F-11D3-BF4B-00C04F79EFBC}") =
"HelloAspire.ServiceDefaults",
"HelloAspire.ServiceDefaults\HelloAspire.ServiceDefaults.csproj", "
{290FEB0D-8BB8-B786-4336-448974D25042}"
EndProject
Project("{FAE04EC0-301F-11D3-BF4B-00C04F79EFBC}") =
"HelloAspire.ApiService",
"HelloAspire.ApiService\HelloAspire.ApiService.csproj", "{779455C5-
65EE-8270-AB64-E9D4CEE5DCC8}"
EndProject
Project("{FAE04EC0-301F-11D3-BF4B-00C04F79EFBC}") =
"HelloAspire.Web", "HelloAspire.Web\HelloAspire.Web.csproj", "
{891CCE41-52AC-0DB9-AD31-E17D318194CC}"
EndProject
Global
    GlobalSection(SolutionConfigurationPlatforms) = preSolution
        Debug|Any CPU = Debug|Any CPU
        Release|Any CPU = Release|Any CPU
    EndGlobalSection



    GlobalSection(ProjectConfigurationPlatforms) = postSolution
        {A2009DE2-2EE5-4C9D-9777-1BA5B818F39A}.Debug|Any
CPU.ActiveCfg = Debug|Any CPU
        {A2009DE2-2EE5-4C9D-9777-1BA5B818F39A}.Debug|Any CPU.Build.0
= Debug|Any CPU
        {A2009DE2-2EE5-4C9D-9777-1BA5B818F39A}.Release|Any

    EndGlobalSection
    GlobalSection(SolutionProperties) = preSolution
        HideSolutionNode = FALSE
    EndGlobalSection
    GlobalSection(ExtensibilityGlobals) = postSolution
        SolutionGuid = {EA27AE4D-36D4-4D86-B024-D0CAD2B159FD}
    EndGlobalSection
EndGlobal
Listing	2-28 An Example of an SLN FileI actually deleted a whole lot of lines from the .sln �ile in Listing 2-28. Otherwise it wouldhave spanned a whole additional page in this book.
<Solution>
  <Project
Path="HelloAspire.ApiService/HelloAspire.ApiService.csproj" />
  <Project Path="HelloAspire.AppHost/HelloAspire.AppHost.csproj" />
  <Project
Path="HelloAspire.ServiceDefaults/HelloAspire.ServiceDefaults.csproj"
/>
  <Project Path="HelloAspire.Web/HelloAspire.Web.csproj" />
</Solution>

Listing	2-29 The Same Solution Saved as SLNXWhen I save the solution as an .slnx �ile, the difference is dramatic as seen in Listing 2-29.
Why	 Introduce.SLNX	 FilesNow that we have an idea what an .slnx �ile looks like, let’s discuss why this new solution �ileformat was introduced. The change is due to longstanding pain points when it comes tomanaging solution �iles.
Frequent	Merge	Con�lictsWhen working in a team, .sln �iles were notorious sources for merge con�licts. If two developerson the team so much as touch the solution by adding a new project or changing somecon�iguration, the .sln �ile would con�lict in complex ways.This often led to corrupted solution �iles due to a bad merge or time wasted untangling themess. As evidenced in Listing 2-29, the .slnx �ile tries to (successfully) eliminate that headacheby simplifying the structure to a straightforward list of projects. Adding a project now means theaddition of a new line of XML, something far less likely to cause con�lict headaches whenmerging.
Source	Control	Friendliness



Apart from causing fewer con�licts, reviewing a cleaner diff during code reviews or during amerge is a boon for code reviewers. The .slnx �ile is easier to read and understand exactly whatwas changed in the solution at a glance.This makes for a more pleasant experience when reviewing PRs involving solution changes.The .slnx �ile preserves comments and formatting which means that if your team likes toannotate the solution �ile or organize it in a speci�ic way, these details will be saved andpreserved between commits.
Reducing	File	Bloat	and	DuplicationTraditionally, the .sln �ile started off small but grew rapidly as more projects were added to thesolution. Every project appeared with a GUID in multiple places and every con�iguration(Debug/Release etc.) is repeated for each project. In large solutions with many projects, the .slnbecomes unwieldy.The .slnx �ile resolves this problem with sensible defaults and minimal metadata. As a resultof this minimalist approach, the .slnx �iles stays lean and clean. This minimalistic footprint alsoleads to faster load times.
Manual	Edits	and	ToolingManually editing a .sln �ile that were essentially only readable by Visual Studio, was risky. Thenew .slnx by contrast, uses XML which is something all developers know. Using XML not onlymakes it much easier for developers to edit but also for other tools to parse or generate.The Visual Studio team even provides an open-source library called vs-
solutionpersistence that provides a uni�ied object model and serializers for working withtraditional .sln and the new .slnx formats. This allows 3rd-party tools to read, manipulate, andwrite solution �iles programmatically. You can �ind the GitHub repo here:
https://github.com/microsoft/vs-solutionpersistenceWhat this essentially does is open the door for better tooling and automation aroundsolution �iles.
Alignment	with	Project	Files	and	MSBuildOpening up a modern .csproj �ile you will notice that it too, is XML. By adopting XML for solution�iles, aligns the solution �ile format with the project �ile format. The change is not for show, itmeans that the solution can integrate better with MSBuild. In fact, MSBuild was updated tonatively support .slnx �iles allowing for seamless building and project manipulation viacommand-line tools.
Creating	 and	 Using	 .SLNX	 Solution	 FilesLet’s see how developers can work with .slnx �iles in practice? If you are using Visual Studio2022 17.14 or later, support for .slnx is built into Visual Studio and no longer depends ontoggling an experimental �lag in Preview Features (Figure 2-119). In earlier versions of VisualStudio (version 17.10 through 17.13) this feature was feature-�lagged and had to be opted in toby going to Tools ➤ Options ➤ Environment ➤ Preview Features and checking Use	 Solution
File	 Persistence	 Model.

https://github.com/microsoft/vs-solutionpersistence


Figure	2-119 Enabling Preview FeaturesOnce enabled (or with newer builds), Visual Studio allows developers to create and open.slnx �iles. There are primarily two ways to convert an existing .sln �ile to a .slnx �ile.
Using	Visual	StudioThe �irst is via Visual Studio itself. With your solution selected in the Solution Explorer, click on
File	➤ 	 Save	 [YourProject.sln]	 As, as seen in Figure 2-120.



Figure	2-120 Saving a Solution AsThis will open up the familiar Save	 File	 As dialog, as seen in Figure 2-121. Here you will beable to change the Save	 as	 type from .sln to .slnx. You will now have two solution �iles, the .slnand the new .slnx in your solution folder.Visual Studio might not yet be registered as the default app for .slnx �iles in Windows.Instead, use File ➤ Open ➤ Project from within Visual Studio and select the .slnx �ile.Saving your solution as a .slnx �ile will not remove your old .sln �ile.



Figure	2-121 Selecting Save As Type
Via	the	.NET	CLIIf you prefer to use the command line, the .NET CLI has you covered. The dotnet command-linetool in SDK 9.0.200 and above includes a migrate command. Navigate to your solution folder in aterminal and run: dotnet sln YourSolution.sln migrateThis will generate the .slnx �ile alongside the original. In fact, the dotnet sln commandallows you to add, list, remove, or migrate projects in a solution �ile. Type dotnet sln
-? To see available options.



Figure	2-122 Always Open With Visual StudioAs always, to open your .slnx in Visual Studio, right-click the �ile and select Open	 With fromthe context menu and select Microsoft	 Visual	 Studio	 2022. You will then see the dialogdisplayed as seen in Figure 2-122. Select to always open the .slnx �ile in Visual Studio 2022, andyou’ll be all set.You can now open solutions in Visual Studio using your .slnx �ile and use Visual Studio as younormally would.
Final	 ConsiderationsIt is important to know that only Visual Studio 2022 (with the appropriate updates) knowsabout .slnx �iles. If a team member is still using Visual Studio 2019 or earlier, they will not beable to open an .slnx solution.



Secondly, do not keep both the .sln and .slnx �iles in the repo. It might be tempting tomaintain both versions of the solution �ile in the repo, but Microsoft recommends against it.Keeping both �iles around invites confusion and keeping these �iles in sync manually will beerror-prone and defeats the purpose of simplifying the solution �ile in the �irst place. If you haveto keep both �iles around, consider using a tool like dotnet slnsync to sync both the old andnew solution �ile formats. You can �ind this tool here:
https://github.com/edvilme/dotnet-sln-syncIn real-world development scenarios, adopting the new .slnx format should relieve yoursource control work�low considerably. Moving from the old solution �ile to something as clean asthe new format is a no-brainer for a �ile that changes often. While it isn’t �lashy like a newlanguage feature, it will save teams hours of time and make collaboration smoother.
SummaryIn this chapter, we explored several practical aspects of working with Visual Studio 2022. Westarted off looking at the various project templates available, such as Console Apps, WindowsForms, Worker Services, and different web application types.We also took a look at .NET Aspire, a modern approach to orchestrating distributedapplications. We covered how to create a new Aspire application, how each project in an Aspiresolution works, and how Aspire simpli�ies service orchestration and con�iguration.Moving to productivity features, we then had a look at NuGet, npm, and creating codesnippets. Next, we covered how bookmarks and code shortcuts streamline code navigation, andhow Server Explorer allows developers to manage databases directly inside Visual Studio.Finally, we discussed the Visual Studio menu system, highlighting lesser-known tools such asC# Interactive and Code Metric Results that boost your day-to-day ef�iciency. These topics givedevelopers a solid foundation for working more effectively with Visual Studio 2022.

https://github.com/edvilme/dotnet-sln-sync
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3.	 Debugging	 Your	 CodeDirk Strauss1  Uitenhage, South Africa 
Debugging code is probably one of the most essential tasks that adeveloper performs. Being able to run your application and pause theexecution of code midway is a lifesaver. But there is a lot more todebugging than just setting breakpoints and viewing results.In this chapter, we will be discussing the options available to you asa developer that needs to effectively debug their code. We will belooking atUsing breakpoints, conditional breakpoints, breakpoint actions, andlabels, and exporting breakpointsUsing data tipsThe DebuggerDisplay attributeDiagnostic Tools and Immediate WindowAttaching to a running processRemote debuggingVisual Studio provides all the tools you need to effectively debugproblematic code. Without being able to debug your code, it will bevirtually impossible to resolve any issues you might be experiencing.Not being able to effectively debug your application (not knowinghow to effectively use the tools you have) is just as bad as not havingthe tools to debug with in the �irst place.
Debugging	 Toolbar	 Location

https://doi.org/10.1007/979-8-8688-2114-1_3


Visual Studio allows developers to set the location of any toolbar. Youcan, therefore, set the location of the debugging toolbar by right-clicking on any toolbar under the menu in Visual Studio and choosingCustomize from the context menu (Figure 3-1).





Figure	3-1 Customize the Toolbar LocationThis will display the Customize dialog window where you can selectthe Debug toolbar and choose the Location as seen in Figure 3-2.

Figure	3-2 Choosing the Debug Toolbar LocationThe next time you start a debug session, you will see the Debugtoolbar pinned to the left of your Visual Studio window (Figure 3-3).



Figure	3-3 Debug Toolbar Located on the LeftSome developers might �ind this more suited to their work�low, asopposed to keeping the Debug Toolbar at the top.
Working	 with	 BreakpointsIf you’re already familiar with debugging in Visual Studio, much of thischapter may feel routine. However, you may still discover features andtechniques you haven’t used before, so I invite you to read on.If you are new to Visual Studio, debugging means running yourapplication with the debugger attached. Debugging allows you to stepthrough the code and view the values stored in variables. Moreimportantly, you can see how those values change.
Setting	 a	 Breakpoint



The most basic task of debugging is setting a breakpoint. Breakpointsmark the lines of code that you want Visual Studio to pause at, allowingyou to take a closer look at what the code is doing at that particularpoint in time. To place a breakpoint in code, click the margin to the leftof the line of code you want to inspect, as shown in Figure 3-4.

Figure	3-4 Setting a BreakpointPress F5 or click Debug ➤ Start Debugging to run your application.You can also just click the Start button as shown in Figure 3-5.

Figure	3-5 The Start Debug ButtonAfter you start debugging, and a breakpoint is hit, the debug toolbarin Visual Studio changes as seen in Figure 3-6.



Figure	3-6 Debug Toolbar When Breakpoint HitThe Start button now changes and displays Continue. Remember, atthis point, your code execution is paused in Visual Studio at thebreakpoint you set earlier.In order to step through your code, you can click the step buttons asdisplayed in Figure 3-7.

Figure	3-7 Step ButtonsFrom left to right, these buttons are as follows:Show Next Statement (Alt+Num*)Step Into (F11)Step Over (F10)Step Out (Shift+F11)When you step into a method, you jump to the point in the editorwhere that method’s code is. If you do not want to step into the method,you can click the Step Over button or press F10 to carry on with thenext line of code. If you are inside a method and want to step out andcontinue debugging the calling code, click the Step Out button or pressShift+F11.
Step	into	Speci�icWhen debugging your code, Step Into (F11) lands you inside a methodthat you did not intend to inspect. This is especially frustrating whenyou have to deal with nested calls. This is where Step into Speci�ic canhelp. Instead of leaving you up to the mercy of the call order, this



feature gives you the �lexibility to choose the exact method you want tostep into from a context menu.When you hit a breakpoint, and reach a nested call, as shown inFigure 3-8, right-click on the line of code to bring up the context menu.There, you will see an option to Step into Speci�ic with the nestedmethods listed for you to choose from.

Figure	3-8 Step into Speci�icChoose the method you are interested in and Visual Studio will takeyou directly to that method. This is useful when dealing with largecodebases and noisy method calls.
Run	to	ClickA quiet productivity booster that hides in plain sight is Run to Click.When you are debugging, and hover your mouse over a line of code, youwill see a green glyph appear in the left margin as shown in Figure 3-9.



Figure	3-9 Run to ClickClicking on this glyph will let Visual Studio run everything up to thatline, without you needing to set any additional breakpoints. Run toClick minimizes interruptions and allows developers to jump straight tothe line of code they care about without having to step through setupcode or lengthy iterations.
Run	to	CursorIn a similar fashion to Run to Click, Run to Cursor allows you to executecode up to a speci�ic point without setting a breakpoint. To use it, putyour cursor on the line of code where you want execution to pause andright-click to bring up the context menu. Then select Run to Cursor asseen in Figure 3-10. You can also just hit Ctrl+F10.



Figure	3-10 Run to CursorVisual Studio will run the code up to that line, providing that thecode is reachable from the current execution path. While Run to Clicklends itself well to mouse users, Run to Cursor is perfect for keyboard-driven work�lows.
Force	Run	to	CursorWhere Run to Cursor is a gentle approach to debugging, Force Run toCursor acts more like a bulldozer. Taking the Run to Cursor one step



further, Force Run to Cursor ensures that you skip over method callsand breakpoints to get you to your code.To use it, right-click the line of code that you want to force-run toand choose Force Run to Cursor as seen in Figure 3-10 (Just below Runto Cursor). Visual Studio will now ignore breakpoints and go directly toyour code. You can also hold down the Shift button, and the Run to Clickglyph we saw earlier, will change to a double-arrow glyph. This alsoallows you to Force Run to Cursor.
VisualizersDebugging your code is more than just stopping the code execution at aparticular line. It’s about understanding the data �lowing through yourapplication. Visual Studio provides a set of incredibly helpful toolscalled visualizers. These allow you to inspect complex objects such ascollections, JSON, XML, and even strings in a more readable formatduring a debug session.Visualizers are accessed directly from a DataTip, Watch Window,QuickWatch dialog box, or Autos window by clicking on a smallmagnifying glass next to a variable. In fact, a visualizer is alwaysrepresented by a magnifying glass icon. This will launch theappropriate visualizer based on your selection.
IEnumerable	VisualizerThe IEnumerable Visualizer (Figure 3-11) assists developers whendebugging collections that might be challenging to decipher in a rawobject view.

Figure	3-11 Opening the IEnumerable Visualizer



Clicking on the View button, you will see the contents presented in atabular grid (Figure 3-12). This allows you to scroll through thecollection and inspect each one individually.

Figure	3-12 IEnumerable VisualizerThe IEnumerable Visualizer also allows you to �ilter records andexport them to CSV or Excel. You can even right-click on a row and copythe data to the clipboard.
JSON	VisualizerWhen dealing with APIs, for example, Visual Studio’s JSON Visualizer(Figure 3-13) allows you to format the raw string into JSON.

Figure	3-13 Opening the JSON VisualizerThe JSON Visualizer makes the wall of JSON text in�initely easier toread and understand, as shown in Figure 3-14.



Figure	3-14 JSON VisualizerYou have similar visualizers for Text, XML, and HTML, as seen inFigure 3-13The JSON Visualizer gives you a collapsible tree view with properindentation.When working with a REST API, the JSON Visualizer becomes anessential tool in your debugging toolkit.
Custom	Visualizers



Apart from the standard visualizers that Visual Studio provides, morevisualizers might be available for download from Microsoft. You caneven create your own visualizer if you have a unique requirement notcatered for in Visual Studio. For a walkthrough on accomplishing this,use the following URL as a starting point:
https://learn.microsoft.com/en-
us/visualstudio/debugger/create-custom-
visualizers-of-data

Conditional	 Breakpoints	 and	 ActionsSometimes, you need to use a condition to catch a bug. Let’s say thatyou are in a for loop, and the bug seems to be data-related. Theerroneous data only seems to enter the loop after several hundrediterations. If you set a regular breakpoint, you will be pressing F10 untilyour keyboard stops working.This is a perfect use case for using conditional breakpoints. You cannow tell the debugger to break when a speci�ic condition is true. To seta conditional breakpoint, right-click the breakpoint and clickConditions from the context menu, as seen in Figure 3-15.

Figure	3-15 Breakpoint Context Menu

https://learn.microsoft.com/en-us/visualstudio/debugger/create-custom-visualizers-of-data


You can now select a conditional expression and select to break ifthis condition is true or when changed, as seen in Figure 3-16.

Figure	3-16 Conditional ExpressionYou can also select to break when the Hit Count is equal to, amultiple of, or greater than or equal to a value you set, as shown inFigure 3-17.

Figure	3-17 Hit Count Condition



The last condition you can set on a conditional breakpoint is a Filter,as seen in Figure 3-18.

Figure	3-18 Filter ConditionTake note of the Actions checkbox as seen in the Breakpoint Settingsabove (Figure 3-18). This is the same Actions menu seen on the contextmenu in Figure 3-15. Here, you can add an expression to log to theOutput Window using speci�ic keywords that are accessed using the $symbol.The special keywords are as follows:$ADDRESS – Current instruction$CALLER – Previous function name$CALLSTACK – Call stack$FILEPOS – The current �ile and line position$FUNCTION – Current function name$PID – Process ID$PNAME – Process name$TICK – Milliseconds elapsed since the system was started, up to 49.7days$TID – Thread ID$TNAME – Thread name



You can now use these special keywords to write an entry to theOutput Window. You can include the value of a variable by placing itbetween curly braces (think of interpolated strings). Listing 3-1 showsan example of an expression that uses the $FUNCTION keyword.
Product count = {products.Count} in $FUNCTION

Listing	3-1 Action ExpressionPlacing this breakpoint action in your code will cause Visual Studioto change the breakpoint indicator from a circle to a diamond, as shownin Figure 3-19.

Figure	3-19 Breakpoint ActionThis is also known as a TracepointWhen you run your application, you will see the expression outputin the Output Window displayed in Figure 3-20.



Figure	3-20 Action Expression in Output WindowThis is great for debugging because if you don’t select a condition,the Action will be displayed in the Output Window without hitting thebreakpoint and pausing the code. The breakpoint action can also beedited by clicking on the expression, as seen in Figure 3-21.

Figure	3-21 Edit the Breakpoint ActionIf you want to pause the code execution, then you need to uncheckthe Continue code execution checkbox.
Temporary	 BreakpointsThere might be times when you only want a breakpoint hit once andnever again. A scenario could exist where you need to check the changeof a variable in several places, but once this is con�irmed to be working,



you do not need to check the variable again. Instead of having to addseveral breakpoints and having to remove them again afterward, VisualStudio 2022 allows you to set a temporary breakpoint. Instead ofclicking in the margin as you normally would do to place a breakpoint,right-click in the margin to see the breakpoint menu. Then select InsertTemporary Breakpoint as seen in Figure 3-22.

Figure	3-22 Insert Temporary BreakpointYou can also hold down Shift+Alt+F9, T to do the same thing (goodluck with that muscle memory).
Dependent	 BreakpointsIf you look at Figure 3-22 again, you will notice an option to insert adependent breakpoint. A dependent breakpoint is a fantastic additionto Visual Studio because it is a breakpoint that will only pause thedebugger when another breakpoint is hit on which it has been markedas a dependent.As seen in Figure 3-23, you can click the drop-down menu, whichwill show you a list of other breakpoints to choose from. After selectinga dependent breakpoint, the debugger will only pause when thebreakpoint you selected from the drop-down is hit.



Figure	3-23 Insert a Dependent Breakpoint
Dragging	 BreakpointsYou can also drag breakpoints to a different line of code. To do this, clickand hold on the breakpoint and start dragging your mouse. You cannow move it to another line.
Manage	 Breakpoints	 with	 LabelsAs you continue debugging your application, you will be setting manybreakpoints throughout the code. Different developers have differentways of debugging. Personally, I add and remove breakpoints asneeded, but some developers might end up with several breakpoints(or breakpoints across multiple �iles) as seen in Figure 3-24.



Figure	3-24 Multiple Breakpoints SetThis is where the Breakpoints window comes in handy. Think of itas mission control for managing complex debugging sessions. This isespecially helpful in large solutions where you might have manybreakpoints set in various code �iles throughout your solution.The Breakpoints window allows developers to manage thebreakpoints that they have set by allowing them to search, sort, �ilter,enable, disable, and delete breakpoints. The Breakpoints window alsoallows developers to specify conditional breakpoints and actions.To open the Breakpoints window, click the Debug menu, Windows,and then Breakpoints. You can also press Ctrl+D, Ctrl+B. TheBreakpoints window will now be displayed as seen in Figure 3-25.



Figure	3-25 Breakpoints WindowCompare the line numbers of the breakpoints listed in Figure 3-25with the breakpoints displayed in Figure 3-24. You will see that thisaccurately re�lects the breakpoints displayed in the Breakpointswindow.The only problem with this window is that it doesn’t help you muchin the way of managing your breakpoints. At the moment, the onlyinformation displayed in the Breakpoints window is the class name andthe line number.This is where breakpoint labels are very bene�icial. To set abreakpoint label, right-click a breakpoint and click Edit labels from thecontext menu, as shown in Figure 3-26.



Figure	3-26 Edit Breakpoint LabelsThe Edit breakpoint labels window is then displayed (Figure 3-27).



Figure	3-27 Add a New Breakpoint LabelYou can type in a new label or choose from any of the existing labelsavailable. If you switch back to the Breakpoints window, you will seethat the labels you entered in the Edit Breakpoint Labels window, aredisplayed (Figure 3-28), making the identi�ication and management ofyour breakpoints much easier.



Figure	3-28 Breakpoints Window with Labels SetYou are in a better position with the breakpoint labels set to manageyour breakpoints more effectively. This is because you can immediatelyidentify the purpose of a breakpoint based on the label you’ve chosen.
Exporting	 BreakpointsIf you would like to save the current state and location of thebreakpoints you have set, Visual Studio allows you to export and importbreakpoints. This will create an XML �ile with the exported breakpointsthat you can then share with a colleague.I think that the use of Visual Studio Live Share negates the needto share breakpoints with a colleague just for the sake of aiding indebugging an application. There are, however, other situations I cansee exporting breakpoints as being bene�icial.To export your breakpoints, you can right-click a breakpoint andclick Export from the context menu, or you can click the export buttonin the Breakpoints window. You can also import breakpoints from theBreakpoints window by clicking the export or import button ashighlighted in Figure 3-29.



Figure	3-29 Import or Export BreakpointsI’m not too convinced that the icons used on the import and exportbuttons are indicative of importing and exporting something, but that isjust my personal opinion.
Viewing	 Inline	 Return	 ValuesVisual Studio has introduced Inline Return Values. You no longer needto create temporary variables to inspect return values from functions.As shown in Figure 3-30, a return value is displayed.

Figure	3-30 Inline Return ValueThis quality of life improvement allows developers to remainfocused on coding without having to go through extra steps of addingtemporary variables and removing them afterwards, just to inspect areturn value.As you hit a breakpoint and step through your code, Visual Studioautomatically displays the return value next to the closing brace of themethod. This immediate feedback makes spotting issues easier,allowing you to verify that your functions are returning the expectedresults.
Using	 DataTipsDataTips in Visual Studio allow developers to view information aboutvariables during a debug session. You can only view DataTips in break



mode, and DataTips only work with variables that are currently inscope.This means that before you can see a DataTip, you are going to haveto debug your code. Place a breakpoint somewhere in your code andstart debugging. When you hit the breakpoint that you have set, you canhover your mouse cursor over a variable. The DataTip now appears,showing the name of the variable and the value it currently holds. Youcan also pin this DataTip as shown in Figure 3-31.

Figure	3-31 Debugger DataTipWhen you pin a DataTip, a pin will appear in the gutter next to theline number. You can now move this DataTip around to anotherposition on the screen. If you look below the pin icon on the DataTip,you will see a “double down arrow” icon. If you click this, you can add acomment to your DataTip as illustrated in Figure 3-32.

Figure	3-32 DataTip CommentDataTips also allow you to edit the value of the variable, as long asthe value isn’t read-only. To do this, simply select the value in the



DataTip and enter a new value. Then press the Enter key to save thenew value.
Using	 the	 Watch	 WindowThe Watch window allows us to keep track of the value of one or morevariables and also allows us to see how these variable values change asone steps through the code.You can easily add a variable to the Watch window by right-clickingthe variable and selecting Add Watch from the context menu. Doing thiswith the products variable in the previous section will add it to theWatch 1 window as illustrated in Figure 3-33.

Figure	3-33 The Watch 1 WindowHere, you can open the visualizer by clicking the magnifying glassicon or expanding the products variable to view the other propertiesof the object. I use the Watch window often as it is a convenient way tokeep track of several variables at once.
The	 DebuggerDisplay	 AttributeIn the previous section, we discussed how to add a variable to theWatch window in Visual Studio. We saw that we can view the value of avariable or variables easily from this single window. Looking back atthe products variable in Figure 3-33, each item in the list displays as



DataEntities.Product. You need to expand each list item to viewthe property values.This quickly becomes untenable when dealing with a list ofhundreds of items and you are looking for a speci�ic value.This is where the DebuggerDisplay attribute comes into play.Because the products variable is a List<Product> we can modifythe Product class as seen in Listing 3-2.Ensure that you add the statement using System.Diagnostics toyour code �ile.By adding the DebuggerDisplay attribute you can control how aclass or �ield is displayed in the Watch window.
[DebuggerDisplay("Product {Id} - {Name}")]
public sealed class Product
{
    [JsonPropertyName("id")]
    public int Id { get; set; }

    [JsonPropertyName("name")]
    public string? Name { get; set; }

    [JsonPropertyName("description")]
    public string? Description { get; set; }

    [JsonPropertyName("price")]
    public decimal Price { get; set; }

    [JsonPropertyName("imageUrl")]
    public string? ImageUrl { get; set; }
}

Listing	3-2 Modi�ied Subject ClassStart debugging your code again and have a look at your Watchwindow after adding the DebuggerDisplay attribute. Your itemvalues are more readable and easily identi�iable, as seen in Figure 3-34.



Figure	3-34 The lstSubjects Variable Values with DebuggerDisplayYou can also go a bit further by adding a format speci�ier to theattribute. The use of “nq” in the DebuggerDisplay attribute willremove the quotes when the �inal value is displayed. The “nq” means“no quotes.” To do this, modify the attribute as seen in Figure 3-35.

Figure	3-35 Specifying no QuotesRunning your code again and viewing the output in your Watchwindow, you will notice the change to the Name property.



Figure	3-36 The Name Property Without QuotesThis provides a cleaner output making the Watch window less noisy.
Evaluate	 Functions	 Without	 Side	 EffectsWhile debugging an application, we probably do not want the state ofthe application to change because of an expression we are evaluating. Itis, unfortunately, a fact that evaluating some expressions might causeside effects.To illustrate this, have a look at the Counter class in Listing 3-3.
public class Counter
{
    public int Value { get; private set; } = 0;

    public int GetAndIncrement()
    {
        Value++; // side effect: changes internal
state
        return Value;
    }
}

Listing	3-3  The Counter ClassHere we see that the class contains a method called
GetAndIncrement() that will cause changes to the internal state ofthe class.



When we place a breakpoint somewhere in our code after creatingan instance of the Counter class and adding
counter.GetAndIncrement() to the Watch window, you willnotice that the value is incremented each time (as expected).If, however, you add counter.GetAndIncrement(), nse to theWatch window, you will see that all future evaluations are suppressed(Figure 3-37).

Figure	3-37 Suppress Future Evaluations with nseWhen adding a side-effecting method call to the Watch windowwith, nse the method is still executed once, which is why you see theValue increment the �irst time you call
counter.GetAndIncrement(), nse.Side effects can cause all sorts of issues further down the debuggingpath, and sometimes the change might be so subtle that you don’t evennotice it. You could end up chasing “bugs” that never really were bugs tobegin with.As you have probably guessed by now, the nse added after theexpression stands for “No Side Effects.”
Format	 Speci�iersFormat speci�iers allow you to control the format in which a value isdisplayed in the Watch window. Format speci�iers can also be used inthe Immediate and Command window. Using a format speci�ier is aseasy as entering the variable expression and typing a comma followed



by the format speci�ier you want to use. The following are the C#format speci�iers for the Visual Studio debugger.
acForce evaluation of an expression decimal integer
dDecimal integer
dynamicDisplays the speci�ied object using a Dynamic View
hHexadecimal integer
nqString with no quotes
nseEvaluates expressions without side effects where “nse” means “No SideEffects”
hiddenDisplays all public and nonpublic members
rawDisplays item as it appears in the raw node. Valid on proxy objects only
resultsUsed with a variable that implements IEnumerable or
IEnumerable<T>. Displays only members that contain the queryresult.You will recall that we used the “nq” format speci�ier with theDebuggerDisplay attribute discussed in a previous section.



Error	 Copying	 ImprovementsImprovements have been made to copying errors from the Error List asdisplayed in Figure 3-38.

Figure	3-38 Copy Error Description OnlyWhen you right-click on an error, you can choose to copy just theerror description or the entire row. Before this change, you would havecopied detailed data that might not have been necessary. Now, you cancopy just the description making it much easier when searching forsolutions to the error online.
Debugging	 with	 GitHub	 CopilotGitHub Copilot is available to developers throughout the Visual StudioIDE. It isn’t just for autocompleting code via code suggestions, it’s yourdebugging wingman too. It understands runtime state, call stacks, andalso suggests �ixes targeting the error you’re experiencing. This means



that when you interact with GitHub Copilot, you’re interacting with adebugger-aware AI.To get started with GitHub Copilot, see Chapter 1 of this book.To �ind GitHub Copilot, just look for the Ask Copilot button.
Variable	 AnalysisWhen you hit a breakpoint in your code, you can use Copilot forvariable analysis.

Figure	3-39 Copilot in the Autos WindowWhen you view the Autos Window (Figure 3-39), for example, andhover over a variable, you will see the Copilot button appear. Clickingon the button will invoke GitHub Copilot chat, and it will analyze thevariable for you as shown in Figure 3-40.



Figure	3-40 Copilot Variable Analysis



You can also do the same thing in code. You can hover over avariable in your code, and on the DataTip that is displayed, you will seethe GitHub Copilot button appear (Figure 3-41).
Figure	3-41 Copilot When Hovering Over a VariableAlternatively, you can right-click a variable in your code to bring upthe context menu. The Ask	Copilot button will be available to you asshown in Figure 3-42.

Figure	3-42 Right-Click on a VariableWhen you click on the Ask Copilot button, you will see that you canstart an in-line chat with Copilot as shown in Figure 3-43.

Figure	3-43 Copilot Inline ChatYou can now ask Copilot for suggestions and �ixes as you normallywould when using the GitHub Copilot Chat window. This �lexibilitymakes GitHub Copilot available to developers with less friction,allowing you to remain focused on the task at hand.



Debugging	 an	 ExceptionWith GitHub Copilot, exception handling is enhanced through the use ofcontext-aware, intelligent suggestions that help identify root causesand accelerate resolutions. As seen in Figure 3-44, we have a
NullReferenceException, and the Copilot button is displayed inthe Exception Thrown dialog as one of the �irst options to follow (nextto Show Call Stack, View Details, Copy Details, and Start Live ShareSession).

Figure	3-44 NullReferenceException with CopilotClicking on the Copilot button will invoke a GitHub Copilot Chatsession, with Copilot having context of the exception you are dealingwith.As seen in Figure 3-45, Copilot uses the debugger as a reference andthen correlates the exception to the code context. Copilot doesn’t justparrot the error message, but digs down to the root cause. It correctlyidenti�ied that _products is null because it has not been initializedbefore being used.What is interesting is that Copilot walks the call path backwardsand detects that _products is a static �ield, explaining theimplications of this in C#. It correctly states that static �ields are nullby default unless explicitly set. Copilot then suggests some remediationsteps to resolve the error.



Figure	3-45 Copilot Debugging the ErrorCopilot understands the execution order of the code, the state of thecode, and C# memory behavior. It also goes one step further and �lags



architectural concerns like the issues static mutable state causes in webapplications.While this is a contrived example, this is the kind of targetedresponse you can expect from Copilot. It is rooted in the context of yourexception, saves time debugging and reduces cognitive load, especiallywhen dealing with complex or obscure exceptions.
Get	 Conditional	 Breakpoint	 SuggestionsThinking back to when we discussed conditional breakpoints earlier inthis chapter, you might have noticed Copilot’s subtle yet powerfulin�luence.

Figure	3-46 Copilot and Conditional BreakpointsShown in Figure 3-46, when you click in the expression �ield, Copilotstarts working by parsing the scope, inspecting nearby variables, andsurfacing relevant suggestions for expressions that would make senseto use in your conditional breakpoint.As you can see from Figure 3-46, the suggestions Copilot providedare for response.IsSuccessStatusCode,
responseText.Contains("error"), and
responseText.Length > 0. It did not suggest this randomly, itdrew from symbols in context and aligned it with debugging patternsdevelopers commonly use.The suggestions Copilot provides become even more useful whenyou are dealing with nullable state, LINQ queries, Enum comparisons,



or Boolean patterns.Accepting a suggestion with a simple selection, or using it as abaseline to re�ine further, helps keep you in that inner dev loop. As withmost AI-generated suggestions (for now), these might not be perfect,but they offer a solid starting point, especially when dealing with non-trivial condition logic.
Diagnostic	 ToolsPerformance pro�iling is no longer something that only concernsdevelopers post-deployment. It is a �irst-class aspect of modernapplication development, and Visual Studio provides Diagnostic Toolsto aid developers in analyzing application behavior during a debugsession. Whether you are chasing a CPU spike, investigating memorypressure, or validating baseline performance, the Diagnostic Toolsbring clarity to your application’s runtime behavior directly inside theIDE.Visual Studio Diagnostic Tools might be enabled by default. If not,enable Diagnostic Tools by going to the Tools menu and clickingOptions ➤ Debugging, and then General. Ensure that Enable DiagnosticTools while debugging is checked, as shown in Figure 3-47.



Figure	3-47 Enable Diagnostic ToolsOnce enabled, the Diagnostic Tools window (Figure 3-48) willappear as a docked pane, typically beside the code editor. The windowcomprises multiple tabs, each surfacing different performance metrics.These range from event timelines and memory snapshots to CPUpro�iling and .NET runtime counters. Together, these tools make themideal for detecting performance issues or regressions.



Figure	3-48 Diagnostic Tools



At the top of the Diagnostic Tools window (Figure 3-49), you canselect the performance aspect to analyze by clicking on the Select	Toolsdropdown. This allows you to toggle various counters such as CPUUsage, .NET Counters, and Memory Usage. These selections will feedinto the graphical area and visualize trends over time, providing real-time feedback on the performance characteristics of your application asyou interact with it.

Figure	3-49 Select What to AnalyzeDiagnostic Tools’ superpower is its ability to correlate performanceevents with your code execution timeline. For example:Trends in memory usage can be aligned with garbage collectionevents or allocation spikes.Speci�ic method calls or threads can be correlated against speci�icCPU utilization.



.NET Counters can provide insights such as exception rates, GarbageCollection activity, and thread pool usage.This correlation takes the guesswork out of what your app wasdoing when it hit 100% CPU or started aggressively allocating memory.Let’s see in the upcoming sections how each of these tabs providesdeeper granularity and understanding of your application'sperformance.
CPU	 UsageThe CPU usage tab in the Diagnostic Tools window gives developers areal-time view into how much processor time their application isconsuming. In a world where performance bottlenecks often hidebehind otherwise functional code, being able to understand the CPUconsumption of your application is not a luxury; it’s essential inpinpointing where that time is being spent.With Diagnostic Tools enabled, when you start a debug session, youcan switch to the CPU Usage tab to begin recording. As your applicationruns, Visual Studio will sample stack traces to analyze where the CPU isspending time.From the sample code used for this demonstration, you will clearlysee that SlowPrimeCheck(int) is a hot path (Figure 3-50). Withoutlooking at the actual source code, the CPU usage tells us that thisfunction dominates execution time. Top functions are ranked by TotalCPU, and for each method, you get a breakdown of how much time wasspent directly in that method. You can then double-click the function inthe list. This will jump you to the de�inition in the source code whereyou can start optimizing your code. But Visual Studio goes a stepfurther.



Figure	3-50 Viewing CPU Usage
Get	AI	AssistanceWhen you analyze the CPU usage of your application, Visual Studio maysurface AI-driven insights in the Top Insights section.Copilot assistance is indicated in Figure 3-51 with arrows.These insights are generated by analyzing the data collected andmatching this data against known performance anti-patterns. If VisualStudio does not �ind any issues outright, you can invoke the AI help byclicking on the Ask	 Copilot button, as shown in Figure 3-51.You will also see a button to Analyze	 method	 with	 Copilot in thesource editor. This will let Copilot analyze the method and suggestoptimizations based on the current pro�iling session.



In Figure 3-51, the methods AllocateMemory() and
SlowPrimeCheck() are both excellent candidates for improvement.The sample code in this chapter is deliberately engineered to beinef�icient by design. It exists to trigger CPU load, memory usage,and runtime events so that the Diagnostic Tools in Visual Studio havesomething meaningful to report. You are encouraged to apply thediagnostic techniques illustrated here in your own production codeand not to mistake the code illustrated here as production-ready.

Figure	3-51 AI Assistance in CPU Insights



The level of detail that this assistive pro�iling offers is especiallyuseful for large legacy codebases where trying to understand the intentbehind every method is impractical. Copilot insights and suggestionshere allow you to signi�icantly shorten the diagnosis-to-�ix cycle.The CPU usage tool is not just a live view into your application'sperformance, it’s a window into the runtime behaviour of your code.Combined with Copilot assistance, it becomes a powerful force forperformance tuning and cleaning up technical debt.
Memory	 UsageVisual Studio Diagnostic Tools allows developers to see what thechange in memory usage is. This is done by taking snapshots. When youstart debugging, place a breakpoint on a method you suspect is causinga memory issue. Then you step over the method and place anotherbreakpoint. An increase is indicated with a red up arrow as shown inFigure 3-52.This is often the best way to analyze memory issues. Two snapshotswill give you a nice diff and allow you to see exactly what has changed.



Figure	3-52 Memory Usage SnapshotsThis view is essential for identifying memory leaks, bloated objectgraphs, or inef�icient allocations that creep in during development. Ihave taken two snapshots as illustrated in Figure 3-52. One snapshotwas taken at the start of the workload and the other was taken afterseveral memory-intensive operations. You will see that the number ofobjects has grown as well as the overall heap size.



Managed	Memory	AnalysisDrilling into a snapshot will take you to one of Visual Studio’s mostpowerful debugging tools. The Managed Memory View displays a tableof object types, their instance counts, sizes etc.

Figure	3-53 Managed Memory AnalysisAs shown in Figure 3-53, when you drill into a memory snapshot tobegin analyzing object types, you will often see internal .NET types suchas:SignatureRuntimeTypePollingCounterAt �irst glance these would not resemble anything you have writtenin your code. They are, however, very real and relevant. Signature, forexample, is an internal CLR type used by the runtime to representmethod signatures, especially when re�lection or dynamic calls areinvolved. RuntimeType represents a .NET type at runtime. You’ll oftensee this when your code (or a class) is using GetType() or
typeof().In short, these are normal object to see in your Managed MemoryAnalysis view. What matters is not that they exist, but whether they are



growing unexpectedly or staying around longer than they should be.To leverage these insights, use the Paths To Root pane to check whythese objects are still alive. Opening this pane for a selected object type,Visual Studio will display the chain of references keeping that objectalive in memory. Think of this as a breadcrumb trail back to the source.By following these root paths, you are able to gain an understandingof how memory is being used and retained in your application. You caneasily spot unintended references, long-lived objects, or potential leaks.You gain insights that are often dif�icult to surface through codeanalysis alone. By creating a few snapshots and exploring a little, youcan essentially turn raw memory data into actionable understanding.This is the power of the Managed Memory Analysis view.
Immediate	 WindowThe Immediate Window in Visual Studio allows you to debug andevaluate expressions, execute statements, and print the values ofvariables. If you don’t see the Immediate Window, go to the Debugmenu, select Windows, and click Immediate or hold down Ctrl+D,Ctrl+I.Let’s place a breakpoint in one of our for loops, as seen in Figure 3-54.

Figure	3-54 Breakpoint Hit



Opening up the Immediate Window and typing in list.Countwill display its value as seen in Figure 3-55.You can also use ?list to view the value of the list.

Figure	3-55 Immediate WindowIf you step over the breakpoint and type list[0] = 42 in theimmediate window, you would be updating the value from whateverrandom value was assigned to the �irst index of the list, to the number
42 as seen in Figure 3-56.



Figure	3-56 Variable Value ChangedYou can also execute a function at design time (i.e., while notdebugging) using the Immediate Window. The code in Listing 3-4 justoutputs a simple string.
static string DisplayMessage()
{
    return "Hello World";
}

Listing	3-4  DisplayMessage FunctionIn the Immediate Window, type ?DisplayMessage() and pressEnter. The Immediate Window will run the function and return theresult seen in Figure 3-57.



Figure	3-57 Execute the DisplayMessage functionAny breakpoints contained in the function will break the executionat the breakpoint. Use the debugger to examine the program state.
Attaching	 to	 a	 Running	 ProcessAttaching to a process allows the Visual Studio Debugger to attach to arunning process on the local machine or a remote computer. With theprocess you want to debug already running, select Debug and clickAttach to Process as seen in Figure 3-58. You can also hold downCtrl+Alt+P to open the Attach to Process window.



Figure	3-58 Attach to ProcessThe Attach to Process window is then displayed (Figure 3-59). Theconnection type must be set to Local.



Figure	3-59 Attach to ProcessThe available processes list allows you to select the process youwant to attach to. You can quickly �ind the process you want by typingthe name in the �ilter process text box.You can, for example, attach to the w3wp.exe process to debug aweb application running on IIS. To debug a C#, VB.NET, or C++application on the local machine, you can use the Attach to Process byselecting the <appname>.exe from the available processes list (where<appname> is the name of your application).
Attach	 to	 a	 Remote	 ProcessTo debug a process running on a remote computer, select Debug andclick the Attach to Process menu, or hold down Ctrl+Alt+P to open theAttach to Process window. This time, change the Connection type toRemote and select the remote computer name in the Connection target



by selecting it from the drop-down list or typing the name in theconnection target text box and pressing Enter.If you are unable to connect to the remote computer using thecomputer name, use the IP and port address.
Remote	Debugger	Port	AssignmentsThe port assignments for the Visual Studio Remote Debugger are asfollows:Visual Studio 2022: 4026Visual Studio 2019: 4024Visual Studio 2017: 4022Visual Studio 2015: 4020Visual Studio 2013: 4018Visual Studio 2012: 4016The port assigned to the Remote Debugger is incremented by twofor each release of Visual Studio.
Reattaching	 to	 a	 ProcessYou can quickly reattach to a process you previously attached to. To dothis, you can click the Debug menu and select Reattach to Process orhold down Shift+Alt+P. The debugger will try to attach to the lastprocess you attached to by matching the previous process ID to the listof running processes. If that fails, it tries to attach to a process bymatching the name. If neither is successful, the Attach to Processwindow is displayed and lets you select the correct process. The optionto reattach to a process you previously attached will only be available ifyou had previously attached to it.
Remote	 DebuggingSometimes, you need to debug an application that has already beendeployed to a different computer. Visual Studio allows you to do this viaremote debugging. To start, you need to download and install remotetools for Visual Studio 2022 on the remote computer.Remote tools for Visual Studio 2022 enables app deployment,remote debugging, testing, pro�iling, and unit testing on computers that



don’t have Visual Studio 2022 installed.
System	 RequirementsThe supported operating systems for the remote computer must be oneof the following:Windows 11Windows 10 (not phone)Windows 8 or 8.1 (not phone)Windows 7 SP 1Windows Server 2016Windows Server 2012 or Windows Server 2012 R2Windows Server 2008 SP 2, Windows Server 2008 R2 Service Pack 1The supported hardware con�igurations to enable remotedebugging are detailed in the following list:1.6 GHz or faster processor1 GB of RAM (1.5 GB if running on a VM)1 GB of available hard disk space5400 RPM hard driveDirectX 9-capable video card running at 1024 x 768 or higher displayresolutionThe remote computer and your local machine (the machinecontaining Visual Studio) must both be connected over a network,workgroup, or homegroup. The two machines can also be connecteddirectly via an Ethernet cable.Take note that trying to debug two computers connected througha proxy is not supported.It is also not recommended to debug via a dial-up connection (dothose still exist?) or over the Internet across geographical locations.The high latency or low bandwidth will make debugging unacceptablyslow.
Download	 and	 Install	 Remote	 Tools



Connect to the remote machine and download and install the correctversion of the remote tools required for your version of Visual Studio.The link to download the remote tools compatible with all versions ofVisual Studio 2022 is
https://visualstudio.microsoft.com/downloads#remot
e-tools-for-visual-studio-2022.If you are using Visual Studio 2017, for example, download thelatest update of remote tools for Visual Studio 2017.Also, be sure to download the remote tools with the samearchitecture as the remote computer. This means that even if your appis a 32-bit application, and your remote computer is running a 64-bitoperating system, download the 64-bit version of the remote tools.Install the remote tools and click Install after agreeing to the licenseterms and conditions (Figure 3-60).

Figure	3-60 Remote Tools for Visual Studio 2022
Running	 Remote	 Tools

https://visualstudio.microsoft.com/downloads%2523remote-tools-for-visual-studio-2022


After the installation has been completed on the remote machine, runthe Remote Debugger application as Administrator if you can. To dothis, right-click the Remote Debugger app and click Run asAdministrator.At this point, you might be presented with a Remote DebuggingCon�iguration dialog box as seen in Figure 3-61.

Figure	3-61 Remote Debugging Con�iguration



If you encounter this window, it possibly means that there is acon�iguration issue that you need to resolve. The Remote DebuggingCon�iguration dialog box will prompt you to correct con�igurationerrors it picks up. Do this by clicking the Con�igure remote debuggingbutton.You will then see the Remote Debugger window shown in Figure 3-62.

Figure	3-62 Visual Studio 2022 Remote DebuggerYou are now ready to start remote debugging your application.
Start	 Remote	 DebuggingThe great thing about the Remote Debugger on the remote computer isthat it tells you the server name to connect to. In Figure 3-62, you cansee that the server is named 43A51FCC-F1DD-4:4026 where 4026is the port assignment for Visual Studio 2022. Make a note of thisserver name and port number.In your application, set a breakpoint somewhere in the code. Nowright-click the project in the Solution Explorer and click Properties. Theproject properties page opens as seen in Figure 3-63.



Figure	3-63 Project Properties PageNext, you need to click on the Open	 debug launch	 pro�iles UI linkas the launch pro�iles have moved to a dedicated screen, as seen inFigure 3-64.

Figure	3-64 Launch Pro�iles Dialog



Now, perform the following steps to remotely debug yourapplication:1. Check the Use remote machine checkbox, and enter the remotemachine name and port noted earlier. In our example, this is
43A51FCC-F1DD-4:4026.  

2. Make sure that you leave the Working directory text box empty anddo not check Enable native code debugging.  3. When all this is done, close the properties and build your project.  4. You now need to create a folder on the remote computer that is thesame path as the Debug folder on your local machine (the VisualStudio machine). For example, the path to the project Debug folderon my local machine is <source path>
DiagnosticToolsDemo\diag-tools\bin\Debug. Createthis same path on the remote machine.

 
5. Copy the executable that was just created by the build youperformed in step 3 to the newly created Debug folder on theremote computer.Be aware that any changes to your code or rebuilds to yourproject will require you to repeat step 5.

 
6. Ensure that the Remote Debugger is running on the remotecomputer. The description (Figure 3-62) should state that it iswaiting for new connections.  
7. On your local machine, start debugging your application, and ifprompted, enter the credentials for the remote machine to log on.Once logged on, you will see that the Remote Debugger on theremote computer displays that the remote debug session is nowactive (Figure 3-65). A point to note here is that if you trust thenetwork that you are debugging across, and you are havingproblems logging on, you can specify that no authentication isdone. In the project properties, change the Authentication mode

 



p j p p , gfrom Windows Authentication to No Authentication (Figure 3-64).Then, on the remote machine, click the Remote Debugger and click
the Tools menu, and select Options. Here, you can specify that noauthentication is done and that any user can debug.

Figure	3-65 Remote Debug Session Connected8. After a few seconds, you will see your application’s main windowdisplayed on the remote machine.  9. On the remote machine, take whatever action is needed to hit anybreakpoints you might have set. When you hit the breakpoint, itwill be hit on your local machine (Visual Studio machine).  
If you need any project resources to debug your application, youwill have to include these in your project. The easiest way is to create aproject folder in Visual Studio and then add the �iles to that folder. Foreach resource you add to the folder, ensure that you set the Copy toOutput Directory property to Copy always.

SummaryThis chapter explored Visual Studio’s powerful debugging capabilities.The emphasis here is that effective debugging is vital to professionalsoftware development. We discussed the fundamentals such as setting



and managing breakpoints, including conditional, temporary,dependent, and labeled breakpoints.We had a look at debugging tools such as DataTips, Visualizers, theWatch Window and the Immediate Window that provide developerswith various ways to inspect the state of their application at runtime.GitHub Copilot also made an appearance as a debugging assistant,offering suggestions, variable analysis, and insights into exceptionhandling. The Diagnostic Tools in Visual Studio were then introduced asa performance pro�iler, allowing developers to gain valuable insightsinto the CPU usage, memory snapshots, and managed heap behavior inreal time, enhanced with AI.Finally, the chapter concluded with a practical guide on attaching torunning processes and remote debugging.
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4.	 Unit	 TestingDirk Strauss1  Uitenhage, South Africa 
Experienced developers know that in order to maintain the quality of theircode is a relentless pursuit. To this end, Unit Testing is one of the mosteffective tools we have to catch bugs early, refactor code safely, and buildsoftware that is as robust as possible.In this chapter, we will have a look atCreating and running unit testsUsing live unit testsUsing GitHub Copilot to generate unit testsHow to measure Code Coverage in Visual StudioUnit tests allow you to maintain the health of your code and �ind errorsquickly, before shipping your application to your customers. To introduce youto unit testing, we will start off with a very basic example of creating a unittest.
Creating	 and	 Running	 Unit	 TestsThe purpose of unit tests is to ensure that units of code (often individualfunctions and classes) work as intended when they were originally written.Writing unit tests acts as a safety net, alerting you when changes in code breakexpected behavior. Visual Studio provides a Test Explorer to make it easy tocreate, organize, and run unit tests.
Choosing	 a	 Test	 FrameworkOut of the box, Visual Studio supports multiple test frameworks such asMSTest, NUnit, and xUnit. You can then decide to use the framework that isbest suited for your team’s habits. Adding a new test project to your solution,you will see that Visual Studio provides templates for all three frameworks.
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In our example, we will be using MSTest. Adding a unit test project is doneby adding a new project to your existing solution. Search for Unit	Test in theAdd new Project dialog and select Unit	Test	Project as shown in Figure 4-1.

Figure	4-1 Add a New Unit Test ProjectVisual Studio adds the test project to your solution with the distinct �laskicon shown in Figure 4-2.



Figure	4-2 The Added Unit Test ProjectIt is to this project that you will add your unit tests as required. To do this,start by adding a reference to the project containing the code that you want totest. Your test code can now instantiate and call methods in your class orproject under test.
Writing	 Your	 First	 TestTo illustrate creating unit tests, I have a small Console Application thatcalculates insurance premiums based on the age and driving history of thedriver.You will see this entire class in Listing 4-1. The static method
CalculatePremium implements a few business rules and we want toensure that these rules remain consistently applied.
public static class InsuranceCalculator
{
    public static double CalculatePremium(int age, int
accidents)
    {
        if (age < 18)



            throw new ArgumentException("Age must be 18
or older.", nameof(age));
        if (accidents < 0)
            throw new ArgumentException("Accident count
cannot be negative.", nameof(accidents));

        double basePremium = 500;
        if (age < 25)
            basePremium *= 2;
        else if (age > 70)
            basePremium *= 1.5;
        else if (age >= 50 && age <= 70)
            basePremium *= 0.8;

        if (accidents == 0)
            basePremium -= 200;
        else
            basePremium += 100;

        // Minimum premium enforcement
        if (basePremium < 300)
            basePremium = 300;

        return basePremium;
    }
}

Listing	4-1 The Code to TestNext, we need to create a test class called
InsuranceCalculatorTests in the test project (Listing 4-2). A commonstructure for a unit test method is Arrange-Act-Assert. We set up the inputs(Arrange), then we execute the code that we want to test (Act), and �inally weverify the results (Assert).
[TestClass]
public sealed class InsuranceCalculatorTests
{
    [TestMethod]
    public void
PremiumCalc_YoungDriverWithAccident_ReturnsHigherPremium
()



    {
        // Arrange
        int age = 22;
        int accidents = 1;
        // Expected: base $500 * 2 for young driver +
$100 for one accident = $1100
        double expected = 1100;

        // Act
        double actual =
InsuranceCalculator.CalculatePremium(age, accidents);

        // Assert
        Assert.AreEqual(expected, actual, 0.001,
            "Premium for young driver with an accident
should be high");
    }
}

Listing	4-2 The Test ClassUsing MSTest, you will notice that we mark the class with [TestClass]and every method with [TestMethod]. What this method is testing is that a22-year-old driver that has previously been involved in an accident is chargedthe correct higher premium.The message in the Assert.AreEqual clari�ies the assumption beingchecked and this message will appear if the assertion fails. The additionaltolerance of 0.001 is also good practice when dealing with doublecalculations because �loating-point results might not match exactly.
Running	 Your	 TestsWhen it’s time to run your tests, Visual Studio’s Test Explorer (Figure 4-3)serves as the central hub for running and managing them. Invoked by typingCtrl+E, T, be sure to build your solution. Visual Studio will discover and list thetests you wrote in real time (Tools ➤ Options ➤ Test ➤ Test Discovery).



Figure	4-3 Test Explorer WindowTo run all your tests, click the Run All button indicated by a double greenarrow on the Test Explorer toolbar.

Figure	4-4 Test Explorer SettingsThe Test Explorer Options, as seen in Figure 4-4, allow you to con�igureadditional behavior such as running tests in parallel, running tests after abuild, selecting the processor architecture, and more.Once the tests have been run, Test Explorer will display the test results aspassed or failed.



Figure	4-5 Failed TestsFailed tests are indicated with a red error indicator as seen in Figure 4-5.The test detail summary shows you the assertion message with the expectedversus actual values.

Figure	4-6 Ask Copilot OptionFor any failed tests, Copilot is also available, as seen in Figure 4-6. You canget Copilot assistance to explain the failure or to debug the issue for you.
Create	 and	 Run	 a	 Test	 PlaylistIf your project contains many tests, and you want to run those tests as a group,you can create a playlist. To create a playlist, select the tests that you want to



group from the Test Explorer, and right-click them. From the context menuthat pops up, select Add to Playlist ➤ New Playlist as seen in Figure 4-7.

Figure	4-7 Create a PlaylistThis will open a new Test Explorer window where you can run the testsand save the tests you selected under a new playlist name. This will create a.playlist �ile for you.I created a new playlist called SeniorJunior.playlist from two ofthe tests that test senior drivers and young drivers. The playlist �ile it createsis simply an XML �ile that you can view and open from your Solution Explorer.



Figure	4-8 Open a Playlist FileTo open and run a playlist again, click the Open Playlist File button shownin Figure 4-8 and select the playlist �ile you want to run.
Unit	 Test	 AttributesIn MSTest, you need to mark each class with [TestClass] and each methodwith [TestMethod]. Using the [TestClass] attribute speci�ies that aclass contains unit tests along with optional setup and teardown methods. The
[TestMethod] attribute speci�ies an individual test method that needs to berun by the test runner. You will see this if you refer back to the code in Listing4-2.
Setting	Up	and	Tearing	DownMSTest also allows you to de�ine setup and teardown logic using two specialattributes. These are:
[TestInitialize] – marks a method to run before each test.
[TestCleanup] – marks a method to run after each test.These are instance methods and can optionally be async. They run aroundevery test, setting up and tearing down logic. You can also de�ine class-levelsetup and teardown logic with [ClassInitialize] and

[ClassCleanup], which will be called once per class. These need to be
public static methods, and the class initialization method takes a
TestContext parameter.Similarly, assembly-level equivalents [AssemblyInitialize] and
[AssemblyCleanup] will run once per test assembly. These are also
public static methods.You can see an example of this structure in Listing 4-3. Being able tospecify setup and teardown logic in this manner allows developers to bespeci�ic about the creation and destruction of their unit tests.
[TestClass]
public sealed class InsuranceCalculatorTests
{
    [AssemblyInitialize]
    public static void AssemblyInitialize(TestContext
context)
    {
        // Any assembly-level setup code if needed



    }

    [ClassInitialize]
    public static void ClassInitialize(TestContext
context)
    {
        // Any class-level setup code if needed
    }

    [TestInitialize]
    public void TestInitialize()
    {
        // Any test-level setup code if needed
    }

    [TestMethod]
    public void Test1() { }

    [TestMethod]
    public void Test2() { }

    [TestCleanup]
    public void TestCleanup()
    {
        // Runs after each test method
    }

    [ClassCleanup]
    public static void ClassCleanup()
    {
        // Runs once after all tests in this class
    }

    [AssemblyCleanup]
    public static void AssemblyCleanup()
    {
        // Any assembly-level cleanup code if needed
    }
}

Listing	4-3 Test Class Structure



Data	Driven	TestsMSTest also supports tests that are data-driven or parameterized. To do this,you need to add the [DataRow] attribute that will provide the data for eachtest method. In other words, every [DataRow] attribute added to the methodwill cause the method to run once with those speci�ied parameters. You alsoindicate a data-driven test by using the [DataTestMethod] attribute. Anexample can be seen in Listing 4-4.
[DataTestMethod]
[DataRow(22, 1, 1100)]
[DataRow(30, 0, 300)]
[DataRow(72, 0, 550)]
public void TestVariableCalculations(int age, int
accidents, double expected)
{
    // Act
    double actual =
InsuranceCalculator.CalculatePremium(age, accidents);
    // Assert
    Assert.AreEqual(expected, actual, 0.0001,
        $"Premium for driver age {age} with {accidents}
accidents should be {expected}");
}
Listing	4-4 A Data-Driven TestIn the code example in Listing 4-4, the test will be called three times withthe provided arguments. Once for each [DataRow] attribute set. The numberand types of the parameters in the [DataRow] must match the methodsignature.
Dynamic	Data	Driven	TestsWe saw that we can use [DataRow] with hardcoded data to run testmethods, but we can also supply data to a test method via a property ormethod using [DynamicData].Looking at the code in Listing 4-5, you will see that I have added a readonly property called AdditionalData that simply returns
IEnumerable<object[]> of the test cases we want to execute.On the test method TestDynamicDataCalucaltions I then use the
[DynamicData(nameof(AdditionalData))] attribute.



public static IEnumerable<object[]> AdditionData
{
    get
    {
        yield return new object[] { 22, 1, 1100 };
        yield return new object[] { 30, 0, 300 };
        yield return new object[] { 72, 0, 550 };
    }
}

[TestMethod]
[DynamicData(nameof(AdditionData))]
public void TestDynamicDataCalculations(int age, int
accidents, double expected)
{
    // Act
    double actual =
InsuranceCalculator.CalculatePremium(age, accidents);
    // Assert
    Assert.AreEqual(expected, actual, 0.0001,
        $"Premium for driver age {age} with {accidents}
accidents should be {expected}");
}

Listing	4-5 Using Dynamic DataThis will tell MSTest to fetch each row of that data and feed it to the testmethod. You can also optionally specify a custom display name for each datarow via DynamicDataDisplayName to improve the readability of the testresults.In Listing 4-6 I have created a method called
GetCustomDynamicDataDisplayName that will enrich the test resultssummary. The attribute on the test method is also changed from
[DynamicData(nameof(AdditionData))] to
[DynamicData(nameof(AdditionData),
DynamicDataDisplayName =
nameof(GetCustomDynamicDataDisplayName))].
public static IEnumerable<object[]> AdditionData
{
    get



    {
        yield return new object[] { 22, 1, 1100 };
        yield return new object[] { 30, 0, 300 };
        yield return new object[] { 72, 0, 550 };
    }
}

public static string
GetCustomDynamicDataDisplayName(MethodInfo methodInfo,
object[] data)
{
    return string.Format("DynamicDataTestMethod {0}
with {1} parameters", methodInfo.Name, data.Length);
}

[TestMethod]
[DynamicData(nameof(AdditionData),
DynamicDataDisplayName =
nameof(GetCustomDynamicDataDisplayName))]
public void TestDynamicDataCalculations(int age, int
accidents, double expected)
{
    // Act
    double actual =
InsuranceCalculator.CalculatePremium(age, accidents);
    // Assert
    Assert.AreEqual(expected, actual, 0.0001,
        $"Premium for driver age {age} with {accidents}
accidents should be {expected}");
}

Listing	4-6 Using DynamicDataDisplayNameThis will result in your test summary changing from what we see in Figure4-9 to what you speci�ied in the GetCustomDynamicDataDisplayNamemethod and output in the test summary as seen in Figure 4-10.



Figure	4-9 Without Using GetCustomDynamicDataDisplayNameWhile this example is rather contrived, it illustrates the �lexibility you haveover what can be displayed in the test Detail Summary.

Figure	4-10 Using GetCustomDynamicDataDisplayNameThe �lexibility provided to developers does not stop there. You also haveaccess to execution control attributes, which we will be looking at next.
Testing	TimeoutsThe speed of your code is also very important. Using the MSTest framework,you can set a timeout attribute to specify a timeout after which a test shouldfail. This is convenient because as you write code for a speci�ic method, youcan immediately identify if the code you are adding to a method is causing apotential bottleneck. Consider the TestTimeoutOfMethod test in Listing 4-7. Here we are specifying that if the test runs for longer than 2 seconds (2000milliseconds), then it should be aborted and marked as failed. To force afailure, I have added a delay in the code of 2100 milliseconds.
[TestMethod, Timeout(2000)]
public void TestTimeoutOfMethod()
{



    // Arrange
    int age = 22;
    int accidents = 1;
    // Expected: base $500 * 2 for young driver + $100
for one accident = $1100
    double expected = 1100;

    Task.Delay(2100).Wait(); // Simulate some delay

    // Act
    double actual =
InsuranceCalculator.CalculatePremium(age, accidents);

    // Assert
    Assert.AreEqual(expected, actual, 0.0001,
        "Premium for young driver with an accident
should be high");
}

Listing	4-7 Adding a Timeout AttributeRunning this test you will notice that it will fail because it has exceeded thespeci�ied timeout value set by the Timeout attribute (Figure 4-11).

Figure	4-11 Test Timeout ExceededIdentifying critical methods in your code and setting a speci�ic timeout onthat method will allow developers to catch issues early on when tests startexceeding the timeout set. You can then go back and immediately refactor thecode that was recently changed to improve the execution time.
Retry



You can specify that MSTest automatically retries a failed test. As of MSTestv3.8, the Retry attribute allows you to specify how many times a failing testshould be retried.
private static int _retryAttempt = 0;

[TestMethod, Retry(2)]
public void TestRetryAttempt()
{
    _retryAttempt++;
    if (_retryAttempt == 1)
    {
        Assert.Fail("Intentional failure on first
attempt.");
    }

    // Succeeds on retry
    Assert.IsTrue(true, "Test succeeded on retry.");
}
Listing	4-8 Using Retry on a Unit TestFrom the contrived example in Listing 4-8 you will see that I have speci�iedthat a test needs to be retried twice. The code then forces a failure. To see thisin action, place a breakpoint on the Assert.Fail and debug your unit test.After you step over the failure, the unit test will be run again, succeeding thesecond time.



Figure	4-12 MSTest VersionEnsure that you have at least MSTest 3.8 or later installed, as seen inFigure 4-12.
Metadata	AttributesThere are several attributes that exist within MSTest that add metadata oralter the way tests appear in Test Explorer. While they do not change testexecution, it helps organize your tests.
[TestMethod]



[Description("Throws ArgumentException when age is less
than 18.")]
[TestCategory("Premium Calculation")]
[Priority(1)]
[Owner("Dirk")]
[WorkItem(1234)]
public void TestMethodWithExpectedException()
{
    // Arrange
    int age = 16; // Invalid age
    int accidents = 0;
    // Act & Assert
    Assert.ThrowsException<ArgumentException>(() =>
InsuranceCalculator.CalculatePremium(age, accidents),
        "Expected ArgumentException for age less than
18.");
}
Listing	4-9 Metadata AttributesIf you look at the Test Explorer after running your test, you will see themetadata for Owner, TestCategory, and Priority displayed in the Traitscolumn (Figure 4-13).

Figure	4-13 Test Explorer Displaying Metadata



As for Description and WorkItem, these attributes are applied but notdisplayed in the Traits column, potentially for you to enrich the test methodwith additional information about its purpose.If you need to add an arbitrary key/value property to your test, you canuse the TestProperty attribute as seen in Listing 4-10.
[TestMethod]
[TestProperty("Category", "Premium Calculation")]
public void
PremiumCalc_SeniorNoAccidents_ReturnsDiscountedPremium()
{
    // Arrange
    int age = 72;
    int accidents = 0;
    // Expected: base $500 * 1.5 for senior driver -
$200 for no accidents = $550
    double expected = 550;
    // Act
    double actual =
InsuranceCalculator.CalculatePremium(age, accidents);
    // Assert
    Assert.AreEqual(expected, actual, 0.0001,
        "Premium for senior driver with no accidents
should be discounted to minimum");
}

Listing	4-10 Adding the TestProperty AttributeOnce added you will see this displayed in the Traits column as displayed inFigure 4-14.



Figure	4-14 Viewing the TestProperty AttributeAs you can see these attributes do not affect test execution, but helporganize your tests.
IgnoreYou can also choose to exclude tests from execution. You can optionallyprovide a reason message, but marking a test with Ignore will report it asskipped in the test results.
[TestMethod]
[TestProperty("Category", "Premium Calculation")]
[Ignore("Not yet implemented")]
public void
PremiumCalc_SeniorNoAccidents_ReturnsDiscountedPremium()
{
    // Arrange
    int age = 72;
    int accidents = 0;
    // Expected: base $500 * 1.5 for senior driver -
$200 for no accidents = $550
    double expected = 550;
    // Act
    double actual =
InsuranceCalculator.CalculatePremium(age, accidents);



    // Assert
    Assert.AreEqual(expected, actual, 0.0001,
        "Premium for senior driver with no accidents
should be discounted to minimum");
}
Listing	4-11 Ignoring a TestUsing the code in Listing 4-11, you will notice that the Ignore attributehas been added to the test method.

Figure	4-15 Skipping a Test with IgnoreWhen running your tests, the test will be marked as skipped and the messageyou provided (if any) will be displayed in the summary.You might skip a test if you’re still working on it and need to commit yourcode, or if the test has become obsolete but you don’t want to remove it yet. Inany event, having this kind of control over test execution is very convenient.
Using	 Live	 Unit	 TestsFirst introduced in Visual Studio 2017, Live Unit Testing runs your unit testsautomatically as you make changes to your code. You can then see the resultsof your unit tests in real time.Live Unit Testing is only available in Visual Studio Enterprise edition forC# and Visual Basic projects targeting the .NET Framework or .NET 5 andlater. For a full comparison between the editions of Visual Studio, refer to



the following link:
https://visualstudio.microsoft.com/vs/compare/.The bene�its of Live Unit Testing are as follows:You will immediately see failing tests, allowing you to easily identifybreaking code changes.It indicates Code Coverage, allowing you to see what code is not covered byany unit tests.Live Unit Testing persists the data of the status of the tests it ran. It thenuses the persisted data to dynamically run your tests as your code changes.Live Unit Testing supports the following test frameworks:xUnit.net – Minimum version xunit 1.9.2NUnit – Minimum version NUnit version 3.5.0MSTest – Minimum version MSTest.TestFramework 1.0.5-previewTo view the Live Unit Testing frequently asked questions, browse to
https://learn.microsoft.com/en-
us/visualstudio/test/live-unit-testing-faq.Before you can start using Live Unit Testing, you need to con�igure it bygoing to Tools ➤ Options and selecting Live Unit Testing in the left pane(Figure 4-9).

https://visualstudio.microsoft.com/vs/compare/
https://learn.microsoft.com/en-us/visualstudio/test/live-unit-testing-faq


Figure	4-16 Con�igure Live Unit TestingOnce you have con�igured the Live Unit Testing options, you can enable it fromTest ➤ Live Unit Testing Window (Figure 4-17) or by holding down Ctrl+E, L.

Figure	4-17 Open the Live Unit Testing WindowThe Live Unit Testing window is displayed as seen in Figure 4-18.



Figure	4-18 Live Unit Testing windowClick on the playlist editor in the toolbar to select the tests that Live UnitTesting should run, shown in Figure 4-19. When selected, click the pencil iconagain and then Start.

Figure	4-19 Selecting Tests to be Run



You will now see the Con�igure Live Unit Testing screen displayed (Figure4-20).

Figure	4-20 Con�igure Live Unit TestingThis screen allows developers to tailor how Live Unit Testing operates ontheir solution. You will see this screen when initializing Live Unit Testing(LUT) for the �irst time. Here you specify a Repository root and Workspacefolder.Live Unit Testing requires the repository root to be the parent folderthat contains all projects referenced in the solution. If a solution referencessibling project folders using relative paths, the repository root must be setabove all those folders to resolve correctly.The Workspace folder isolates the working copy and avoids polluting thesource code repo with LUT artifacts. You can also �ilter common build outputs



such as bin/, obj/, *.dll, and *.obj to optimize sync performance.Enabling multiple MSBuild processes under Build	options can signi�icantlyreduce build time in large solutions. For the Test	options section you cancon�igure a timeout (in seconds) and parallelize test execution using multipletest processes, which is ideal for improving responsiveness and testthroughput. Con�iguring your Live Unit Testing ensures seamless integrationwith real-world dev work�lows, minimizing overhead while maintainingimmediate feedback on code changes.

Figure	4-21 Con�igure Lutignore FileClicking Next will display the Con�igure	lutignore	�ile screen. This allows you tode�ine which �iles and directories to exclude when creating its workspace. The
.lutignore �ile follows the same syntax as .gitignore, �iltering out user-speci�ic �iles, build outputs, and temporary artifacts. If a .lutignore �ile isnot present, Live Unit Testing will fall back to the .gitignore �ile, ensuringclean and ef�icient test runs.



Referring back to Listing 4-1, make a breaking change to your
CalculatePremium method as illustrated in Figure 4-22. You will noticethat I changed the basePremium multiplier from 1.5 to 7.5.

Figure	4-22 Making a Breaking ChangeA breaking change will immediately be visualized in the code editor asseen in Figure 4-22. With Live Unit Testing, areas of code indicated by a dashare not covered by any tests. A green tick indicates that the code is covered bya passing test. A red X indicates that the code is covered by a failing test. Youwill also see that the Live Unit Testing window is updated to display the failingtests as shown in Figure 4-23.



Figure	4-23 Live Unit Testing Results UpdatedLive Unit Testing provides real-time insight into the stability of your codeas you write it.
Using	 Copilot	 to	 Generate	 Unit	 TestsGitHub Copilot can assist developers when creating Unit Tests for their sourcecode. In the InsuranceCalculator class I have a method that determinesthe risk category of an individual based on age and the number of previousaccidents they have been involved in. You can see this code in Listing 4-12.
public static string GetRiskCategory(int age, int
accidents)
{
    if (age < 18)
        throw new ArgumentException("Age must be 18 or
older.", nameof(age));
    if (accidents < 0)
        throw new ArgumentException("Accident count
cannot be negative.", nameof(accidents));

    if (accidents == 0 && age >= 25 && age <= 50)
        return "Low";
    if (accidents <= 1 && age >= 18 && age < 25)
        return "Medium";
    if (accidents >= 2 || age > 70)



        return "High";
    return "Medium";
}
Listing	4-12 The Risk Category MethodThe code is straightforward, but I want to be sure that I have it suf�icientlycovered with a Unit Test. Open the InsuranceCalculatorTests class andposition your cursor where a new test method should go. Invoke Copilot’sinline chat by pressing Alt+/ or right-clicking and selecting Ask	Copilot fromthe context menu, as seen in Figure 4-24.
Figure	4-24 Invoking Copilot Inline ChatYou can now prompt Copilot to create a suitable unit test for your
GetRiskCategory method. The inline chat allows you to change the LLM,but as seen in Figure 4-24, I am just using the default (at the time of thiswriting) GPT-4.1 with its large context window.

Figure	4-25 Copilot Generated Unit TestCopilot will generate a Unit Test for you and display that as seen in Figure4-25.You can press (or click on) the Tab button to accept the change or Alt+Delto discard the suggestion from Copilot. You will see the newly added testdisplayed in the Test Explorer and indicated with a blue exclamation icon, asseen in Figure 4-26.



Figure	4-26 Updated Test ExplorerAs before, Test Explorer provides a centralized view to monitor testexecution. You can run the newly added test to verify that it passes.The example above illustrates using Copilot Inline chat to create a UnitTest, but you can do the same thing using the GitHub Copilot Chat window, asseen in Figure 4-27.By invoking the slash command, you can ask Copilot to create a unit testfor the selected code in your editor window.



Figure	4-27 Using Copilot ChatThis enables you to perform the same action directly within the CopilotChat window. You may be wondering whether Copilot can assist with speci�icuse cases, such as generating documentation.Documenting unit tests is a common task for developers, though it is rarelya favorite. In the next section, we will explore how to leverage AI to help



document your unit tests, or any code �ile, ef�iciently and accurately.
Document	 Unit	 Tests	 with	 Obsidian	 MCP	 ServerYou are able to integrate Obsidian with Visual Studio through the use of anMCP (Model Context Protocol) Server. This allows you to leverage the powerof GitHub Copilot Agent to document your unit tests (or any code for thatmatter) directly into your Obsidian knowledge base. Using this approach, younot only centralize your documentation but you also enable AI-assistedupdates as your unit tests evolve over time.The process begins by ensuring that you have Docker installed and readyto run containers. In Docker, install the Docker MCP Toolkit (Figure 4-28).

Figure	4-28 MCP Toolkit in DockerThis toolkit provides the infrastructure required to host and run MCPservers, including the one we will need for Obsidian. With the toolkit installed,you can enable the Obsidian MCP Server. Since the server relies on Obsidian,you must have Obsidian installed locally. In Obsidian, open the CommunityPlugins section and install the Local REST API Plugin (Figure 4-29). Thisplugin exposes an HTTP API for interacting with your vault, which the MCPserver will utilize to create and update notes.



Figure	4-29 Obsidian Local REST API PluginAfter installation, navigate to the plugin’s settings and get your API key asseen in Figure 4-30. This key is critical as it authenticates requests from theMCP server to your Obsidian vault.



Figure	4-30 Obsidian API KeyBack in Docker, add the API key to the Obsidian MCP server con�igurationshown in Figure 4-31.With the version 17.14.13 August release of Visual Studio 2022, MCPsupport became GA in Visual Studio. Released after the publication of thischapter, MCP support became a �irst-class experience in Visual Studio 2022.No more copying JSON snippets into .mcp.json �iles. This is anotherexample of the rapidly evolving landscape of AI tools and Visual Studio ingeneral.



Figure	4-31 Obsidian MCP Server Con�iguration
Above the Con�iguration tab in Docker, click the URL to open theObsidian.md page on GitHub and scroll down until you locate the JSONcon�iguration for the MCP server. Copy this JSON, which resembles the code inListing 4-13.

{
  "mcpServers": {
    "obsidian": {
      "command": "docker",
      "args": [
        "run",
        "-i",
        "--rm",
        "-e",
        "OBSIDIAN_HOST",
        "-e",
        "OBSIDIAN_API_KEY",
        "mcp/obsidian"
      ],



      "env": {
        "OBSIDIAN_HOST": "host.docker.internal",
        "OBSIDIAN_API_KEY": "YOUR_OBSIDIAN_API_KEY"
      }
    }
  }
}

Listing	4-13 MCP Server Con�ig JSONThis JSON de�ines the MCP server for Obsidian, passing in the host addressand the unique API key (copied earlier) via environment variables.Once you have this JSON, open Windows Explorer and navigate to
%USERPROFILE%. In this directory, create a new �ile named .mcp.json(note the leading period) as shown in Figure 4-32. Paste the JSON from Listing4-13 into this �ile.

Figure	4-32 The .mcp.json FileIf you already have other MCP servers con�igured, append this JSON to theexisting mcpServers section (you can de�ine multiple MCP servers in this�ile). Replace YOUR_OBSIDIAN_API_KEY with the key you copied from yourObsidian settings earlier.



Figure	4-33 Obsidian Tool SelectionAfter saving the �ile, restart Visual Studio to load the updated MCPcon�iguration. Switch to GitHub Copilot Agent mode as shown in Figure 4-33.Clicking on the tools icon, you will see the Obsidian tools that are nowavailable to you. This allows you to select the speci�ic Obsidian tools Copilotcan use.



Figure	4-34 Prompting Copilot



From this point, you can prompt GitHub Copilot to document your unittests directly into Obsidian, as shown in Figure 4-34. Copilot will sendstructured documentation to your Obsidian vault, creating or updating notesaccordingly.

Figure	4-35 Generated Unit Test DocumentationOnce the process has completed, open Obsidian to review the generatedunit test documentation (Figure 4-35). The advantage of this setup is theiterative nature that you can implement. You can quickly regenerate or updatedocumentation with a single Copilot prompt, ensuring that your testdocumentation remains synchronized with the unit tests you wrote. No moremanual copy-and-paste updates.
How	 to	 Measure	 Code	 Coverage	 in	 Visual	 StudioCode Coverage indicates what portion of your code is covered by Unit Tests. Toguard against bugs, it becomes obvious that the more code is covered by UnitTests, the better tested it is.This feature is only available in Visual Studio Enterprise edition.



The Code Coverage feature in Visual Studio will give you a good idea ofyour current Code Coverage percentage. To run the Code Coverage analysis,open Test Explorer, and click the drop-down next to the play button (Figure 4-36).

Figure	4-36 Analyze Code CoverageClick Analyze Code	Coverage	for	All	Tests in the menu. The Code CoverageResults are then displayed in a new window (Figure 4-37). You can access thiswindow from the Test menu and then select Code	 Coverage	 Results or holddown Ctrl+E, C on the keyboard.

Figure	4-37 Code Coverage ResultsIn the Code Coverage Results window, you can Export the results, ImportResults, Show Code Coverage Color (Figure 4-38), or Remove the results.



Figure	4-38 Toggle Code Coverage ColoringThis will toggle colors in your code editor to highlight areas touched,partially touched, and not touched at all by tests. The colors used to highlightthe code can also be changed. To do this, head on over to Tools ➤ Options ➤Environment ➤ Fonts and Colors (Figure 4-39).

Figure	4-39 Change Fonts and ColorsThis should give you a good understanding of how much code is coveredby unit tests. Developers should typically aim for at least 80% Code Coverage.If the Code Coverage is low, then modify your code to include more tests. Onceyou are done modifying your code, run the Code Coverage tool again as theresults are not automatically updated as you modify your code.Code Coverage is typically measured in blocks. A block of code is a sectionof code that has exactly one entry point and one exit point. If you prefer to see



the Code Coverage in terms of lines covered, you can change the results bychoosing Add/Remove Columns in the results table header (Figure 4-40).

Figure	4-40 Code Coverage Expressed in LinesCode Coverage is a great tool to allow you to check if your code issuf�iciently covered by unit tests. If you aim for 80% Code Coverage, youshould be able to produce well-tested code. The 80% Code Coverage is notalways attainable. This is especially true if the code base you’re working onhas a lot of generated code. In instances such as these, a lower percentage ofcode cover is acceptable.
SummaryThis chapter explored how unit testing safeguards code quality, catches errorsearly, and supports safe refactoring. We began by creating and running tests inVisual Studio and running them in Test Explorer. We had a look at thefundamentals of MSTest such as [TestClass] and [TestMethod]attributes. We discussed setup and teardown methods at various scopes aswell as data-driven tests using [DataRow] and [DynamicData]. Executioncontrol techniques were also discussed such as timeouts, retrying failed tests,and skipping tests with [Ignore].The chapter then examined advanced capabilities such asLive Unit Testing for real-time feedback and coverage indicatorsGitHub Copilot integration to create unit tests via inline chat or chatpromptsObsidian MCP Server integration to document unit tests into an Obsidianknowledge baseIt concluded with measuring code coverage in Visual Studio Enterprise,interpreting results, and customizing coverage highlighting. Together, these



tools and techniques provide a robust framework for ensuring that developersship quality code with con�idence.In the next chapter, we will be looking at a feature that all developersshould be very familiar with. Source control management is essential to anyproject. We will explore this and some new features of Visual Studio 2022such as multi-repo support, comparing branches, Check out Commit, and linestaging, but to name a few. Let’s look at source control next.
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5.	 Source	 ControlDirk Strauss1  Uitenhage, South Africa 
If you have worked on projects in a team environment, or if you need aplace to keep your own code safe, then you’ll agree that using a sourcecontrol solution is essential. It doesn’t matter if it’s a large enterprisesolution or a small personal project, Visual Studio makes it extremelyeasy for developers to use Git and GitHub.Git is a distributed version control system that developers installlocally to track changes to their code. GitHub is a cloud-basedhosting service for Git repositories, enabling developers to storetheir code online, collaborate with others, and manage projectsusing the Git tool.In 2018, Microsoft acquired GitHub for $7.5 billion in Microsoftstock. This acquisition of GitHub brought about changes to their pricingtiers. Previously, developers could only create public repos on the freetier. In January 2019, however, GitHub announced that developers cannow create unlimited private repositories on the free tier.This is great, especially if you are working on a side project that youdo not want to share with anyone just yet. In this chapter, we will belooking at using Git and GitHub inside Visual Studio 2022. We will seehow toCreate a GitHub accountCreate and clone a repositoryCommit changes to a repositoryCreate a branch from your code
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Create and handle pull requestsThese are all things that developers will do on a daily basis whenworking with Git and GitHub. While the process might change slightly ifyou use a different source control strategy, the concepts remain thesame.
Create	 a	 GitHub	 AccountLet’s start with creating a GitHub account. Point your browser to
www.github.com, as shown in Figure 5-1, and create an account byclicking the signup button.

http://www.github.com/


Figure	5-1 Sign up for GitHubEnter a username (Figure 5-1), email address, and password.GitHub then checks your password to verify that it does not appear on alist of known compromised passwords. If all checks out, a con�irmationcode is sent to your email address. Once you verify your email address,



GitHub signs you in to your account. From there, you can modify yourpro�ile and complete your account setup.You can continue using the free account, but there is also the optionto upgrade to a Team or Enterprise account. The free subscriptionoffers the basics suitable for most developers, while the Teamsubscription offers several more features aimed at advancedcollaboration for individuals and organizations. The free subscription isvery generous and will appeal to most developers. The freesubscription includes the following, among others:Unlimited public and private repositoriesUnlimited collaborators for public and private repositoriesIssues – Track bugs, enhancements, and other requestsProject, Milestones, and Team discussionsPages and wikis for public reposGitHub Actions (2000 minutes/month) or free for public reposThe Team and Enterprise subscriptions, on the other hand, offermore, which includesUnlimited public and private repositoriesUnlimited collaborators for public repositories, while privaterepositories incur the subscription pricing per user per monthIssuesProject, Milestones, and Team discussionsInsights into security overviewGitHub Actions (3000 minutes/month for Team and 50,000minutes/month for Enterprise) or free for public reposGitHub Team and Enterprise allow a team of developers tocollaborate on projects, and GitHub bills for GitHub Team andEnterprise on a per-user basis.For more info on all GitHub’s pricing, browse to the followingURL: https://github.com/pricing#compare-featuresTo follow along in the book, the free GitHub account will besuf�icient.

https://github.com/pricing%2523compare-features


Improve	 GitHub	 Productivity	 with	 Multi-
account	 SupportGitHub account management has undergone a signi�icant overhaul inVisual Studio, making it much easier to work with multiple accountsacross different projects and organizations. This improvement isparticularly bene�icial for developers who need to switch betweenpersonal and work-related GitHub pro�iles, or who contribute tovarious repositories under different credentials. You can now add,authenticate, and manage multiple GitHub accounts directly withinVisual Studio without the constant need to sign out and back in again.Once your accounts are connected, Visual Studio remembers yourauthentication details and applies them seamlessly to operations suchas cloning repositories, pushing changes, or creating pull requests.The integration is designed to be intuitive; simply click on yourpro�ile icon in the top-right corner of the Visual Studio window (asshown in Figure 5-2) to view and manage all linked accounts. Fromhere, you can quickly switch between accounts, check the connectedorganization, or Account settings. This streamlined approach not onlysaves time but also reduces friction when collaborating across multipleteams, ensuring that you’re always working under the correct GitHubidentity.



Figure	5-2 Managing Multiple GitHub AccountsAt the bottom of this pro�ile card, you can click on Add	another
account, sign in to your second GitHub account, and repeat as required.The sign-in process is straightforward and once your account isadded, you can switch between the accounts effortlessly by selecting
Set	as	active	account from the ellipses in the pro�ile card.



Figure	5-3 Multiple GitHub AccountsJust remember that the active GitHub account drives the activation ofGitHub Copilot. Depending on your GitHub Copilot subscription, thosefeatures will automatically be activated as you switch accounts.
Create	 and	 Clone	 a	 RepositoryVisual Studio 2022 makes it extremely easy to create a repository onGitHub. Before I start writing actual code, I want to set up my GitHub



repo. From the menu in Visual Studio, select Git and click Create	Git
Repository as seen in Figure 5-4.

Figure	5-4 Create Git RepositoryYou will then be presented with the Create a Git repository windowas seen in Figure 5-5. The window will default the local path to the paththat your project is currently saved in. I always add a README �ile tomy repos and keep the rest set to the default options regarding thelicense template and .gitignore template.



Figure	5-5 Create a Git RepositoryBecause I already have a GitHub account, the Account drop-downwill default to that account. You can also add a GitHub account from thedrop-down or select another GitHub account if you have multipleaccounts, as shown earlier in Figure 5-3.You can now click the Create and Push button that will create therepo on GitHub for you. This will also create a new local Git repositoryfor your solution.Open up the Output Window (Ctrl+Alt+O) from the View menu andclick Output. Here, you will see that a new local Git repository has beencreated (Figure 5-6).



Figure	5-6 New Git Repository CreatedIt is important to remember that this project is now under sourcecontrol using Git. Remember that we mentioned earlier that Git is thesource control plumbing, the tool that developers install locally on theirmachines.If you never want a backup of your code in the cloud or never wantto collaborate with other developers, you can just use Git. This is,however, quite an unlikely scenario, especially now that GitHub allowsyou free private repositories.Therefore, you pushed your code to a GitHub repository afterconnecting your account. In my case, I can see that the repository hasbeen created for me by going to my GitHub account, as seen in Figure 5-7.



Figure	5-7 The Created Repository on GitHubThe �irst repo listed will be the one I just pushed from Visual Studio,and you will �ind your repo here, too, under your GitHub pro�ile.Next to the Solution Explorer (unless you have created a differentwindow layout or docked the Git Changes somewhere else), you will seethe Git Changes tab as displayed in Figure 5-8. Currently, there are nochanges in our project to commit.



Figure	5-8 The Git ChangesMake some UI or code changes to your project, and you willimmediately notice that the Git Changes window (Figure 5-9) in VisualStudio re�lects these updates in real time. Any �ile that has beenmodi�ied, added, or deleted since your last commit will be listed here,giving you a clear and organized view of pending changes.This view helps you keep track of exactly what is being altered inyour working directory, ensuring that nothing is accidentallycommitted without your knowledge.



Figure	5-9 Git Changes Showing Changes FilesEnter a commit message and then click the drop-down arrow nextto the Commit All button.Here, you can see the options for committing your code as seen inFigure 5-10. You can simply commit all your changes, commit and pushto the remote repo, commit to the remote repo and do a sync, or stashyour code.



Figure	5-10 Commit OptionsWe are just going to commit the changes without pushing to theremote repo.Remember, the Commit All will create the changes locally.Nothing will be created on the remote GitHub repo yet.After clicking the Commit All option, the Git Changes tab will tellyou that the changes were committed locally and display the commit ID(in this case, e28e90a3) as seen in Figure 5-11.



Figure	5-11 Commit the Changes LocallyYou might want to commit locally while working on code, and youare not quite ready to push the changes to the remote. This is a nicework�low to follow. Make some changes, commit locally with a speci�iccommit message, make some more changes, commit again with anothercommit message, and so on.
Note Each commit message and ID will also be visible on GitHubalong with the �iles that have changed.



When you have completed the changes and committed everythinglocally, you can push these changes to the remote repo by clicking thePush button, as seen in Figure 5-12.

Figure	5-12 Push Changes to the Remote RepoDoing this will push the changes to GitHub, and you will be noti�iedin the Git Changes tab that your changes have been pushed to theremote repo on GitHub, as seen in Figure 5-13.



Figure	5-13 Successful Push to the Remote RepoIf you go to your GitHub repository, you will see that the code youpushed is displayed in your repo (Figure 5-14) along with the commitmessages entered.



Figure	5-14 The Pushed Changes in GitHubIt is also nice to remember that if you have made changes to a �ilethat you have not committed yet and want to change the �ile back to thestate it was since the last commit, you can undo these changes easily. Asseen in Figure 5-15, I have made some changes to the
WeatherApiClient.cs �ile that I no longer want.



Figure	5-15 Changed Files You Want to UndoBy right-clicking the �ile as seen in Figure 5-16 and selecting Git ➤Undo Changes from the context menu, you can revert the �ile back tothe state it was at the last commit.



Figure	5-16 The Undo Changes Option



The ability to quickly revert �iles becomes especially valuable whenworking with temporary or experimental changes, for example, debug-speci�ic modi�ications to con�ig �iles that you do not intend to keep inthe �inal codebase. Rather than editing the �ile manually back to itsprevious state, this feature guarantees an exact restoration to the lastcommitted version.
Cloning	 a	 RepositoryIf you use multiple computers, you can easily clone repositories to each,allowing you to work on the same codebase (e.g., at home and at theof�ice). To do this in Visual Studio is simple and quick. We are just goingto be cloning the same repository we created in the previous section.Start Visual Studio, and then click the Clone a repository optionunder the Get	started section of the Visual Studio start screen (Figure 5-17).



Figure	5-17 Clone or Check Out CodeThis will take you to the Clone a repository screen as seen in Figure5-18.



Figure	5-18 Clone from GitHubFrom this screen, you can enter the repository location to get thecode from, but because we are using GitHub, we can simply click theGitHub option (Figure 5-18).You can also clone repos from Azure DevOps if you are using thatas your source control solution.This will display the Open from GitHub screen (Figure 5-19).



Figure	5-19 Open from GitHubSearch for and select the project, ensure that the local path iscorrect, and click the Clone button. The Visual Studio project is thencloned to my machine. In previous versions of Visual Studio, you wouldsee the repo in the Team Explorer window. Opening Team Explorer inVisual Studio 2022, you will see a message stating that the Git featureshave moved to their own window (Figure 5-20).



Figure	5-20 The Team Explorer WindowThe new Git tool window in Visual Studio 2022 streamlines Git-related actions such as cloning repos, working with stashes, creatingand comparing branches, line staging, etc. We will have a look at theseGit-related actions in the next sections.
Create	 a	 Branch	 from	 Your	 CodeWhen implementing a new feature or making signi�icant changes to anexisting codebase, best practice dictates that it’s best to work inisolation to avoid disrupting the stability of the main branch. This isoften referred to as master or main. Creating a dedicated branch in Gitprovides this isolation, allowing you to develop, test, and re�ine yourchanges without impacting production-ready code. In Visual Studio,your current branch is displayed in the status bar at the bottom right of



the IDE, making it easy to con�irm your working context before youbegin. (Figure 5-21).

Figure	5-21 Working in the Master BranchTo create a new branch, click the current branch to open theBranches view (Figure 5-22).



Figure	5-22 Branches ViewI will now create a local branch in Visual Studio. To do this, click theNew Branch button in the Branches view.



Figure	5-23 Create a New BranchI can now give my new branch a suitable name (Figure 5-23) andtell it to create the branch from the master branch. I keep the Checkoutbranch selected to check out my new branch and click the Createbutton.



Figure	5-24 Feature Branch CreatedAs seen in Figure 5-24, my new local branch is created and checkedout. This means that from now on, all changes made to the code willstay in this branch. Let’s add some new code to the project.



Figure	5-25 New Feature Code AddedAs seen in Figure 5-25, I have made several changes to my code. Inow need to commit the changes to my branch. These changes includeboth new and modi�ied �iles. Before committing code, I need to add a



suitable commit message. Then I can click the drop-down next to theCommit All button and select Commit All and Push (Figure 5-26).

Figure	5-26 Commit All and Push



This action commits the changes to the local repository andimmediately pushes them to the remote repository. By selecting thebranch indicator and switching to the Remotes tab, you can con�irmthat your feature branch has been pushed to GitHub (Figure 5-27).

Figure	5-27 Branch Pushed to the ServerWith the branch now available in the remote repository, the nextstep is to merge these changes into the master branch. To achieve this, apull request will be created.



Creating	 Pull	 RequestsWith our changes committed and pushed to the feature branch, we caneasily create a pull request without leaving Visual Studio. After pushingyour branch, Visual Studio will display a noti�ication banner in the GitChanges window shown in Figure 5-28. Here you have the option tocreate a Pull Request in Visual Studio or in the Browser.

Figure	5-28 Noti�ication to Create a Pull RequestIf you do not see this banner, you can manually open this dialog byusing the menu. Go to Git ➤ GitHub ➤ New Pull Request. If you’reusing Azure DevOps, you will see the menu Git ➤ Azure DevOps ➤ NewPull Request.We will be opting to do this inside Visual Studio, and clicking the
Create	in	Visual	Studio link, opens the New Pull Request window.Clicking on the Link or using the GitHub or Azure DevOps menuwill all lead to the same Pull Request creation interface within VisualStudio.



From the New Pull Request screen shown in Figure 5-29, you canselect the branches you want to create the PR for and enter the pullrequest details. Generally, you would verify the source branch (VisualStudio pre-selects this based on the branch that contains your mostrecent commits) and the branch that you want to merge into. In ourexample, we want to merge our changes into the master branch fromour refactoring-changes branch.You would then enter your Pull Request title and provide the detailsof the changes you are creating a pull request for in the Details section.The description you enter supports Markdown, allowing you to includerich formatting such as bullet lists and code blocks. You can also clickon the pencil icon to have AI generate your Pull Request details for you.

Figure	5-29 New Pull Request WindowYou can preview the entered details by clicking on the Previewbutton. This will open a Markdown viewer above your diff window. You



can also link work items or issues by clicking on the # next to thePreview button. This will trigger an issue search, allowing you to easilyreference the relevant issue number or Azure work item.A diff window will be displayed showing you exactly what you willbe merging. This is nice as it gives you a �inal look at exactly what isbeing included in this pull request.The New Pull Request window in Visual Studio also allows you toadd reviewers. This ensures that the correct people are noti�ied toreview the code that you want to merge. Once you are happy with thedetails you entered, click the Create button. This will submit the PRdirectly from Visual Studio to the server and notify any reviewers youselected that a PR is assigned to them. The Create button also allowsyou to create a draft by clicking on the dropdown next to the button andclicking on Create	as	Draft. Doing this will create your PR on the serverin a draft state.This is useful for sharing changes for early feedback withoutmarking it as ready to merge into the main or master branch.Whichever option you choose, after creating the PR, Visual Studio willprovide feedback that the Pull Request creation was successful, asshown in Figure 5-30. Here it shows that Pull	Request	#1 was created.

Figure	5-30 Pull Request SuccessfulYou now have an active pull request against your branch and yourteam can begin reviewing the changes and start providing feedback toyou.You can browse to your GitHub repo, as shown in Figure 5-31, toview your active pull request.



Handling	 Pull	 RequestsPull requests (PRs) are the backbone of modern collaborativedevelopment. Teams can review, discuss, and validate any changesbefore they are merged into the main branch. The integration VisualStudio provides with GitHub (or Azure DevOps) streamlines thiswork�low, allowing you to manage PRs without leaving the IDE.Viewing your open pull requests can be done by navigating to the
Git menu and selecting GitHub (or Azure	DevOps if you are working inthat environment), and choosing View	Pull	Requests.

Figure	5-31 The Active PR on GitHubThis will take you to all the active pull requests on GitHub for therepository you’re connected to (Figure 5-31). From this screen onGitHub, you can quickly see which PRs have been assigned to you, thecurrent status of those PRs, and any PRs that require your attention.



Figure	5-32 Viewing the Pull RequestActing as the reviewer, you can open any PR to see the description,related discussions, and the �iles that are changed. The Files	changedtab shown in Figure 5-32 will display a detailed breakdown of all themodi�ications to a particular �ile, as well as any added or removed �iles.



Figure	5-33 Start a ReviewAs shown in Figure 5-33, the reviewer is reviewing a new �ile, so nodiff is available. In the left tree view, �iles marked with a green squarewith a plus icon are new �iles, while a red square with a dot indicates amodi�ied �ile.Clicking any �ile in the tree view opens its contents for inspection. Ifyou spot an issue, hover over the relevant line number and click theplus sign to add a comment. This displays an editor from where you caneither leave a single, isolated comment or start a full review. Reviewsare useful when you have multiple feedback items and want to submitthem all at once for consideration.



Figure	5-34 Finish the Code ReviewOnce all the feedback on the code changes has been added, you cancomplete that code review by clicking the Finish	your	review button asshown in Figure 5-34.This will prompt you to choose an action as shown in Figure 5-35:CommentApproveRequest changesOn submission, GitHub will notify the PR author by email that acode review has been done and that there are some items that needresolving before the changes will be merged.



Figure	5-35 Submit the Code ReviewWhile you can always view review feedback on GitHub, VisualStudio allows you to bring those comments directly into the IDE. To dothis, click on the PR dropdown as shown in Figure 5-36 and check the
Show	Comments	in	Files option or go to the menu Git ➤ GitHub ➤ ShowComments In Files to enable the comments to be shown in your code�ile.



Figure	5-36 Show Comments in FilesAfter a short sync, comments will appear in line with your code asshown in Figure 5-37.



Figure	5-37 Showing PR CommentsThis is particularly useful when making changes in response to thefeedback you receive, as you can see the reviewer’s remarks exactlywhere they apply.At this stage, your team’s work�low dictates the next steps. You canaction the comments received immediately by making the changes ordiscussing the changes with the reviewer to clarify intent. Either way,once you’ve resolved an issue, reply to the comment and mark it asresolved. You would then need to commit and push these changes toyour remote branch. This action will automatically update the pullrequest with the new commits, allowing the reviewer to re-check and, ifsatis�ied, approve the merge.By leveraging Visual Studio’s GitHub integration, you reducecontext-switching, keep reviews closer to the code, and maintain a clearaudit trail of decisions.
Working	 with	 Stashes



It isn’t uncommon to realize midway through a task that you have beenworking on the wrong branch.

Figure	5-38 Changes in the Wrong BranchIn this example shown in Figure 5-38, I have made several edits tothe controller, but the changes were intended for a new branch. Thiskind of oversight can happen easily when working with multiplebranches. It is, however, easily remedied by using stashes.



Figure	5-39 Stashing ChangesFrom the Git Changes window (Figure 5-39), clicking on thedropdown next to the Commit button will allow you to stash yourchanges. A stash stores your uncommitted changes locally and revertsyour working directory to match the last commit made to the branch.This makes it possible to switch to a new or different branchwithout losing any of your work. As shown in Figure 5-39, you have twooptions. These are to Stash	All and Stash	All	and	Keep	Staged. Thedifference between them is as follows:1. Stash All (--include-untracked)



What it does:Saves all changes in your working directory to a stash,including tracked �iles you have modi�ied as well as new �iles thatGit isn’t tracking yet.What happens after:Your working directory is cleaned and matches the lastcommit. All untracked �iles are removed from the workingdirectory (but they are safely stored in your stash).When to use:You will choose this option when you want to clear yourworkspace completely. This will include new �iles that have notbeen committed. You can then switch to another branch or workon something else without losing any work.

 

2. Stash All and Keep Staged (--keep-index)What it does:Saves all changes in your working directory except thechanges that you have already staged. Staged changes willremain staged and remain in the working directory. Onlyunstaged changes are stashed.What happens after:Your index (staging area) is left untouched. This means thatyou can continue with an in-progress commit or partial workwhile excluding the rest.When to use:When you have some work that you want to commit but alsohave changes that you want to exclude temporarily.

 



Figure	5-40 Stashed ChangesWith your changes stashed, the Git Changes window will display thestash under the Stashes section (Figure 5-40). You are then free toswitch branches as required.



Figure	5-41 Creating a New BranchIn this example (Figure 5-41), I am creating a totally new branch formy changes.Refer back to the section on creating branches earlier in thischapter if you need a refresher on the process to follow.I am basing my new branch on the master branch and checking thebranch out after creation.



Figure	5-42 Applying or Popping a StashAfter switching to the correct branch, you can decide how to reapplythe stashed changes as shown in Figure 5-42. You have three options:Apply – Merge the stashed changes into the current branch whilekeeping the stash.Pop – Merge the stashed changes into the current branch and removethe stash.



Drop – Permanently delete the stash without applying it to thecurrent branch.Stashing is useful if you need to pause your current work to dealwith a high-priority task, for example, a production bug �ix. You canstash your changes, switch branches, �ix and push code �ixes, and thenreturn to the current task at hand by applying the stash. The work�lowfollowed here helps keep your branches clean and prevents code fromslipping into branches they weren’t intended for.
Multi-repo	 SupportA nice feature in Visual Studio 2022 is multi-repo support. You can nowwork in a single solution, with projects hosted in different Gitrepositories.

Figure	5-43 Multiple GitHub ReposI have two repositories in GitHub: an API project and the DBCproject shown in Figure 5-43. With multi-repo support, I can now openone project in Visual Studio 2022 and then add an existing project byright-clicking the solution and selecting Add ➤ Existing	Project andselect the second project.



Figure	5-44 Multi-repos Open in Visual StudioAs seen in Figure 5-44, both my projects across both repositoriesare loaded into Visual Studio, and the repo in the status bar shows thatI am working with two repositories.



Figure	5-45 Changes in Both RepositoriesAs seen in Figure 5-45, I can make changes in both repositories andcommit all these changes locally by clicking the Commit	All	Reposbutton.



Figure	5-46 Changes Committed LocallyOnce these changes are committed locally, I can click on the Pushbutton (the up arrow seen in Figure 5-46). This will display a Pushdialog shown in Figure 5-47.

Figure	5-47 Select the Branch to PushYou can select both branches or choose to push them one by one. InFigure 5-47, I have selected to push both branches in both repositories.The commit noti�ication in Figure 5-48 shows that both branches werepushed successfully.



Figure	5-48 Both Branches PushedHaving the ability to work with multiple repositories in VisualStudio is convenient because I no longer need to open a separateinstance of Visual Studio to work on a different repository.
Compare	 BranchesVisual Studio 2022 now allows you to compare branches. This providesa convenient way to see the differences between the two branches youare comparing and will be helpful before creating a pull request, beforemerging, or even when choosing to delete a branch.



Figure	5-49 View the Branches to CompareAs seen in Figure 5-49, when I click the currently checked outbranch, I can see all the other branches for my project, too. To comparethe current branch with the master branch, for example, right-click themaster branch and select Compare with Current Branch from thecontext menu, as seen in Figure 5-50.

Figure	5-50 Compare to Master BranchVisual Studio will then display a diff between the two branches youselected to compare, as seen in Figure 5-51.



Figure	5-51 The Branch DiffI am now able to see exactly what is different between the twobranches without leaving Visual Studio.

Figure	5-52 Changing the Preferred Diff LayoutI can also use the diff con�iguration options gear in the top-rightcorner to switch to an inline diff view, as shown in Figure 5-52.
Check	 Out	 Commit



When working with Git in Visual Studio, you are not limited to the lateststate of a branch. You can check out any commit in your repository’shistory and load the project exactly as it existed at that point in time.You are effectively traveling back in time to a previous state of yourcodebase. This can be invaluable when you need to investigate a bug,validate a �ix, or just review how a speci�ic feature was originallyimplemented. Visual Studio makes this process seamless, allowing youto freely move between different points in your project history. To dothis, open the Git Repository window by selecting the View menu andclicking Git	Repository as seen in Figure 5-53.

Figure	5-53 View the Git RepositoryYou can also hold down Ctrl+O, Ctrl+R to open the Git Repository,which can be seen in Figure 5-54.



Figure	5-54 The Git Repository WindowTo check out a speci�ic commit, right-click the commit in the GitRepository window shown in Figure 5-55 and select Checkout (--detach) from the context menu.

Figure	5-55 Check Out a Commit



Visual Studio now displays a con�irmation window (Figure 5-56) toinform you that by checking out this commit, you will be in a detachedHEAD state. In other words, your repo’s HEAD will be pointing to aspeci�ic commit instead of a branch.

Figure	5-56 The Checkout Commit Con�irmationThe status bar of Visual Studio will now show that you are currentlypointed to a speci�ic commit instead of to a branch (Figure 5-57).

Figure	5-57 The Visual Studio Status BarChecking out a commit provides the following bene�its:
Debug	historical	issues – Speci�ically when a regression appears, youcan check out the commit where the code last worked, allowing youto compare it with later commits to identify the issue.
Reproducing	bugs – Customer reported issues might be tied to aspeci�ic version of the code. You can therefore reproduce the bug bychecking out the commit matching the deployed build.
Code	“archaeology” – Being able to understand why a section of codewas written in a speci�ic way. Being able to check out a speci�ic



commit allows you to see the code in the exact context of thatdecision.
Avoiding	unnecessary	branch	creation – If all you need to do is reviewor test code without making any modi�ications, checking out thecommit directly is faster and keeps the structure of your branchesclean.Being able to check out a speci�ic commit is more than just goingback in time. It can be a precise tool used for debugging, analysis, andvalidation without the clutter of temporary branches. To get back toyour branch, simply select it from the branch selector in the VisualStudio status bar.

Line	 StagingAlso known as interactive staging, line-staging allows you to stageselected lines or portions of a �ile instead of the entire �ile at once. Thislevel of precision is valuable when your edits span multiple concerns.You might be �ixing a bug while also refactoring a small piece of code,and adding some experimental code, all at the same time. With linestaging, you do not need to bundle all these unrelated changes together.You can selectively stage lines that belong together and leave the restfor later.To see line staging in action, make some changes to one of your �iles,and then view the �ile in the Git	Changes window as seen in Figure 5-58.



Figure	5-58 Git Changes Showing Changed FilesNext, double-click the �ile that you want to apply line staging to.Visual Studio will display a diff view of the selected �ile, allowing you tohover over the lines that you want to stage, and stage them individuallyas shown in Figure 5-59.



Figure	5-59 Staging a Speci�ic Line of CodeLine staging also supports side-by-side and inline diff modes. Linestaging turns staging into a surgical tool rather than a blunt instrument.It helps developers maintain discipline in version control, produces acleaner history, and ultimately leads to more maintainable codebases.
Copy	 Git	 Permalink	 in	 Visual	 StudioVisual Studio 2022 introduces the ability to copy a Git permalinkdirectly from the editor. A permalink is a URL that points to a speci�icline or block of code at a given commit. This is quite useful whenreviewing code with a colleague or documenting behavior in a wiki.Instead of having to refer to a line number in code, you can simply sharea link that takes the recipient to the exact line of code in question.



Figure	5-60 Copying a PermalinkTo copy a permalink, right-click a line of code and select Git ➤ CopyGitHub Permalink from the context menu. Your colleague can then openthe link you copied to view the speci�ic line of code on the web. Thisallows them to gain valuable context of the issue at hand withoutdisrupting their local dev environment or work�low.



Note that this feature is supported in both Azure DevOps andGitHub Repositories.
Commit	 with	 GitHub	 CopilotGitHub Copilot can generate commit messages directly from yourchanges. By clicking on the pencil icon in the Git Changes window(Figure 5-61), Copilot inspects the diff and proposes a commit message.

Figure	5-61 Generate Commit MessageShown in Figure 5-62, the commit message proposed by Copilotdoes save you time, but relying solely on the default output can lead toinconsistent messages, especially if your team likes to create commitmessages in a speci�ic format.



Figure	5-62 Generated Commit MessageVisual Studio provides a way to enforce a speci�ic standard when itcomes to Copilot-generated commit messages by allowing you to de�inecustom instructions.As seen in Figure 5-63, I can specify the custom instructions bygoing to Tools ➤ Options ➤ GitHub ➤ Copilot and specifying a set ofrules that help guide Copilot’s generation process.Think of the custom instructions as a style guide that Copilotapplies every time you ask it to write a commit message. This ensuresthat your commit messages remain structured and consistent.



Figure	5-63 Commit Message Custom InstructionsFor example, consider the custom instructions shown in Listing 5-1.
## Commit Message Instructions for Copilot

Always add the text "TODO:" with a one-line
summary of the change, limited to 50 characters.
Leave the second line blank.
The third line adds the text "COMMENTS:" and then
adds all the details of the commit.
**Use the imperative mood** in the subject line
- Example: *“Add logging for API requests”* not
*“Added logging”*

Listing	5-1 The Commit Message Custom InstructionsWith these instructions in place, Copilot’s generated commitmessage follows a predictable format. De�ining a structured commitmessage format enforces industry-accepted conventions, ensuring eachchange is documented in a consistent and predictable way. This makesthe rationale behind a change clear and easier for the team to follow.



Figure	5-64 Commit Message Using Custom InstructionsWhen you generate the same commit message using the custominstructions, the difference is striking. Instead of generic or verbosecommit messages, Copilot now produces entries that align withestablished best practices, reducing ambiguity during code reviews andmaking history easier to navigate.For teams working at scale, this consistency is not just aconvenience; it’s a necessity for long-term maintainability. CustomInstructions allow you to codify your team standards directly into thetooling, ensuring that message quality is enforced automatically ratherthan relying on manual discipline.
Stop	 Issues	 Before	 Committing	 to	 Git



Visual Studio now includes a feature that helps you catch potentialproblems before your code ever leaves your machine. This is calledLocal Code Review, and it integrates directly with GitHub Copilot.Instead of waiting until a pull request review identi�ies gaps, or worse,letting issues slip all the way into the remote repo, you can surfacesuggestions at commit time.

Figure	5-65 Running Local Code Review



This process �its seamlessly into the Git work�low. Once you have achange ready to commit, you can click on the “sparkle comment” icon(for lack of a better word) shown in Figure 5-65. This triggers Copilot toreview your changes and provide feedback about the changes you’vemade. What makes this especially valuable is that it happens withinVisual Studio, allowing you to address the issues immediately beforecommitting to the remote repo.
SummaryIn this chapter, we looked at the full Git and GitHub work�low insideVisual Studio 2022. We started with account creation and multi-accountsupport. Then we had a look at cloning repositories, committingchanges, branching, and handling pull requests. These are the tools thatdevelopers use every day. We also looked at some of the advancedfeatures such as working with stashes, managing multiple repositoriesin the same solution, comparing branches, checking out speci�iccommits, and staging changes at a line level.Finally, we saw how Visual Studio integrates tightly with GitHubCopilot to generate commit messages, enforce team standards, andeven perform local code reviews to catch issues before they reach yourremote repository.Together, these features make source control in Visual Studio morethan just a way of keeping code safe. It’s a productivity engine thatenforces best practices, supports collaborative work�lows, and givesteams con�idence that the code they are shipping is both maintainableand secure.
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